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About This Manual 
This is version 11.30 of the manual to the home and professional versions of X-Plane (X-Plane 11 and 

X-Plane 11 for Professional Use, respectively). The latest version will always be available online on the 

X-Plane website. PDF manuals are available in German, French, and Spanish. Quick Start Guides are 

available in Japanese and Chinese. 

To use this manual, you can jump to a section by clicking its title in the table of contents on the side. To 

search for a specific term or set of words, press “ctrl” (“command” on a Mac) + “f” then start typing to 

be taken to the term anywhere in the document. For a PDF version of this manual, use an HTML to PDF 

converter such as pdfcrowd.com. 

If you would like to receive a free guide to many of the most important features of X-Plane, you can sign 

up for our free email course. By signing up, you’ll be able to learn all the most important features of 

X-Plane at your own pace, without having to search through the manual for the feature you’re 

interested in. This course will show you how to: 

add new aircraft to X-Plane for free, 

simulate out-of-this world situations (literally!), like flying the Space Shuttle’s re-entry into the 

atmosphere, 

dogfight against your friends or X-Plane’s artificial intelligence, 

shoot approaches to your favorite runways, and more! 

Sign up for the free course to get the most out of X-Plane. 

About X-Plane 

Overview 
X-Plane is the world’s most comprehensive and powerful flight simulator for personal computers, and it 

offers the most realistic flight model available. 

X-Plane is not a game, but an engineering tool that can be used to predict the flying qualities of fixed- 

and rotary-wing aircraft with incredible accuracy. 

Because X-Plane predicts the performance and handling of almost any aircraft, it is a great tool for pilots 

to keep up their currency in a simulator that flies like the real plane, for engineers to predict how a new 

airplane will fly, and for aviation enthusiasts to explore the world of aircraft flight dynamics. 

Welcome to the world of props, jets, single- and multi-engine airplanes, as well as gliders, helicopters 

and VTOLs. X-Plane contains subsonic and supersonic flight dynamics, allowing users to predict the flight 

characteristics of the slowest aircraft or the fastest. X-Plane includes more than 15 aircraft in the default 

installation, spanning the aviation industry and its history. Aircraft included range from the Sikorsky S–

76 and Cessna 172 to the Space Shuttle and the B–52 Bomber. Additionally, some 2,000 additional 

aircraft models can be downloaded from the Internet (X-Plane.org and Google are good places to start 

looking), many of which are completely free. If those aren’t enough, users can design their own 

airplanes and test-fly them! 

http://www.x-plane.com/manuals/desktop/
http://www.x-plane.com/manuals/desktop/
http://www.x-plane.com/wp-content/uploads/2017/04/Manual_XPlane11_de_web.pdf
http://www.x-plane.com/wp-content/uploads/2017/04/Manual_XPlane11_fr_web.pdf
http://www.x-plane.com/wp-content/uploads/2017/04/Manual_XPlane11_sp_web.pdf
http://www.x-plane.com/wp-content/uploads/2017/04/XPlane11_QuickStart_japanese.pdf
http://www.x-plane.com/wp-content/uploads/2017/06/Manual_X-Plane11_Chinese.pdf
http://pdfcrowd.com/
http://www.x-plane.com/desktop/get-the-most-out-of-the-flight-simulator/
http://www.x-plane.com/desktop/get-the-most-out-of-the-flight-simulator/
http://www.x-plane.com/desktop/get-the-most-out-of-the-flight-simulator/
http://forums.x-plane.org/index.php?autocom=downloads
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The full X-Plane scenery package covers the Earth in stunning resolution from 74 north to 60 south 

latitude. Users can land at any of over 35,000 airports or test their mettle on aircraft carriers, oil rigs, 

frigates (which pitch and roll with the waves), or helipads atop buildings. They can also realistically 

model the flight of remote-controlled model aircraft, perform an air-launch in an X–15 or Space Ship 

One from the mother ship, fly re-entries into Earth’s atmosphere in the Space Shuttle, fly with friends 

over the Internet or a LAN, drop water on forest fires, or shoot approaches to aircraft carriers at night in 

stormy weather and rough water conditions in a damaged F–4. The situations that can be simulated are 

unbelievably diverse! 

Weather in X-Plane is variable from clear skies and high visibility to thunderstorms with controllable 

wind, wind shear, turbulence, and micro bursts. Rain, snow, and clouds are available for an instrument 

flying challenge, and thermals are available for the gliders. Actual weather conditions can be 

downloaded from the Internet, allowing users to fly in the weather that really exists at their current 

location! 

X-Plane has detailed failure modeling, with multitudes of systems that can either be failed manually at 

an instructor’s command, or randomly when users least expect it! Users can fail instruments, engines, 

flight controls, control cables, antennae, landing gear, or any of dozens of other systems at any moment. 

They can also have a friend or flight instructor (locally or via the Internet, working from an Instructor’s 

Operating Station) fail components on the aircraft without the pilot’s knowledge. The instructor can 

alter the time of day, weather conditions, and failure status of hundreds of aircraft systems and 

components. Additionally, the instructor can relocate the aircraft to a location of his or her choice at any 

time. 

Aircraft models are also extremely flexible, allowing users to easily create paint jobs, sounds, and 

instrument panels to modify any airplane you choose. Custom airplane or helicopter designs can even 

be created and flown using X-Plane and the included Plane Maker software. 

X-Plane is used by world-leading defense contractors, air forces, aircraft manufacturers, and even space 

agencies for applications ranging from flight training to concept design and flight testing. 

For example, X-Plane has been used in crash investigations to depict the view pilots experienced 

moments before a mid-air collision, or to graphically present to juries and judges the forces that impact 

an aircraft in flight. Scaled Composites used X-Plane to visualize Space Ship One’s flights to the edge of 

the atmosphere in their pilot training simulator. Kalitta has used X-Plane to train their pilots to fly freight 

747s in the middle of the night. Northwest and Japan Airlines use X-Plane for flight review and training. 

Cessna uses X-Plane to train new customers in the intricacies of the Garmin G1000. Dave Rose has used 

X-Plane to optimize airplanes for his many wins at Reno. NASA has used X-Plane to test the re-entry of 

gliders into the Martian atmosphere, and the list goes on. These customers serve as perhaps the most 

significant endorsement of the incredible capabilities of this simulator. 

Furthermore, X-Plane has received certification from the FAA for use in logging hours towards flight 

experience and ratings. This experience can provide credit towards a private pilot’s license, recurrence 

training, hours towards instrument training, and even hours towards an Airline Transport Certificate—

it’s that good. 
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What X-Plane Includes 
Windows, Mac, and Linux installers are included with X-Plane 11. It includes over 70 GB-worth of 

scenery (covering essentially the entire world) and over 15 aircraft, with thousands of planes available 

on the web. The DVDs or digital download contain everything needed to run X-Plane—there is nothing 

more that you need to buy. You’ll receive free updates to X-Plane 11 until Version 12 is released, as well 

some of the best customer service and tech support available. 

While on its own X-Plane represents the world’s most comprehensive flight simulator, the installation 

DVD also comes with Plane Maker, allowing users to create custom aircraft or modify existing designs, 

and Airfoil Maker, allowing users to create airfoil performance profiles. 

Stock Aircraft  

Cirrus Vision SF50 North American X–15 

Beechcraft Baron 58 Boeing 747–400 and 747–100 

Boeing 737–800 Lockheed SR–71 

Cessna 172SP McDonnell Douglas KC–10 Extender 

Stinson L–5 Sentinel Beechcraft King Air C90B 

ASK–21 glider Boeing B–52G Stratofortress 

Lockheed C–130 Hercules Space Shuttle Orbiter 

McDonnell Douglas F–4 McDonnell Douglas MD–80 

Sikorsky S–76 Columbia 400 

 

Custom  
 

Beechcraft Bonanza Boeing 727/737/747/787 

Mooney M20J 201 Piper PA–16 Clipper 

de Havilland DH–106 Comet Pitts “Mountain Dew” S2C 

Sikorsky S76 StratoCloud Ram-Air 

P–51D Mustang Piper Twin Comanche PA30 

Beechcraft King Air 350 Cessna 195 

Cessna C150 Bell 222 

Douglas A–4B Skyhawk Ilyushin IL–76 

Fiat CR.42 Falco Paris Jet III 

Bell 407 Peregrine F222 Firenze 

Beechcraft Staggerwing Curtis P–6 Hawk 

Ford Tri-motor Cessna 120 

Hawker Sea Harrier FRS1 Airbus A320/A340/A380 

About the Versions of the X-Plane Simulator 
X-Plane can be used in a wide array of situations, ranging from home use to commercial flight training. 

The standard installation is X-Plane 11, and it is perfect for almost all home users. Situations that go 

beyond the standard home use (including use in commercial simulators) require the purchase of a USB 



Page | 10  
 

“key” (a simple flash drive) or the specific digital download product key that is used to unlock the 

features of X-Plane Professional. 

Note that FAA certification of a simulator requires not only that the user has X-Plane 11 Professional but 

also the appropriate hardware (cockpit and flight controls) available through the X-Plane Hardware 

page and companies such as Precision Flight Controls and  Fidelity Flight Simulation.  This is because 

flight-training systems can only be certified as a complete package (a software and hardware 

combination). The commercial, FAA-certifiable software is available for $750 to $1,000 per copy and the 

hardware runs from $5,000 to $500,000. The retail version of X-Plane purchased at X-

Plane.com is not certified for flight training right out of the box, since certification requires a software 

and hardware combination. However, the software available at X-Plane.com is almost identical to what 

is found in the $500,000 full-motion, FAA-certified platforms. The biggest difference is that the FAA-

certified versions have custom aircraft files with larger instrument panels, which are set up to work with 

hardware radios like those found in the physical cockpits. The FAA-certifiable version also has some of 

the purely fun stuff (like space flight) removed even though those situations are simulated accurately in 

X-Plane, just like the FAA-certified subsonic terrestrial flight. 

X-Plane 11 Global 
The standard X-Plane simulator is the retail copy of X-Plane. It requires one X-Plane 11 Disc 1 DVD or one 

digital download product key for each copy of X-Plane on the network, and nothing else. For additional 

information on the digital download version of X-Plane 11, see this Knowledge Base article. 

Many copies of X-Plane on many computers can be networked to act as external visuals, external 

cockpits, instructor stations, and the like. One X-Plane Disc 1 DVD or one digital download product key is 

required for each computer networked together running the simulator. This system cannot be certified 

by the FAA or any other authority for logging flight training, due to the fact that it does not self-test for 

the presence of flight controls or a usable frame rate. However, since only one X-Plane Disc 1 DVD or 

digital download product key is needed for each computer, this setup is amazingly affordable and easy 

to assemble, even though a user could never certify the system. 

X-Plane 11 Professional 
This version of X-Plane is for commercial use and FAA-approved simulators. It requires one X-Plane 

Professional USB key or Pro-Use Digital Download product key in addition to each copy of X-Plane on the 

network. This version is very similar to the home use version of the X-Plane 11 simulator but enables 

commercial uses, FAA certification checks, and ability to use a real GPS. This version is designed to 

replace Microsoft ESP. 

The Pro USB key or digital download product key needs to be used for commercial purposes and FAA-

approved simulators for flight training. It gives a Commercial Use message as X-Plane starts up, causing 

X-Plane to check for flight controls and self-test the frame rate, as required for FAA certification. 

Furthermore, the pro key allows you to interface with Garmin Real Simulator Units. 

Finally, this key enables cylindrical and spherical projections (see “Projector Setup for X-Plane 

Professional” for more information). 

https://www.x-plane.com/?page_id=6706
https://www.x-plane.com/?page_id=6706
http://www.flypfc.com/
http://www.fidelityflight.com/
http://www.x-plane.com/kb/x-plane-digital-download-xdd/
https://www.x-plane.com/manuals/desktop/index.html#projectorsetupforx-planeprofessional
https://www.x-plane.com/manuals/desktop/index.html#projectorsetupforx-planeprofessional
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The Professional USB Key or Digital Download can be purchased from X-Plane.com’s Ordering page. USB 

key drivers for both Mac OS and Windows can be downloaded from the X-Plane.com site. Be sure to run 

those installers to make X-Plane recognize the USB keys. 

Quick Start Guide 
This chapter is designed to allow a first-time X-Plane user to get the simulator up and running in as short 

a time as possible. The goal is to be in the air and flying within ten minutes of completing the installation 

while still learning the essentials of the simulator. 

This chapter will gloss over a great deal of background information, and configuration of many non-

essential options will be skipped entirely. It assumes that the computer X-Plane is being installed on is 

capable of running the simulator with its default rendering options. For the latest system requirements, 

see “X-Plane 11 System Requirements” in the X-Plane Knowledge Base. 

Where the process differs between installing on Windows and Mac OS X, the differences have been 

noted. 

After getting off the ground initially, you may want to continue reading the full manual, or simply keep it 

for reference. If you have any issues while following this guide, check the rest of the manual—the 

problem is very likely addressed there, and you’ll save time for both yourself and customer support. 

Detailed information on installing and configuring X-Plane can be found in the chapters Preparation and 

Installation and Configuring and Tuning Your X-Plane Installation. Detailed information on joystick 

configuration can be found in the chapter Configuring and Tuning Your X-Plane Installation, and the 

chapter Flight in X-Plane contains more on setting up and flying the aircraft. 

Installation of X-Plane 
Before installing, we recommend uninstalling any old or demo versions of X-Plane. You can do this by 

simply dragging the old X-Plane folders to your Recycle Bin (called Trash in Mac OS X). 

1. Insert the first X-Plane DVD into your DVD drive and wait for it to spin up. 

If you have purchased a digital download product key, download the latest X-Plane installer from 

our web site. Launch that installer, then skip to step 3. 

2. In Windows, if the operating system does not launch the X-Plane DVD installer automatically, click 

the Start menu, then My Computer. Double click on the XPLANE11 DVD, then “X-Plane 11 

Installer.exe”. 

Mac users will need to double click on the X-Plane DVD icon on the desktop, then double click the 

“X-Plane 11 Installer.app” to launch the installer. 

3. When the installer window appears, click Continue to begin the installation process. 

Note that you can change the language or pick a different operating system for the install by 

clicking on the settings slider icon in the top right corner. 

4. If you purchased a digital download product key, enter it on the following screen. Be sure you are 

connected to the Internet at all times during your installation. 

http://www.x-plane.com/store/pro-use/
http://www.x-plane.com/files/HASP.zip
https://www.x-plane.com/kb/x-plane-11-system-requirements/
https://www.x-plane.com/manuals/desktop/index.html#preparationandinstallation
https://www.x-plane.com/manuals/desktop/index.html#preparationandinstallation
https://www.x-plane.com/manuals/desktop/index.html#configuringandtuningyourx-planeinstallation
https://www.x-plane.com/manuals/desktop/index.html#configuringandtuningyourx-planeinstallation
https://www.x-plane.com/manuals/desktop/index.html#flightinx-plane
http://www.x-plane.com/desktop/try-it/
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5. By default X-Plane will install to the Desktop. Though it can be installed elsewhere, it is strongly 

recommended that it be placed on the Desktop so that it can be found in the future. For the 

purposes of this guide, we will assume it is installed there. Click Continue. 

6. Accept the user agreement and click Continue once again. It is highly recommended that you 

leave the box for sending anonymous usage data checked. This allows Laminar Research to gather 

anonymous data to make updates to the simulator based on how you use it. 

 

Figure 2.1: All scenery selected for installation after clicking “Select All” 

7. Select the scenery you would like to install. Parts of the world that are currently selected will be 

a bright blue color (as all continents are in Figure 2.1). Note that for regions where no scenery is 

installed, only oceans and airports will be visible. 

If you are unsure what areas are currently selected, just click Select None to turn everything off 

(as seen in Figure 2.2). From there, move your mouse around the map to highlight sections of the 

world and click on on the ones you would like to install. 



Page | 13  
 

 

Figure 2.2: No scenery selected for installation after clicking “Select None” 

8. When you’re finished selecting scenery, click Continue to begin installing. 

The installer will begin displaying its progress. When using DVDs, the installer will prompt you 

when it’s time to remove the current disc and insert the next. DVD installation may take anywhere 

from thirty to sixty minutes per disc, and that only one X-Plane disc can be in the system at once 

(the installer wont recognize a disc placed in a second DVD drive). Note that digital download time 

estimates are based on your initial network speed and real install times may vary significantly. 

 
We strongly recommend that you install only a small bit of scenery now and add more later, as the 

entire scenery package takes nearly 60 GB of space and a long time to install. 

Scenery can be added or removed at any point in the future by re-running the installer. Insert Disc 1 if 

you have the DVD set, but if you are using a digital download product key, X-Plane should remember it. 

If not, enter your product key when required. When the X-System installer comes up saying “You already 

have X-Plane 11 installed on this computer,” click the Add or Remove Scenery button and proceed just 

like in step 7 above. 

Note: Having finished the installation, Mac users will probably want to exclude their X-Plane installation 

directory from their Time Machine backups (as described in the chapter Preparation and Installation, in 

the section “Special Considerations for Mac Users.”) 

Launching X-Plane for the First Time 

1. Make sure your USB joystick is plugged in. To avoid any possible problems, it is recommended 

that the flight controls be plugged directly into the machine rather than into a hub. 

2. If you own the DVD set, put Disc 1 into your DVD drive. 

3. Open the X-Plane folder (located by default on the Desktop) and double click on ‘X-Plane.exe’ in 

Windows, or ‘X-Plane.app’ on a Mac. 

https://www.x-plane.com/manuals/desktop/index.html#preparationandinstallation
https://www.x-plane.com/manuals/desktop/index.html#specialconsiderationsformacusers
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4. If you have a digital download key, X-Plane may prompt you for your key, or the field may be pre-

filled if you have entered your product key before (i.e., during installation). Simply click 

“Authorize” and X-Plane will proceed. Starting the simulator without this or a DVD in the drive will 

force it to run in demo mode only. 

If you have successfully used your digital download product key, X-Plane will try to contact the 

authorization server in the background without prompting you. Thus if your net connection is 

good and your product key is not locked, you may never notice or need the product key again to 

fly. 
Since this is the first time you’ve started X-Plane, it will begin with a tutorial on the basics of flight and 

using X-Plane. Follow the instructions or use the Skip buttons to complete it. 

Configuring Essential Yoke/Joystick Functions 
During this first launch, if you are using flight control hardware, the program can quickly and 

automatically configure them. In the Uncalibrated Joystick or Yoke box that appears, click the Open 

Joystick Calibration button then continue with the steps below. 

Note that a mouse may be used to fly if neither a yoke or a joystick is available, though it will (of course) 

be unrealistic and cumbersome. If the mouse will be used, skip to the section “Setting Up a Flight” 

below. 

1. Click on the Calibrate or Calibrate Now button (if necessary). 

 

Figure 2.3: The calibration window for a new yoke 

2. Move each axis of the device through its full range of motion. Make sure to move all levers as 

well as the stick or yoke itself. 

Note that if you’re unable to move the controls through their full range of motion you may simply click 

the Accept Axis or Skip button for each axis that X-Plane believes to be uncalibrated, but which you 

have confirmed has actually gone through its full range of motion. 

1. Press the Next button to continue to the centering screen. Release the controls, press Next again 

and wait until the timer is up. 

2. Click Finish to leave the calibration screen to return to the main joystick screen. 

https://www.x-plane.com/manuals/desktop/index.html#settingupaflight
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Figure 2.4: The joystick configuration screen, after completing calibration 

3. If any axes weren’t recognized properly during the automatic calibration, you can set them with 

the drop down menus in the column of controls on the right. 
If your device does not have a preset configuration in X-Plane, you will need to set all the axes and 

buttons by hand by picking options from all the axes & button drop down options. 

4. Assign functions to joystick buttons, such as brake toggle (if you’re not using rudder pedals) by 

clicking the Edit button. Note that for many of the most popular flight controls, you will be able 

to refer to the labeled image on the left if you are unsure which button is being assigned. 

5. Find the command you’d like to assign, such as “Toggle brakes regular effort,” by searching or 

scrolling through the list. Then click Apply. 

6. If buttons appear to be missing from the list in this screen, check under the “Views” drop down 

for additional images of the device that may have additional buttons mapped. 

7. Once you’ve finished assigning functions to buttons, close the Joystick screen by pressing 

the Done button. 
If at any time you need to return to the joystick screen, you can access it by clicking on the settings icon 

in the top right corner of the screen and going to the Joystick section. 

Setting Up a Flight 
The first thing you see when you launch X-Plane is the main menu. From here you can choose to quit, 

resume your last flight, start a new flight, load a saved flight, or visit Flight School for tutorials. If you are 

brand new to X-Plane or flying, it’s recommended that you start with this last option, Flight School. 

Otherwise, to set up a new, custom flight, click the New Flight option to go to the Flight Configuration 

screen. 

 

https://www.x-plane.com/manuals/desktop/index.html#flightschool
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Figure 2.5:The Flight Configuration screen 

Select an aircraft from the list on the left. You can narrow down your options by using the drop down 

menus at the top of the screen or the search bar. Click on the star in the corner of the aircraft box to 

mark it as a favorite, and quickly find it next time at the top of the list. 

Pick an airport to start at by searching by Name, ICAO/FAA/IATA code, or feature (such as “grass strip”) 

in the Location box at the top right side of the screen. You can specify which runway or ramp to start on 

by clicking the Customize button. 

Drag the slider in the Weather box to change the cloud and precipitation settings between 8 different 

presets. Adjust the time of day the same way. 

Once you’re ready, click the Start Flight button and get flying! 

See the section Setting Up Your Flight for detailed explanations of the Customize screen options for each 

aspect of the flight. 

Updating Your Copy of X-Plane 
Updating X-Plane will ensure that the copy of X-Plane you are using is the most stable, most feature-rich 

version available. Updates within a given version of X-Plane (e.g., from Version 11.0 to 11.1 to 11.2) are 

free, and recommended for virtually all users. 

Simply start X-Plane, and if an update is available you will see an “Update Available” box with the 

options to “Ignore” or “Update.” Click Update to have X-Plane automatically download and launch the 

latest installer/updater. Proceed through the installer to update X-Plane to the latest version. 

If you would like to check what version of the simulator you’re using: 

1. Go to Settings > General. 

2. Click the About X-Plane button in the bottom left corner. 

3. Your version number will be listed in the “About This Copy of X-Plane” section. There will be 

an Update X-Plane button if an update is available. Clicking this will cause X-Plane to download 

the latest updater and run the updater for you. 

Preparation and Installation 

System Requirements 
Given X-Plane’s incredible capabilities and accuracy, it is not possible to run a current release of X-Plane 

on an exceptionally old computer. A good rule of thumb is that any machine built in the last 18 to 24 

months will probably be able to run the simulator acceptably. Computers up to about 36 months old 

may be fine if they were top-of-the-line machines when manufactured. Even if they weren’t, X-Plane 

may still be able to run, albeit with its rendering options turned down. 

For the latest system requirements, see the “X-Plane 11 System Requirements” Knowledge Base article. 

X-Plane 11 requires a computer with at least the following specifications: 

https://www.x-plane.com/manuals/desktop/index.html#settingupyourflight
https://www.x-plane.com/kb/x-plane-11-system-requirements/
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1. CPU: Intel Core i3, i5, or i7 CPU with 2 or more cores, or AMD equivalent. (Dual-core CPUs slower 

than 3 GHz should try the demo before purchasing.) 

2. Memory: 8 GB RAM 

3. Video Card: a DirectX 11-capable video card from NVIDIA, AMD or Intel with at least 1 GB VRAM 
However, for the best experience, we recommend the following: 

1. CPU: Intel Core i5 6600K at 3.5 ghz or faster 

2. Memory: 16–24 GB RAM or more 

3. Video Card: a DirectX 12-capable video card from NVIDIA, AMD or Intel with at least 4 GB VRAM 

(GeForce GTX 1070 or better or similar from AMD) 

4. 10 GB of hard drive space 
To find your computer’s CPU speed and amount of RAM, Mac users can simply open the Apple Menu 

and click “About This Mac.” 

For Windows users, you can open the Start menu and type My Computer. Desktop app “This PC” will 

show up in the list. Right click on it and choose “Properties.” System Panel will open and display your 

system specs. 

While X-Plane 11 will run on Linux, X-Plane doesn’t provide support for specific distributions; if you want 

to run on Linux, you will need to try X-Plane on your distribution to see if it is compatible. With that in 

mind, developers have used Ubuntu 14.04 and 16.04 LTS successfully. 

For Linux, X-Plane requires the proprietary driver from AMD or NVIDIA to run. You may be able to get 

X-Plane to run on the Mesa/Gallium driver with an Intel GPU, but this is unsupported. We absolutely do 

not support the fully open source drivers for AMD and NVIDIA. 

Display Hardware 

X-Plane can display on any screen, with resolutions ranging from 1,024 × 768 pixels to 9,999 × 9,999 

pixels. It makes no difference to X-Plane what aspect ratio your screen has; if your aspect ratio doesn’t 

match that of the instrument panel you are using, X-Plane will simply zoom or stretch the panel as 

appropriate to fill your screen. 

X-Plane allows the use of any number of screens to depict anything you like. Multiple computers with 

multiple copies of X-Plane can be used to drive multiple monitors, thereby networking up to about 20 

screens to show any combination of views imaginable. Many modern graphics cards or technology such 

as a video splitter like the Matrox TripleHead2Go) can be used to drive multiple forward visuals with one 

machine. In that case, a second machine could be used to drive the cockpit display or exterior view, as 

described in the section “Configuring a Multi-Monitor Simulator.” 

Graphics Drivers 

X-Plane, of course, needs a decent graphics card in the computer you wish to run it on. Essentially any 

modern, discrete (i.e., non-integrated) video card will do just fine, though a more powerful, more 

expensive graphics card will allow for higher detail in the simulator’s graphics. Just as important as the 

http://www.matrox.com/graphics/en/products/gxm/th2go/displayport/
https://www.x-plane.com/manuals/desktop/index.html#configuringamulti-monitorsimulator
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graphics card itself, though, are the computer’s graphics drivers (essentially, the instructions that let 

X-Plane know how to use your graphics card). 

On many systems the required graphics drivers will already be installed. However, it may be necessary 

to periodically update the computer’s video drivers, either to fix a problem or to get the very best 

performance the system can deliver. Many graphics card companies provide software that can 

automatically detect when a new driver is available and help keep you up to date. Users of ATI/AMD 

video cards can find out more and download drivers from the AMD web site, while NVIDIA users can 

download drivers and software from NVIDIA’s web site. 

Before updating the graphics driver, we recommend installing and launching X-Plane (per the section 

“Installing X-Plane” of this chapter) and seeing how it runs. If any of the following problems are 

experienced, the system’s graphics drivers probably need to be updated: 

1. a screen consisting only of splashes of color 

2. a screen with horizontal or vertical bars running through it 

3. random images of various pieces of the airplane or instrument panel 
Additionally, if an error appears referring to a corrupt or missing ‘.dll’ file, the drivers most likely need to 

be replaced. 

Updating Graphics Drivers in Windows 

Some Windows-based computers are operating with drivers that are out of date or that do not currently 

support OpenGL (caused by using the default Windows drivers rather than those of the manufacturer). If 

you conclude that your graphics drivers need to be updated, the following (general) steps should guide 

you through the process. 

Automatic updating 

Many of the latest video cards come with manufacturer’s software that can automatically download and 

install the latest drivers, easily keeping you up to date. 

1. AMD & ATI Driver Autodetect tool 

2. NVIDIA Update 

Manual updating 

Windows 10 

1. Go to your video card manufacturer’s driver download page (ATI’s site or NVIDIA’s) and download 

the latest drivers, being sure to save it to a place that you’ll be able to find it (for example, the 

Desktop). 

2. Click the Windows icon at the bottom of the screen and type Device Manager in the search box. 

3. Select the device, right click it, and choose “Update Driver Software.” 

4. Select “Browse my computer for driver software” then navigate to the file you saved in step 1. 

5. Click Next then wait until the installation finishes. 

6. Reboot your PC and you’re ready to fly! 

http://support.amd.com/us/gpudownload/Pages/index.aspx
http://www.nvidia.com/Download/index.aspx
https://www.x-plane.com/manuals/desktop/index.html#installingx-plane
http://support.amd.com/en-us/download/auto-detect-tool
http://www.nvidia.com/object/nvidia-update.html
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Windows 8 

1. Swipe in from the right edge of the screen, and then tap Search. (If you’re using a mouse, point 

to the lower-right corner of the screen, move the mouse pointer up, and then click Search.) 

2. Enter Device Manager in the search box, and tap or click Device Manager. 

3. In the list of hardware categories, double-tap or double-click the category your device is in and 

then double-tap or double-click the device you want. For example, to see your video card, tap or 

click Display adapters, and then double-tap or double-click the video card name. 

4. Tap or click the Driver tab, tap or click Update Driver, and then follow the instructions. You might 

be asked for an admin password or to confirm your choice. 

5. Reboot your PC and you’re ready to fly! 

Windows 7 

1. Open Device Manager by clicking the Start button, clicking Control Panel, clicking System and 

Security, and then, under System, clicking Device Manager. If you’re prompted for an 

administrator password or confirmation, type the password or provide confirmation. 

2. In the list of hardware categories, find the device that you want to update, and then double-click 

the device name. 

3. Click the Driver tab, click Update Driver, and then follow the instructions. If you’re prompted for 

an administrator password or confirmation, type the password or provide confirmation. 

4. Reboot your PC and you’re ready to fly! 

Graphics Driver Requirements in Linux 

When running X-Plane on Linux, please note that you must install the proprietary Nvidia or AMD drivers. 

X-Plane will _not_ run using Gallium or Mesa open-source drivers. 

Selecting Flight Control Hardware 
While it is physically possible to fly X-Plane with only the mouse and keyboard, this can be cumbersome 

and unrealistic (for obvious reasons). While instructions for flying this way are included in the section 

“How to Fly” of the chapter Flight in X-Plane, it is strongly recommended that users fly with at least a 

joystick for a realistic experience. 

So which joystick should a user purchase? Most USB joysticks and yokes made in the last 10 years or so 

will work with X-Plane, but, as with most things in life, you get what you pay for. Be leery of joysticks 

advertised for $29.95 at a local retailer. In our experience the cheaper hardware typically does not last 

as long or work as well as more moderately priced equipment. 

Note: X-Plane can only interface with USB devices. This covers nearly all the controllers manufactured in 

the last ten years, but if you have a non-USB device, an adapter will be needed to change it to a USB 

input. 

Joysticks 
Joysticks typically provide pitch, roll, and throttle control, as well as a few buttons that can be 

programmed to do different things. For example, you may program one button to raise and lower the 

http://www.nvidia.com/object/unix.html
http://support.amd.com/us/gpudownload/linux/Pages/radeon_linux.aspx
https://www.x-plane.com/manuals/desktop/index.html#howtofly
https://www.x-plane.com/manuals/desktop/index.html#flightinx-plane
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landing gear, and two additional buttons to raise the flaps and lower them. Also, some joysticks can 

have their handle twisted left and right to control yaw movement. If the joystick being used does not 

offer yaw control, you will probably want a set of rudder pedals to provide realistic yaw control in the 

airplane. A joystick will be best for flying fighter or sport airplanes, or planes made by companies like 

Airbus, Cirrus, or Lancair, for the simple reason that those planes, in reality, are controlled with 

joysticks! 

Yokes 

A yoke consists of a steering wheel-like control that rotates left and right and also slides back and forth. 

These are the best option for users primarily interested in flying older-style general aviation planes, 

business jets, and non-Airbus airliners, since these planes are flown with yokes in reality. 

Yokes are typically clamped to a desk for stability. They may have a built-in throttle quadrant, which will 

allows for independent control of the propeller, throttle, and mixture for a single propeller engine. Also, 

note that yokes do not control yaw movement (they do not twist left and right for yaw control like some 

joysticks), so rudder pedals are required for realistic yaw control. 

Rudder Pedals 
Rudder pedals allow users to realistically control the airplane’s yaw by pushing the left or right pedal to 

turn. While in flight, the pedals control the rudder, whereas on the ground they’re used to steer. The 

pedals also control the brakes to help the airplane stop or turn sharply while on the ground. (Push the 

top of the left or right pedal to activate the brakes on that side of the plane.) 

If neither a set of rudder pedals nor the joystick is set to control yaw, X-Plane will automatically slew the 

rudder to try and keep the airplane flying true. This auto-rudder function, however, is not smart enough 

to take off or land properly in a crosswind, slip, or do various other things that rudders might be used 

for. For this reason, rudder pedals (or at least a twisting joystick) are highly recommended. 

Please note that, when flying a helicopter, pedals must be used for the anti-torque controls—this can 

not be assigned to keyboard commands, simply because it is not practical to try to use the keyboard to 

fly. 

Other Considerations 

For added realism in certain situations, you may want an independent throttle quadrant. CH 

Products’ Multi-Engine Throttle Quadrant is perhaps the most popular and offers independent and 

variable control of six different functions. Normally, this would be set up to control the throttle, 

propeller, and mixture controls for each engine on a twin-engine airplane. This controller can also be 

used to control throttle and condition (fuel cutoff) for jet engines, allowing independent control of jet 

aircraft with up to three engines. A multi-engine throttle quadrant is recommended for users interested 

in realistically flying airplanes with more than one engine. 

To purchase joysticks or other equipment, check out the CH Products, Logitech, or Saitek websites. Each 

of the sites allows users to browse the available products and find where to buy them. Also, feel free to 

ask your questions on the X-Plane Q & A site. You may call or e-mail X-Plane customer support (info@x-

plane.com) with any additional questions. 

http://www.chproducts.com/Throttle-Quadrant-v13-d-718.html
http://www.chproducts.com/13-28464-Home.php
http://gaming.logitech.com/en-us/gaming-controllers
http://www.saitek.com/
http://questions.x-plane.com/
mailto:info@x-plane.com
mailto:info@x-plane.com
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Note that instructions on configuring flight control hardware are found in the chapter Configuring and 

Tuning Your X-Plane Installation, in the section “Configuring Flight Controls”. 

Installing X-Plane 
In order to avoid confusion, be sure to delete any installations of the X-Plane demo, or older versions of 

X-Plane, before installing the full version. (Uninstalling the demo is as straightforward as locating the “X-

Plane 11 Demo” folder and moving it to the Recycle Bin or Trash.) 

Note: If you are using a digital download product key, you will need to download the latest X-Plane 

installer from X-Plane.com. 

DVD Installation 

To install X-Plane using the DVD set, do the following: 

1. Insert Disc 1 into your DVD drive and wait for it to spin up. 

2. If the X-System window doesn’t open automatically, navigate to the drive now labeled “X-Plane 

11” (usually the ’D:' drive). If the X-System window does appear automatically, skip to step 4. 

3. Double-click on ‘X-Plane 11 Installer’ to launch the X-Plane installation. 

4. When the installer window appears, click Install an X-Plane Product Purchase if necessary. 

You can change the language or pick a different operating system for the install by clicking on the 

settings slider icon in the top right corner. 

Note that if the buttons at the bottom of the X-System screen are not visible, then the system is 

probably running at a minimal resolution like 800×600. Using this resolution will not allow the 

computer to display the bottom of the X-Plane screen and you will need to force the installer to 

exit (via Ctrl+Alt+Del) and increase the screen’s resolution in Windows to at least 1024×768. 

5. By default, X-Plane will install to the Desktop. Though it can be installed elsewhere (by clicking 

the Change Destination button), it is strongly recommended that it be placed on the Desktop so 

that the folder can be found in the future, and so it has correct permission settings. 

When an acceptable location has been selected, click Continue. 

6. Accept the user agreement and click Continue once again. 

https://www.x-plane.com/manuals/desktop/index.html#configuringandtuningyourx-planeinstallation
https://www.x-plane.com/manuals/desktop/index.html#configuringandtuningyourx-planeinstallation
https://www.x-plane.com/manuals/desktop/index.html#configuringflightcontrols
http://www.x-plane.com/downloads/x-plane_10_installer-updater/
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Figure 3.1: All scenery selected for installation after clicking “Select All” 

7. Select the scenery you would like to install. Parts of the world that are currently selected will be 

a bright blue color (as all tiles are in Figure 3.1). 

If you are unsure what areas are currently selected, just click Select None to turn everything off 

(as seen in Figure 3.2). From there, move your mouse around the map to highlight sections of the 

world and click on on the ones you would like to install. Note that for regions where no scenery is 

installed, only oceans and airports will be visible. 

 

Figure 3.2: No scenery selected after clicking the Select None button during the installation 

8. When you’re finished selecting scenery, click Continue to begin installing. 

9. The installer will begin displaying its progress. When the installer prompts you to do so, remove 

the current disc and insert the next. Note that installation may take anywhere from thirty to sixty 
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minutes per disc, and that only one X-Plane disc can be in the system at once (the installer won’t 

recognize a disc placed in a second DVD drive). 

10. When the installation completes, reinsert Disc 1 and go fly! 
We recommend installing a small amount of scenery at first. Installing the complete scenery package will 

consume about 75 GB of hard drive space, and doing so will take between five and six and a half hours. 

At any point in the future, scenery can be added or removed by inserting Disc 1 and re-running the 

installer. When the X-System installer comes up with the message “You already have X-Plane 11 

installed on this computer,” click the Add or Remove Scenery button and proceed just like in step 7 

above. 

Special Considerations for Mac Users 

By default, Mac OS X is set to automatically back up the entire hard drive using Time Machine. This 

includes a user’s X-Plane directory. Most people would prefer not to have this backed up, due to the fact 

that it requires a significant amount of space on the backup disk (for something already backed up to 

DVDs or online, no less) and the fact that it takes a great deal of time to complete the backup. 

For this reason, it is recommended that users exclude the X-Plane directory from Time Machine’s 

backup, either during or shortly after the X-Plane installation, by doing the following: 

1. Open the Time Machine preferences, either from the task bar (by clicking the Time Machine icon 

and selecting “Open Time Machine Preferences”) or from the System Preferences (by clicking the 

Time Machine icon there). 

2. With the preferences open, click the Options… button. 

3. Click the + icon to add a folder to the list of excluded directories. 

4. Select the X-Plane installation directory (located by default on the Desktop) and click Exclude. 

5. Click Save and exit the Time Machine preferences. 

Special Considerations for Windows Vista and 7 Users 
Some of X-Plane’s menus may render strangely when using the default Aero themes in Windows 7 and 

Windows Vista. For this reason, it is recommended that users switch to the Basic theme when running X-

Plane. 

To make Windows automatically switch to the Basic theme when you launch X-Plane (and switch back 

when you’re done), do the following: 

1. Locate either the ‘X-Plane.exe’ file (found in the X-Plane 11 installation folder) or the shortcut you 

use to launch X-Plane and right click on it. 

2. Click Properties from the menu that appears. 

3. Go to the Compatibility tab and check the Disable desktop composition box. With that done, 

X-Plane will launch with the Basic theme and all menus will render correctly. 

Digital Download Installation 
To install X-Plane using a digital download product key, do the following: 
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1. Ensure your computer is connected to the Internet. Download the latest X-Plane installer from 

our web site. 

2. Double click the “X-Plane 11 Installer” icon to launch the installer. 

3. Click the Install an X-Plane Product Purchase button if necessary. Enter your digital download 

product key in the boxes on the following screen then click the Continue button. 

4. By default, X-Plane will install to the Desktop. Though it can be installed elsewhere (by clicking 

the Change Destination button), it is strongly recommended that it be left on the Desktop so that 

the folder can be found in the future and all permissions are correct. 

5. Accept the user agreement on this screen. It is highly recommended that you leave the box for 

sending anonymous usage data checked. This allows Laminar Research to gather anonymous data 

to make updates to the simulator based on how you use it. Click Continue once again. 

 

Figure 3.3: All scenery selected for installation after clicking “Select All” 

6. Select the scenery you would like to install. Parts of the world that are currently selected will be 

a bright blue color (as all tiles are in Figure 3.3). 
If you are unsure what areas are currently selected, just click Select None to turn everything off (as seen 

in Figure 3.4). From there, move your mouse around the map to highlight sections of the world and click 

on on the ones you would like to install. Note that for regions where no scenery is installed, only oceans 

and airports will be visible. When you’re finished selecting scenery, click Continue to begin installing. 

http://www.x-plane.com/desktop/try-it/
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Figure 3.4: No scenery selected after clicking the Select None button during the installation 

We strongly recommend that you install only a small bit of scenery now and add more later, as the 

entire scenery package takes nearly 60 GB of space and a very long time to install. 

7. The installer will begin displaying its progress. Note that digital download time estimates are 

based on your initial network speed and real install times may vary significantly. 

8. When the installation completes, start the simulator and go fly! 
Scenery can be added or removed at any point in the future by re-running the installer. When the X-

System installer comes up with the message “You already have X-Plane 11 installed on this computer,” 

click the Add or Remove Scenery button. Enter your digital download product key if necessary and 

proceed just like in step 6 above. 

Special Considerations for Digital Download Users 
In order for the simulator to work (outside of demo mode), the computer running X-Plane Digital 

Download Edition must have an Internet connection to contact our servers. X-Plane does not require an 

Internet connection to re-validate on every single application launch, but it does require authentication 

frequently. If your primary use of X-Plane is on a computer that does not have net access or where net 

access is unreliable or rare, you should purchase a DVD set. 

Note that when you authorize X-Plane using a product key, Laminar Research collects your computer’s 

IP address. We use this information only to verify your product key has not been stolen. We do not sell 

or share this information with anyone else. 

X-Plane digital download product keys are like credit card numbers: the key itself authorizes you to get 

X-Plane, and each user has a different key. If someone else has your key, that user has access to your 

copy of X-Plane. Just like credit cards, you should not share your product key with anyone else. 

If you need to contact Laminar Research customer support, we will only require the last eight digits of 

your product key; you do not need to send your full product key to anyone, including Laminar Research. 
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If someone manages to steal your product key, piracy is prevented by fraud detection; our servers will 

see your key being used in a pattern that looks like multiple people (e.g. your key used from two 

continents at the same time) and it will be locked. Downloading the product repeatedly may appear to 

be piracy and may also cause your key to be locked. You can contact X-Plane customer support if you 

experience problems with your digital download product key. 

A digital copy of X-Plane is not a backup. The digital version of X-Plane is available online at any time for 

download, but it is not a replacement for a good backup of your computer(s); only a true backup can 

save your preferences, third party aircraft you’ve downloaded, your log book, etc. 

Additionally, only the latest, non-beta version of X-Plane 11 is available digitally. If you do not want to 

update to the latest version, you need to make your own backup of X-Plane; re-installing the product 

will get the latest version. 

Launching X-Plane 
Unlike many of the programs you may be familiar with, X-Plane does not create shortcuts to itself across 

your hard drive. We recommend launching X-Plane by opening the X-Plane 11 installation directory 

(located by default on the Desktop) and double-clicking the X-Plane icon. However, if you would like, 

you can create a shortcut (called an “alias” in OS X) by doing the following: 

1. Open the X-Plane installation directory (located by default on the Desktop). 

2. In Windows, right-click on the X-Plane.exe icon and select Create Shortcut. In Mac OS, right-click 

on the X-Plane.app icon and select Make Alias. 

3. Drag the shortcut wherever you wish to launch X-Plane from. 
To launch X-Plane for the first time: 

1. Make sure your USB joystick is plugged in. To avoid any possible problems, it is recommended 

that the flight controls be plugged directly into the machine rather than into a hub. 

2. If you own the DVD set, put Disc 1 into your DVD drive. 

3. Open the X-Plane folder (located by default on the Desktop) and double click on ‘X-Plane.exe’ in 

Windows, or ‘X-Plane.app’ on a Mac. 

4. If you have a digital download key, X-Plane may prompt you for your key, or the field may be pre-

filled if you have entered your product key before (i.e., during installation). Simply click 

“Authorize” and X-Plane will proceed. Starting the simulator without this or a DVD in the drive will 

force it to run in demo mode only. 

5. If you have successfully used your digital download product key, X-Plane will try to contact the 

authorization server in the background without prompting you. Thus if your net connection is 

good and your product key is not locked, you may never notice or need the product key again to 

fly. 

mailto:info@x-plane.com
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Configuring and Tuning Your X-Plane Installation 
Having installed X-Plane as described in the previous chapter, you can configure the simulator in a 

number of ways. These include downloading the latest free update (giving you the latest set of features 

available), setting up flight controls, and tuning the performance of the simulator both in terms of 

graphics quality and frame rate. 

General Use of the X-Plane Interface 
X-Plane has been written to operate on Windows, Macintosh, and Linux systems. For consistency’s sake, 

the layout and appearance of X-Plane is the same across all three operating systems. 

Here are a few pointers to aid in the learning process: 

X-Plane’s menu is hidden. To access the menu bar, move the mouse pointer to the top of the screen. 

When the mouse is within a centimeter or so of the top edge of the screen, the menu bar will appear. By 

default the Esc key will also display the menu. You’ll find the majority of X-Plane 11’s options in the drop 

down menus in the left of this menu bar. 

Some of the key functions of the simulator are accessed through small icons on the right side of the 

menu bar however. From left to right, clicking the icons will: pause the simulator, open Flight 

Configuration, show the ATC window, show the map, open Settings, and open a help webpage. Keep in 

mind you can use keyboard shortcuts to access many of these features as well. 

 

Figure 4.1: The menu icons 

Keyboard shortcuts can be found by opening the settings screen and going to the Keyboard tab. These 

keyboard assignments can also be changed using this screen (per the section “Configuring Keyboard 

Shortcuts”) to anything you like. Also note that many of the keyboard shortcuts are shown in the 

X-Plane menus. For example, opening the View menu will display the list of available views on the left 

side of the drop down menu, with the list of corresponding keyboard shortcuts on the right. 

You can adjust almost all aspects of how the simulator runs by going to the Settings screen. Here you’ll 

find tabs to adjust the settings associated with the sound, graphics, networking configurations, data 

input and output, joysticks and flight hardware, and the keyboard shortcut assignments. Many other 

helpful options, such as the language and warnings, can be found in the General section. The 

Notification Settings button in this screen allows you to turn off or on various warnings as well. 

Like most programs, the simplest way to navigate around X-Plane is using the mouse, though there are 

many keyboard shortcuts to help you navigate quickly through the options after you become familiar 

with the program. These shortcuts are particularly important when using the mouse to fly. In that case, 

it is much easier to use the ‘2’ key to drop a notch of flaps than it is to let go of the controls, reach down 

with the mouse to adjust the flaps, and then reach back up and grab the controls again. 

Also note that most instruments and controls inside the cockpit are interactive, meaning that the mouse 

can be used to alter switches, set frequencies, manipulate the throttle(s), change the trim, etc. 

https://www.x-plane.com/manuals/desktop/index.html#preparationandinstallation
https://www.x-plane.com/manuals/desktop/index.html#configuringkeyboardshortcuts
https://www.x-plane.com/manuals/desktop/index.html#configuringkeyboardshortcuts
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Configuring Flight Controls 
With your flight controls plugged in and X-Plane running, you can configure how the simulator responds 

to input from each axis and button. Throughout this section we will refer to any input device as a 

joystick; the instructions apply to yokes, throttle quadrants, and rudders also. Configuring should be 

done upon initial set up of X-Plane and any time new equipment is plugged in, but it is not necessary to 

configure hardware upon every use. 

The first time a joystick or yoke is plugged in, the program can automatically take you to the joystick 

settings screen to configure the device. If you selected No in the Joystick Quick-Config box, move the 

mouse to the top of the screen and click the settings icon, then Joystick, and continue with the steps 

below. 

Video 4.1: Configuring joysticks tutorial 

Setting Up the Control Axes 
Click on the Calibrate or Calibrate Now button. This will open the dialog box allowing you to configure 

and calibrate the flight controls. 

 

Figure 4.2: The calibration window of the Joystick settings screen, with the device partially calibrated 

To begin, move the joystick’s controls around to see how the axes are mapped in X-Plane.  As this is 

done, one of the red bars will move vigorously for each input that is actuated. (Note that if you are using 

a trim wheel, you may have to roll the wheel continuously to see which axis it is mapped to.)  Thus, 

when the stick is rolled left and right only one bar will move a substantial amount; when it is pushed 

back and forth it will be a different bar.   

Move your joystick through the full range of motion for each axes, and each slider through its entire 

range as well. Move your joystick or yoke forward and back for pitch. Move your joystick/yoke left and 

right for roll, and twist your joystick (if applicable) for yaw. (If you do not have or assign a yaw axis, 

X-Plane will attempt to stabilize it for you.) Once all the red bars have changed to blue, click on 

the Next button. 

Note that if you’re unable to move the controls through their full range of motion you may simply click 

the Accept Axis or Ignore Axis button for each axis that X-Plane believes to be uncalibrated, but which 

you have confirmed has actually gone through its full range of motion. 

Let go of the controls and press the Next button to begin centering the controls and setting the 

nullzone. When the timer’s up, press the Finish button to go back to the joystick screen and complete 

joystick set up. 
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Figure 4.3: The Joystick settings screen, after calibration is completed 

If any axes were not recognized automatically, or were incorrectly categorized, in the first calibration 

screen, you can set them in the right column of the joystick settings screen. Simply use the drop down 

menu to select the appropriate axis type. In addition, you will need to do this for any device that does 

not have a default configuration file, as all the buttons and axes will be assigned to “none” (see Figure 

4.4 below). 

 

Figure 4.4: When an unknown device is used, all axes and buttons are set to “none” until manually 

changed 

To manually configure flight control axes: 

1. Move your joystick or yoke forward and back, or spin your trim wheel continuously. One of the 

bars should move as you do so. Click the drop-down menu next to it and set it to pitch. 

2. Move your joystick/yoke left and right. The bar that moves should be set to roll. 

3. Twist your joystick (if applicable). The bar that moves should be set to yaw. If you do not assign a 

yaw axis, X-Plane will attempt to stabilize yaw movement for you. 

If you are using rudder pedals, slide them forward and backward and set the bar that moves then 

to yaw. Additionally, only when using rudder pedals, press the left pedal down with your toes. 

The bar that moves should be set to left toe brake. Do the same for the right pedal, and set that 

bar to right toe brake. 

4. Move your throttle forward and back (on a yoke, this is typically the leftmost lever). Set this bar 

to throttle. 
Note: Any remaining bar (if applicable) which is not actively controlled by your hardware needs to be set 

to none. When this is set, X-Plane is not using the axis. 
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Assigning Functions to Buttons 
Each of the buttons and switches on the joystick can be assigned a function within X-Plane (for example, 

toggling the brakes or landing gear) in the right column of the Joystick settings screen. 

 

Figure 4.5: Clicking button 5 in the image highlights the button in the list on the right 

You can tell which button you’re assigning by the mapping in the image on the left. Click on a number to 

highlight the line in the list on the right side of the screen. You can also press the button on the joystick 

and seeing which number in the list lights up. 

Assign a function to a hat switch by picking from the drop down menu. Assign a function to a button or a 

two-direction switch by clicking the Edit button and scrolling through the list of commands, or by typing 

a key term in the search bar, as in Figure 4.6 below. 

 

Figure 4.6: Searching commands for the term “brakes” 
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Repeat this process for as many buttons and switches as need functions assigned. If buttons appear to 

be missing from the list in this screen, check under the “Views” drop down for additional images of the 

device that may have additional buttons mapped. Close the Joystick window and the settings will be 

saved to preferences. 

Controlling Joystick Sensitivity and Aircraft Stability 
To modify the joystick’s sensitivity, press the Control Sensitivity button at the bottom of the Joystick 

settings screen. The three sliders in this window control the response curves for the pitch, roll, and yaw 

axes of the joystick. 

If these sliders are set all the way to the left, the aircraft’s response to that axis’ input will be completely 

linear. This means that a 50% deflection of the joystick will deflect the airplane’s flight controls 50% of 

their travel. As these sliders are moved to the right the response becomes curved. In this case, a 

deflection of the joystick from center to its halfway point may only deflect the aircraft’s controls by 10%. 

This will dampen any aircraft movements and desensitize the user’s controls. Keep in mind, however, 

that in this case, the remaining 90% of the control surface deflection must take place in the last 50% of 

joystick movement. Thus, the controls will be dampened for the first half or so of their travel and then 

become hyper-sensitive for the remainder of their throw. This gives the user plenty of fine-tune control 

near the center of the flight control envelope to hold altitude and roll precisely, but still allows for full 

control authority at the extremes. 

Try flying with the sliders in various different positions to see what setting works best. 

To modify the stability of the aircraft, press the Stability Augmentation button. These sliders control X-

Plane’s stability augmentation by damping the predicted forces acting on the aircraft’s flight control 

surfaces. If these sliders are all the way to the left, then there is no stability augmentation of the aircraft. 

As the sliders are moved to the right, X-Plane will automatically add some stability augmentation to the 

aircraft, adding some elevator input to level the nose, some aileron input to minimize the roll rate, and 

some rudder input to counter any aircraft yaw rates. In other words, the simulator will try to make the 

plane easier to fly by adding control inputs for the user. The downside, of course, is that as X-Plane adds 

stability, the aircraft becomes less responsive (and less realistic). 

In X-Plane 11.30, each axis can also have a custom response curve which will override the global control 

response curve. This allows you to do things like manually configure a null zone, or create complex 

curves with many control points and your choice of interpolation. Depending on the type of axis, there 

will be additional options to configure ranges for certain axis-specific behaviors such as beta & reverse 

ranges for throttles, feather range for prop controls, or cutoff range for mixture controls. 
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Figure 4.7: Example of custom response curves for a throttle axis 

Adding Special Equipment 
Click the PFC Hardware button to set up special equipment for use in X-Plane. This tab is generally used 

on multi-computer X-Plane configurations in professional, FAA-certified simulators or to tie in various 

GPS navigators (such as a real Garmin 96/296/396 or a 430 GPS radio). After being connected to the 

computer, this equipment should be set up per the manufacturer’s recommendations, then checked off 

on the Equipment screen to tell X-Plane that it is connected. 

Configuring Keyboard Shortcuts 

X-Plane has been designed to be both extremely flexible and easily usable. For this reason, most of the 

keys on the keyboard do something. 

To see which keys are tied to which functions, open the settings by moving the mouse to the top of the 

screen, clicking the settings icon, and clicking on Keyboard. Here you can look at the functions assigned 

to the keys of the keyboard. 

You can use the buttons on the left side to narrow down the list, or use the plus and minus symbols to 

change how many items are shown from the list of functions. Functions are classified into a number of 

categories (operation, engines, ignition, etc.), but if you aren’t sure what category a functions falls 

under, you can use the search bar to find it. 

The description of the function is on the left while the button assigned to it is on the right. To change 

the key a command is bound to, type in the box on the right or use the +. Use the - to delete a key 

assignment. 
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Note that it is not necessary to try and remember all of the keyboard shortcuts. Instead, many of them 

are shown in the menus when flying. For example, while in flight, move the mouse to the top of the 

screen and click the View menu and a subcategory. The keyboard shortcut it’s assigned to is found on 

the right. For instance, in the view menu, the “Forward with 2-D Panel” view has a “w” symbol next to it, 

so it can be selected with the ‘w’ key. 

Joystick and Keyboard Profiles 
Starting in X-Plane 11.10, you can save profiles for different combinations of keyboard and joystick 

settings. This means you can now specify different button or axis assignments for the same joystick and 

switch between them from within X-Plane. 

 

Figure 4.8: The Active Profile window of the Joystick settings screen selected in orange 

To get started creating a joystick or keyboard profile, click on the Active Profile drop down in the lower 

left corner of the joystick or keyboard screen and select “save as new profile.” Enter a new name that 

will help you identify this profile later on. Now you can change key, button or joystick axis assignments 

as desired and X-Plane will associate them with this specific profile. Any time you create another profile, 

all current assignments will be copied to the new profile for you to then adjust as desired. 

To delete profiles and assign them to individual or groups of aircraft, click the Manage Profiles button 

next to the Active Profile dropdown. 
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Figure 4.9: The Manage Profiles window of X-Plane 11.10 

You can manage all your profiles in the left side of this window. Click on the minus sign (-) icon next to a 

profile name to delete it. Double click on a profile name to edit it. You can also add a new profile here 

and then return to the joystick or keyboard settings screens to change its assignments. 

Assign profiles to aircraft in the Associated Aircraft column on the right side of this window. You can use 

the search bar or the expand/reduce buttons next to aircraft types to narrow down your aircraft list. By 

clicking on the drop down next to an aircraft type, such as “Airliner,” you can assign a profile to all 

aircraft of that type. Or you can click the drop down next to individual aircraft to change profile 

assignments one by one. 

Profiles will also be assigned automatically when you change from one profile to another while a flight is 

in progress. Thus, you never have to manually assign aircraft associations if you don’t want to—you’ll 

just get whatever you were using last. 

Configuring the Rendering Options 
X-Plane is a very advanced simulator that has been designed for use across a broad range of computers 

with varying specifications. As such, X-Plane offers the ability to change graphics settings to optimize 

performance on your computer. The Graphics tab of the settings window allows you to match X-Plane’s 

settings (and thus the demands the simulator puts on the computer) to you computer’s capabilities. 

The simulator’s performance is measured in frames per second (FPS, or frame rate). This is how many 

times per second the X-Plane physics and rendering code (currently more than 700,000 lines of code!) 

can be run. Each time the computer runs through the program it advances the aircraft and recalculates 

the images that are seen (cloud formations, scenery, aircraft instruments, other aircraft, etc.). 

Obviously, X-Plane has to be tremendously flexible to be able to run on a three year old computer and 

also take full advantage of the latest and greatest hardware available. There are two things that affect X-
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Plane’s frame rate: the computer’s capabilities and how much it is being asked to simulate (e.g., how 

much visibility is set, how many buildings, clouds, and other aircraft are being drawn, etc.). It will be 

much harder for the computer to compute images when flying an airplane in 30-mile visibility with 8,000 

3-dimensional buildings and cloud puffs than it would be if X-Plane were set up with only two or three 

miles of visibility and no clouds. Thus, generally speaking, the higher the rendering options are set, the 

lower the performance and frame rate achieved. 

The faster a computer can run X-Plane the more realistic and rewarding the simulation will be. Testing 

has shown that the human brain can separate individual frames at frame rates of less than about 20 FPS, 

causing the simulation to appear “choppy.” Coincidentally, this is also about the same place that the 

engineering behind the simulation begins to fall apart. For this reason, X-Plane has set the minimum 

operating speed at this level. If a computer is not capable of delivering a frame rate of 20 FPS while 

rendering the level of detail set up in the Rendering Options page, X-Plane will automatically introduce 

fog to help the simulation to run more smoothly. The fog keeps X-Plane from having to draw the world 

to as great a distance, allowing the simulation to run faster. 

Displaying the Frame Rate 

Before we begin, we will need to be able to tell how fast X-Plane is running on your computer. To do 

this, launch X-Plane and: 

1. Move your mouse to the top of the screen (causing the menu to appear) and click the settings 

icon, then the Data Output tab. 

2. On the first line, Frame rate, check the first box to display the current frame rate in the upper 

left of the screen during flight. 

 

Figure 4.10: Checking the box to display the frame rate while in the simulator 
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3. Close the Data Output window. You should now see how fast the simulation is running, in the f-

act / sec output on the far left (highlighted in orange in the image below). This is the current 

frame rate, given in frames per second (fps). 

 

Figure 4.11: The frame rate per second highlighted 

Note that the frame rate will change depending on what is happening in the simulation. It is not 

uncommon for a computer to output 50 fps while sitting on an empty runway, but drop down to, say, 30 

fps when rendering lots of buildings, other aircraft, etc. 

Refer to the following to determine the significance of this number. 

1. 19 fps is terrible and barely adequate to run the simulator. 

2. 25 to 35 fps is the ideal range. Higher frame rates indicate the computer isn’t rendering with as 

much detail as it could. 

3. 50 fps is very high and indicates that the system could probably draw more buildings, clouds, 

and other objects. 

Setting the Rendering Options 

The Graphics screen is used to configure the level of detail in the simulator. This window can be found 

by moving the mouse to the top of the screen, clicking on the settings icon, and clicking Graphics. 

The rendering options sliders are organized with settings that depend primarily on CPU on the right, and 

GPU-heavy options on the left. The Visual Effects slider adjusts the quality of the visual effects, such as 

shadows and light reflection and is dependent on the quality of your graphics card. If you have a new 

and/or fairly powerful GPU, try setting this slider to high or maximum. 

 

Figure 4.12: The Rendering Options screen of the Settings window 

Adjust the Texture Quality slider to fine tune the level of detail in the textures of the cockpit and world 

objects. This setting determines the clarity and detail of the textures displayed in X-Plane. Textures are 

the image-maps that are draped over the terrain and aircraft to make them look realistic. If it is set too 

low, the runway and terrain will look blurry and blocky. While this will not look very good, it will use very 

little video memory (VRAM), so a high frame rate will be more easily achievable. The more powerful a 

computer’s video card is, though, the higher the texture resolution can be set in X-Plane without hurting 

the frame rate. The frame rate will be significantly impacted, though, if a texture resolution is selected 
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that requires more VRAM than the computer’s video card has. You will need to restart X-Plane to see 

the effect of changing this slider. 

The Antialiasing slider is used to smooth the edges of the objects drawn in the simulator. When a 

computer tries to draw diagonal lines across the finite number of rectangular pixels in a monitor, 

“jaggies” result–pixelated-looking, stair-stepped lines. These jaggies may be (somewhat) eliminated by 

turning on anti-aliasing. This will cause X-Plane to actually draw the simulated world several times per 

frame and blend those frames together, resulting in a better looking image. Thus, it is similar to using a 

higher screen resolution; running at a resolution of 2048×2048 without anti-aliasing is similar to running 

at 1024×1024 and 4× anti-aliasing. Both situations tax the video card with virtually no increase in CPU 

use. This will completely kill the simulator’s frame rate if the system doesn’t have a strong video card, 

but if the video card can take it, crank this option up. Note that X-Plane must be restarted to see 

changes to the antialiasing slider in non-HDR modes. 

The Number of Objects slider will adjust how many 3D objects are drawn in the world, such as trees, 

buildings, and static aircraft. If you have a powerful CPU you can set this to high or even maximum 

without affecting your frame rate too much, and the highest settings will ensure that you see all there is 

to see around an airport. Check the Draw parked aircraft box if you would like to see static aircraft at 

airports. 

If X-Plane is still running at a very high frame rate, you can also choose to check the box next to “Use 

Vsync” at the bottom of the window. This will limit X-Plane’s frame rate to the refresh rate of your 

monitor, thus preventing brief frame rate drops, or stutters. Checking the Draw shadows on 

scenery box will also add detail that older, slower cards may not be able to handle. 

Always keep in mind that, if your graphics card has too little VRAM for the textures X-Plane is loading (a 

very real possibility in this version), you may see a huge drop in frame rate when you move up a notch 

on one of the GPU-dependent sliders on the right. 

We recommend putting the Texture Quality slider on its lowest setting, exiting the sim, restarting it, and 

noting the frame rate. Keep an eye on the message below the slider that shows how many megabytes of 

textures are loaded. From there, raise the slider up one level and repeat until the frame rate decreases. 

This is the point at which all of the video card’s RAM is being used. Back the texture resolution off to one 

level lower than where the decrease was noted and restart X-Plane one more time. 

Finally, you can enable the TrackIR, TrackHat or Matrox TripleHead2Go with the checkboxes at the 

bottom of the window. 

Setting the Rendering Options for Best Performance 

If the simulator’s frame rate isn’t as high you would like, you can raise it by following the instructions 

below. We recommend being very methodical and following these instructions in order, checking the 

frame rate after each major change until you find settings that give an acceptable frame rate. Ensure the 

frame rate is visible on screen per the instructions in Displaying the Frame Rate above. 

Video 4.2: Setting the rendering options tutorial 

First, know that your overall frame rate will be limited by either your CPU or your GPU (your graphics 

card). Your CPU may be much more powerful relative to your graphics card, or vice versa. In such a case, 

https://www.x-plane.com/manuals/desktop/index.html#displayingtheframerate
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you could hypothetically turn the CPU-heavy features up much higher than the GPU-heavy features (or 

vice versa). 

The left half of the “Rendering Options” settings section contains the GPU-heavy features: visual effects, 

texture quality, antialiasing, and shadows. Likewise, the right half of the Rendering Options is the CPU-

heavy features: world objects, reflection detail, and parked aircraft. 

To find the best compromise between performance and visual quality for your specific machine, start 

with all sliders at their minimums, and all checkboxes off. From there, turn up the settings in the order 

detailed below. 

Tuning CPU Settings 

Go to a big airport with lots of 3-D objects, like KSEA. Enable the parked aircraft, and start turning up the 

number of world objects and reflection detail. Eventually you will hit a point where your frame rate 

drops lower than you would like, and at that point, you’ll want to back off a step. 

Note that the effect on your frame rate from the number of objects and reflection detail are very much 

cumulative: if you have minimal objects, you might be able to max out the reflection detail, but as you 

add more objects (giving X-Plane more things to calculate reflections for) you’ll need to dial down the 

reflections. 

Tuning GPU Settings 

Now let’s adjust the texture quality. 

Having found the number of objects you want to use, start bringing the texture quality slider up. Note 

that you’ll need to restart X-Plane (and go back to your testing airport) for changes to take effect. If the 

size of the loaded textures ever goes beyond your graphics card’s VRAM, you’ll see a sharp drop in 

performance, so for safety’s sake, leave some “padding” here–different airplanes and different scenery 

packs might need more VRAM than your test area. 

For other features on the GPU side, increase the Visual Effects slider first, and only increase the 

Antialiasing or add scenery shadows if you get all the other rendering settings to a point you’re happy 

with and still have higher frame rate than you need. 

Changing the Number of Other Aircraft 

The final setting that really impacts the simulator’s frame rate is the number of other airplanes. Access 

this by going to the Flight Configuration screen and clicking the AI Aircraft button. 

There, remove all other aircraft by clicking the ‘X’ for maximum speed. This means X-Plane will only have 

to calculate physics on your aircraft, providing a significant speed increase on slower CPUs. 

With that done, your performance should be optimized, and you’re ready to fly. 

Configuring the Monitor 
At the bottom of the Graphics section of the Settings screen are the options for configuring the monitor. 

Use the drop down menu to switch between full screen and windowed mode, or the Instructor 

Operating Station (requires at least two monitors). 
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Video 4.3: Configuring the monitor tutorial 

When using X-Plane in full screen mode, the resolution will default to the same resolution as your 

operating system. You can change this with the Resolution drop down, but keep in mind that if you 

choose a resolution with a different aspect ratio than your monitor has, X-Plane will appear stretched. 

This would happen, for instance, if your monitor had a native resolution of 1920×1080 (a widescreen, 

16:9 aspect ratio) and you selected a resolution of 1024×768 (a “standard” 4:3 aspect ratio). The lowest 

available resolution is 1024×768. Increasing the resolution may also cause a drop in frame rate if your 

graphics card is not powerful enough. 

If X-Plane is displayed full screen or in a window that is larger than 1920x1080, you will also have the 

option to increase the User Interface Size in a drop down menu in the middle “Accessibility” section. 

This is especially helpful for those with large, high resolution monitors. Set this to 150% or more to 

increase the size of the text and interface throughout the simulator. Starting in X-Plane 11.30, you can 

also pick between 8 options to increase the font size of the user interface in this section. 

 

Figure 4.13: Font size set a few options higher than default 

Expand the Visuals Settings to set the default view or turn off windshield effects such as cracked glass 

after a crash. 

You can adjust the Lateral field of view in the Field of view section. This changes the extent of the 

observable scenery that is onscreen. Widescreen monitors (those with an aspect ratio of, say, 16:10 or 

16:9 and a resolution of, say, 1920×1080, 1600×900, and so on) may benefit from a wider field of view 

(60° or more). Older monitors with a 4:3 aspect ratio (corresponding to a resolution like 1024×768 or 

1600×1200) probably want to stick to a 45° field of view. 
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If you are using a multimonitor set up, expand the Visual Offsets section to make adjustments for 

monitor bezels or wraparound monitors. See the section Configuring a Multi-Monitor Simulator for 

more details. 

Configuring the Sound 
To configure the sound, move your mouse to the top of the screen and click on the settings icon, then 

Sound. The options here allow you to configure the relative volumes of all sounds in X-Plane using the 

sliders on the left side of the window. On the right side, ATC sound and text can be turned off or on. By 

default, all sounds are enabled, with volumes set at 100% (sliders fully to the right). 

This window will also check the status of speech synthesis software used for ATIS.AWOS. If the software 

is not installed on Windows, download the Microsoft Speech SDK 5.1. 

Setting the Language 
To change the language used throughout X-Plane, move your mouse to the top of the screen (causing 

the menu to appear) and click the Settings icon. Then, click on the General tab and select select your 

language from the list in the section labeled “Language.” 

Updating X-Plane 

The X-Plane simulator is designed for both realism and longevity. Maximizing both of these requires that 

X-Plane be updated often. We regularly release new updates to the simulator that contain feature 

enhancements, bug fixes, stability improvements, aircraft and resource updates, flight model 

improvements, and even new feature additions. 

A purchase of X-Plane entitles you to free updates through that full X-Plane version run. This means that 

if you purchase the Version 11 discs, you will get the Version 11.10 update, the Version 11.20 update, 

etc., all the way through Version 11.99 if it exists—all free of charge. Of course, you do not have to take 

advantage of these updates, but it is recommended that you do so. 

If an update is available you will be notified the next time you start X-Plane. If you’d like to update 

immediately, click the Update button to automatically download and launch the latest installer/updater, 

then complete the process. 

If you would like to check what version of the simulator you’re using: 

Go to Settings > General. 

Click the About X-Plane button in the bottom left corner. 

Your version number will be listed in the “About This Copy of X-Plane” section. There will be an Update 

X-Plane button if an update is available. Clicking this will cause X-Plane to download the latest updater 

and run the updater for you. 

Using the X-Plane Betas 
In between official (or “stable”) releases, users can download beta versions of the upcoming update. 

These are treated as a kind of “update in progress”—new features and bug fixes are included, but in the 

beta stage, the updates have not been fully tested in a range of situations. This means that they may 

create incompatibilities or create other problems that would not be experienced in the stable releases. 

https://www.x-plane.com/manuals/desktop/index.html#configuringamulti-monitorsimulator
http://www.microsoft.com/en-us/download/details.aspx?id=10121
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The X-Plane beta updates are for users who want to help test the newest refinements to the X-Plane 

software. The advantage to doing so is that these users get access to the latest enhancements to the 

software. The downside is that there is a greater risk of encountering problems with third-party models 

or other general bugs. We recommend that most users stick to the stable version releases, as these are 

the ones known to “just work.” 

See the X-Plane Release Notes page for information on the latest builds. 

To install a beta: 

Run the installer/updater. 

Pick “update” 

Uncheck “get betas” 

When prompted to keep or overwrite modified files, pick “overwrite”. (WARNING: if you have your own 

modifications, do not pick overwrite for your own mods. This is only an issue if you have add-ons that 

modify x-Plane system files.) 

Note that Steam users only have access to the final betas, called “release candidates.” 

Uninstalling X-Plane 
The X-Plane installer does not infest your hard drive with shortcuts and directories. Therefore, all it 

takes to uninstall the program is to delete the X-Plane installation folder (located by default on the 

Desktop) by dragging it to the Recycle Bin or Trash. After you empty the Recycle Bin/Trash, the program 

will be removed completely from your hard drive. 

Allowing X-Plane through Your Firewall 

Some features of X-Plane require that X-Plane be able to communicate across your network. These 

features include: 

networked multiplayer flights, 

multi-computer simulations, 

integration with apps on mobile devices or tablets 

In order for your computer to “see” the other computers in the situations above, you must first allow 

X-Plane to communicate through your firewall. If your computer is not running a firewall, of course, this 

is of no concern to you. 

To do this in Windows 7, 8 and 10: 

Open Windows Control Panel and select “System and Security.” 

In the Windows Firewall pane, click Allow a program through Windows Firewall. 

Select the check box next to X-Plane in the Allowed programs, and then click OK. If X-Plane is not in the 

list, you can add it by clicking the Allow another program button underneath the list and browsing for it. 

To allow X-Plane through the firewall in Mac OS, 

http://www.x-plane.com/types/release-notes/
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Open System Preferences from the Apple menu. 

Click Security & Privacy. 

Click the Firewall tab. 

Unlock the pane by clicking the lock in the lower-left corner and enter the administrator username and 

password. 

Click Firewall Options to customize the firewall configuration. 

Click the + (plus) button, then select your copy of X-Plane.app. With X-Plane selected, click Add, 

then OK. 

If you need to allow X-Plane through a corporate firewall, open the Operations & Warnings screen and 

enter a non-transparent HTTP proxy in the box at the bottom of the window. 

Expanding X-Plane 
X-Plane can be modified in a number of ways. You can add aircraft or custom scenery, or you can 

download plug-ins that can radically alter the functionality of the simulator. If you don’t find the aircraft, 

scenery, or plug-ins you’re looking for, you can create your own with a bit of programming know-how. 

The X-Plane Developer site has a wealth of information on creating both scenery and aircraft, and the X-

Plane SDK site has documentation on developing plug-ins. The Plane Maker manual will prove especially 

useful for users creating aircraft files, while those developing scenery should keep the WorldEditor 

manual handy. 

Adding Aircraft 
Perhaps the easiest place to find new aircraft is on X-Plane.org. X-Plane.org has models for sale (some of 

which are very, very good) as well as free models. Other noted sources of high-quality, payware aircraft 

are the folks at X-Aviation, as well as Jason Chandler of AIR.C74.NET. 

When downloading a custom aircraft, it will typically be in a compressed folder (usually a ZIP file) that 

contains the airplane and all its various paint jobs, airfoils, custom sounds, and instrument panels. Once 

the compressed folder is downloaded, you should be able to double-click on it to open or expand it on 

Macintosh, Windows, or Linux computers. 

From here, the folder can be dragged and dropped into the Aircraft folder. For instance, for a newly 

downloaded Piper J–3 Cub, the folder path in Windows might look like this: 

C:\User\Desktop\X-Plane 11\Aircraft\Piper Cub 

With the new aircraft in the proper directory, open up X-Plane. When you start a new flight, your 

aircraft will show up in the aircraft grid of the Flight Configuration screen. (If the aircraft does not come 

with icons for the grid, you can have X-Plane generate them by using the commands “(re)generate all 

icons for this aircraft” or “(re)generate the icon for the current aircraft & livery”. Bind them to a button 

or key according to the instructions in Configuring Flight Controls.) 

Of course, users can also upload their own aircraft to X-Plane.org and similar sites, after creating a 

custom airplane per the Plane Maker manual. We place no copyright restrictions of any sort on aircraft 

http://developer.x-plane.com/
http://www.xsquawkbox.net/xpsdk/mediawiki/FrontPage
http://www.xsquawkbox.net/xpsdk/mediawiki/FrontPage
http://developer.x-plane.com/manuals/planemaker/
http://developer.x-plane.com/manuals/wed/
http://developer.x-plane.com/manuals/wed/
http://forums.x-plane.org/index.php?/files/
http://www.x-aviation.com/catalog/
http://www.c74.net/xplane/index.html
https://www.x-plane.com/manuals/desktop/index.html#configuringflightcontrols
http://forums.x-plane.org/index.php?app=downloads
http://developer.x-plane.com/manuals/planemaker/
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made by users with Plane Maker, and these custom aircraft may be uploaded and shared (or sold) at 

will. 

Adding Scenery 
Custom scenery packages, too, can be found on the X-Plane.org download page, among other places. 

These may be downloaded and installed at will. Typically, custom scenery packages will need to be 

unzipped into the X-Plane ‘Custom Scenery’ folder, and X-Plane will load them automatically the next 

time it is started. 

Advanced scenery customization may be handled through modification of the “scenery_packs.ini” file 

found in the Custom Scenery folder. This file determines the order in which scenery packs load, with 

files at the top of the list overriding those lower down. Any time a new scenery pack is added to the 

Custom Scenery folder, it is automatically added to the top of the scenery_packs.ini file, and therefore 

takes priority. 

To modify the order of scenery packs, open the scenery_packs.ini file with a text editor of your choice, 

and simply move the scenery pack line to a different location in the list (i.e., higher for those packs you 

most want to see and lower for those it is less important to see). Additionally, 

the XAddonManager utility may be helpful for managing a large amount of custom scenery or 

downloaded objects. 

To create your own custom scenery, use the World Editor tool (WED), downloadable for free from 

the Scenery Tools page of the X-Plane Developer site. A good number of tutorials for the tools can be 

found in the Scenery Development documentation section of X-Plane Developer and on YouTube. 

The Airport Scenery Gateway 

The Airport Scenery Gateway is a community-driven effort to collect airport data into a global airport 

database. It is a collection of all airport layouts authored by the X-Plane community over the years. 

Custom airports made in WED and uploaded to the Gateway are shared with all X-Plane users via 

updates to X-Plane. 

The latest Gateway scenery will be provided automatically via updates. You may also add scenery from 

the Airport Scenery Gateway before that happens, but note that if you do so, it will suppress any later 

Global Airport updates to that same airport. 

For additional information or to register as an artist, check out the Airport Scenery Gateway homepage 

or the Airport Scenery Gateway reference article. 

Installing Plug-Ins 
Plug-ins are little programs that let you modify X-Plane. People write plug-ins to do all sorts of 

interesting things like hang weights on the dashboard that move around accurately, run little tugs 

around to push your airplane on the ground, or draw interesting terrain visualization systems, among 

other things. Once again, X-Plane.org is a good place to go to find various plug-ins and other things to 

tweak your copy of X-Plane. 

For information on creating custom plug-ins, see the X-Plane SDK site. 

http://forums.x-plane.org/index.php?/files/
https://code.google.com/p/xaddonmanager/
http://developer.x-plane.com/tools/worldeditor/
http://developer.x-plane.com/docs/scenery/
http://gateway.x-plane.com/
http://gateway.x-plane.com/
http://developer.x-plane.com/?article=airport-scenery-gateway
http://forums.x-plane.org/index.php?/files/
http://www.xsquawkbox.net/xpsdk/mediawiki/FrontPage
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Flight in X-Plane 
X-Plane, of course, is a flight simulator. A typical flight consists of some, if not all, of the following steps: 

choosing an aircraft, 

going to a location (either an airport’s runway, a location some distance out from an airport in order to 

make an approach to the airport, or a random location), 

setting the weather and time of day, and 

actually flying. 

In addition, you might take advantage of a number of features of the simulator either before or during a 

flight. These include using instruments in the aircraft’s panel, switching your view of the aircraft, 

visualizing your flight (either on a 2-D map or in 3-D), and creating files to share your flight with others. 

Setting Up Your Flight 
The first thing you see when you launch X-Plane is the main menu. Here you can pick from four options 

to get flying. You can also quit from this screen, or adjust your settings. 

Resume Last Flight will load the aircraft you were last using when you quit X-Plane and place it at the 

closest airport. Load Saved Flight will allow you to load one of your saved replay or situation files (see 

the section Creating a Reusable Situation for more details). Flight School accesses the tutorials and is a 

great place to start if you’re new to flying or X-Plane. 

For now, we’re going to focus on setting up a New Flight to customize all its features. Click the button to 

be taken to the Flight Configuration screen. 

Note that if you return to the Main Menu (found under the File menu) after starting any flight, the name 

of some options will have changed slightly. You can Resume Current Flight or choose Flight 

Configuration to modify your current flight or create a new one. You will also have the option to Save 

Flight in addition to Load Saved Flight and access to Flight School. 

Picking and Customizing an Aircraft 

 

Figure 5.1: Setting up a new flight in the Flight Configuration screen 

Select an aircraft from the list on the left. You can narrow down your options by using the drop down 

menus at the top of the screen or the search bar. Click on the star in the corner of the aircraft box to 

mark it as a favorite, and quickly find it next time at the top of the list. 

By clicking on the Customize button, you can switch between starting your flight with engines running or 

cold & dark. You can change the aircraft’s livery (if available) by using the scroll wheel of the mouse or 

https://www.x-plane.com/manuals/desktop/index.html#creatingareusablesituation
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the drop down list in the top right corner. Click on Weight, Balance, & Fuel if you’d like to modify those 

values, or Failures to pick parts of the aircraft or world to break. 

Choosing an Airport or Location 
X-Plane’s aircraft can be relocated to virtually any airport on Earth. It can place your aircraft on a runway 

or apron, or it can start you in the air on a 3 or 10 nautical mile approach to a runway. 

Pick an airport to start at by searching by Name, ICAO/IATA/FAA code, or feature (such as “grass strip”) 

in the location box at the top right side of the screen. You can obtain the same results by searching for 

“KLAX,” “Los Angeles Intl,” or even just typing “Los Angeles” and scrolling through the results. The 

unfiltered list is the complete X-Plane airport database, which represents nearly every airport on the 

planet. 

Click on the Customize button to go to the Location screen if you’d like additional control over where 

your flight starts. This screen is divided into three parts. In the top left is a larger version of the airport 

selection on the previous screen. The bottom left portion toggles between ramp & runway starts. When 

the toggle button is set to “Runway” you can start on the ground at the runway end, or in the air 3 or 10 

nautical miles away from the runway. 

To the right of the list pane is an overhead view of the selected airport’s layout with your current 

starting point marked in blue. You can quickly see which end of the runway you’ll start on, or where the 

ramp start you’ve selected is located. You can zoom in and out by using your mouse scroll wheel and 

even click on the location you’d like to start at in the map instead of picking from the lists on the left. 

Note that if the aircraft is moved to an area that does not have any scenery installed, it will end up on a 

runway which is hovering above the ocean down below. This is referred to as “water world” and it is 

covered in detail in the appendix Water World, or “Help, there’s water everywhere!”. 

Other Ways to Choose a Location 

You do not have to choose a location for your flight using the list of world airports. You can have X-Plane 

choose a random location near you by clicking the Special Starts button at the bottom of the Location 

screen, then selecting “Get Me Lost” from the bottom of the list. You can also choose from a number of 

special starts in this screen, such as a carrier cat shot, oil rig approach, or the space shuttle landings. 

Changing the Environment 
The X-Plane environment consists of weather, time of day, and date, each of which can be modified at 

will. 

Setting the Weather 

X-Plane’s weather simulation is highly configurable and remarkably realistic. Weather in X-Plane can be 

set in three ways. The first, and easiest, way to set the weather is using the slider on the Flight 

Configuration screen. Eight options are available, with the cloud cover getting increasingly heavy as you 

drag the slider right. 

Click the Customize button for much finer control over the weather. It may be easiest to start with the 

closest type of weather you want with the slider, then go to the Weather Settings screen to tweak the 

individual settings. 

https://www.x-plane.com/manuals/desktop/index.html#waterworldor%22helpthere'swatereverywhere%22
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Advanced Weather Customization 

The Weather Settings screen allows you to specify the exact weather you want. The largest portion of 

the screen is for the weather map, which displays the clouds and wind layers in relation to each other. 

You can use the Preset Conditions drop down menu to set some preset weather conditions to start 

designing your custom weather from: 

CAVOK sets the weather to clear and visibility OK. Typically pilots refer to this as “CAVU”—Clear And 

Visibility Unlimited. This puts no wind or cloud layers in the weather map, and the visibility slider is set 

to 25 statute miles. 

VFR sets the weather to good visual flight rule conditions—clear, sunny skies with no wind and visibility 

at 7sm. 

Marginal VFR sets the weather marginal VFR flying conditions, with about five miles of visibility and a 

1,500 foot ceiling. 

Non-Precision Approach sets the weather for a non-precision approach, with a 3 mile visibility and a 400 

foot ceiling. 

IFR Cat I sets the weather up for a Category-I ILS approach, with poor ceiling and visibility. 

Cat II sets the weather up for a Category-II ILS approach, with terribly poor ceiling and visibility. 

Cat III sets the weather up for a Category-III ILS approach. These are extremely low instrument 

conditions, with basically zero ceiling and visibility. 

Stormy sets the weather to about IFR-I level ceiling and visibility conditions with heavy precipitation and 

storms, of course. 

Custom allows you to open a custom METAR.rwx file to create your own weather conditions in a text 

file. 

Or you can simply add up to six cloud and/or wind layers (3 each) by clicking on their respective buttons. 

Note that each layer you add will be placed above any existing layers of the same type, so it will be most 

efficient to design your weather from the bottom up. 

The weather map is very tactile–you can grab the icons and drag them up and down, and some cloud 

types allow you to adjust their edges to make them wider or narrower. Click on a layer to adjust 

additional settings in the Layer Properties column on the left side of the window. Press the Delete 

Layer button if you’d like to remove the wind or cloud layer. 
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Figure 5.2: Specifying the cloud and wind layers in Weather Settings 

Cloud layers can be set to cirrus, various amounts of cumulus, and stratus. You can adjust the heights of 

the clouds by using the sliders, or typing in the boxes for the most precision. These heights are 

measured in feet above mean sea level (MSL). 

The altitude, speed, turbulence, gust, and shear of wind layers can also be adjusted by dragging the 

sliders or specifying a number in the boxes. X-Plane will use the high, middle, and low altitude settings 

to interpolate between the layers. You can click and drag near the edge of the direction circle to make 

the wind come from that direction. 

In the right side of the Weather Settings window are the setting sliders for atmospheric conditions. Here 

you can also change the units of measure, such as switch the temperature from Fahrenheit to Celsius for 

example. 

The Set visibility drop down and slider adjusts what its name suggests, measured in statute miles for 

atmospheric visibility or feet for runway visual range. 

The precipitation slider sets the level of precipitation. Depending on the temperature around the 

airplane and in the clouds where it is formed, this will be in the form of rain, hail, or snow. 

The storminess slider adjusts the tendency for convective activity. The weather radar map in the lower-

right of the window shows where the cells are forming. Flying into these cells results in heavy 

precipitation and extreme turbulence. The turbulence is great enough that in reality, airplanes can fly 

into thunderstorms in one piece and come out in many smaller pieces. 

Taking helicopters into these icing and thunderstorm situations is interesting because their very high 

wing-loading on their rotor and the fact that the rotor is free teetering causes them to have a pretty 

smooth ride in turbulence. They are still not indestructible, though, and they are subject to icing on their 

blades just like an airplane. 

Next, the temperature at the nearest airport and the barometric pressure (air pressure) at sea level can 

be set. Keep in mind that the “standard atmosphere” is 59° F (15° C) and 29.92 inches mercury (1013 

millibars). 

Expand the “Thermals” section to enter the altitude, coverage, and climb rate. These controls are mainly 

used when flying gliders. In addition to thermals, X-Plane also runs air up and down the terrain as wind 

blows into mountains, simulating the effects that real glider pilots have to keep in mind and try to take 

advantage of. Try setting the wind at 30 knots or better at a right angle to a mountain range and running 

along the upwind side of the mountain range in a glider—you should be able to stay aloft on the 

climbing air if you stay pretty low. Drift to the downwind side of the mountain, though, and an 

unstoppable descent is assured! 

Expand “Bodies of Water” to set wave height and wave direction for bodies of water. Changing the wave 

height, in feet, will also modify the wave length and speed. 

Video 5.1: Weather Customization tutorial 
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Downloading Current Real-World Weather from the Internet 

Another method of setting the weather in X-Plane is to download the weather from the Internet. 

Downloading real weather will obtain weather and winds information for the entire world, contained in 

three files in the main folder: global_turbulence.grib, global_winds.grib, and METAR.rwx. 

To enable this, first open the Customize Weather screen from Flight Configuration. There, pick Match 

real world conditions from the “Weather mode” drop down menu at the bottom left of the window. 

X-Plane will automatically download the weather in your current location, and it will set a timer to re-

download weather in the increments you specify in the “Refresh rate” drop down. If you want to 

download weather at some other time, you can always come back to this window and press 

the Refresh button. 

Make Your Own Custom Weather Files 

You can make your own weather and wind files, allowing you to specify your own weather to X-Plane 

with unlimited resolution and location of weather definitions. This section will provide a basic 

explanation of how to set up your own custom weather text files, or see this article on the X-Plane 

Developer site for more information. 

For custom weather, create a custom text file that list the reporting station name as MDEG. Then add 

the longitude, latitude, and elevation. Next, enter the METAR report you want to apply at that location. 

For example, if we wanted to change the weather for the South Carolina area, we would specify the area 

in the METAR.rwx file as: “MDEG –81.235425 34.5647 80.0”. After that we’d enter: “24031KT 2SM CLR 

10/M10 A3011” for our weather. 

X-Plane has 16 weather envelopes spanning the area around the flying region. Each bucket is about 1.0 

degrees of longitude by 0.6 degrees of latitude, or about 35 miles or so. If you put an MDEG airport 

every degree of longitude and every half degree of latitude, you will be entering about the right number 

of MDEG airports to get all the detail you can out of the X-Plane weather engine. 

To use this custom METAR file in the simulator, go to the customize weather screen and pick From 

custom METAR (.rwx) file in the “Weather mode” drop down menu. X-Plane will create (or overwrite, as 

the case may be) a METAR.rwx file in the main directory with your custom information. 

For custom winds, create a text file named “Winds.rwx” and place it in the main directory. This file will 

load custom winds at 10,000 ft and 34,000 ft into X-Plane, so you have winds aloft for both light planes 

and airliners, with interpolation for turboprops that fly in between. 

Start the line with “DEG,” then enter the latitude and longitude for the location. Each of the numbers 

after the latitude represent the direction, speed and temperature. Add additional columns of wind 

information to correspond to specific altitudes: 3000, 6000, 9000, 12000, 18000, 24000, 30000, 34000, 

and 39,000 feet. Note that you may leave a lower altitude column blank if the location is already above 

that altitude, but you must enter a full winds-aloft report for all of the altitudes. X-Plane will only use 

the data at 12,000 and 34,000 ft (with interpolation between them) but you must enter a number (a 

dummy value like zero is fine) for all altitudes for the file to be scanned properly. 

Example: 

DEG –82.235 34.345 2910 3117+14 2925+08 2934+04 2924–07 2836–20 284436 284946 

http://developer.x-plane.com/?article=custom-wind-weather-in-x-plane-10
http://developer.x-plane.com/?article=custom-wind-weather-in-x-plane-10
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Let’s parse the first few items in our example above. Note that X-Plane uses longitude first, then 

latitude; thus the location is 82.235 degrees West, 34.345 degrees North. At 3000 feet, the wind 

direction is 290, with a speed of 10 knots. At 6000 feet, the wind direction is 310, speed 17 knots, and a 

temperature of +14 degrees Celsius. Continue on in this manner when you are adding custom winds or 

interpreting the report. 

Again, X-Plane has 16 weather envelopes spanning the area around the flying region, and each bucket is 

about 1.0 degrees of longitude by 0.6 degrees of latitude. So, if you put DEG wind-reporting station 

every degree of longitude and every half degree of latitude, you will be entering about the right number 

of wind-reporting station to get all the detail you can out of the X-Plane weather engine. 

If changes are made to the custom METAR.rwx or winds.rwx files, use the command “scan real weather 

files” to refresh your weather. 

Setting the Date and Time 

The simplest way of setting the time of day is by dragging the slider in the bottom right of the Flight 

Configuration screen. Time is given as both local and Zulu time (that is, Greenwich Mean Time or UTC). 

Click on the Customize button to change the date, time or GMT offset by using the drop down menus. 

Changing the date will accurately track changes in the length of days and nights within X-Plane. For 

instance, there are fewer daylight hours in December than in June in North America, as in the real world. 

Aditionally, you can check the always track real date and time box to keep X-Plane in sync with the date 

and time set in your operating system. 

 

Figure 5.3: The options available in the Customize window of Time of Day 

How to Fly 
When flying for the first time (both in X-Plane and the real world), it’s a good idea to use a relatively 

simple aircraft. The Cessna 172 is an excellent choice in this regard, a fact attested to by the millions of 

real-world pilots trained in this model. 

Before beginning, be sure you have configured your flight controls, if applicable, per the section 

“Configuring Flight Controls” of the chapter Configuring and Tuning Your X-Plane Installation. If you are 

not using flight controls, you will have to fly with the mouse. In this case, there will be a small white plus 

sign (+) in the center of the screen. If only this cross is visible, with no white box around it, X-Plane is 

https://www.x-plane.com/manuals/desktop/index.html#configuringflightcontrols
https://www.x-plane.com/manuals/desktop/index.html#configuringandtuningyourx-planeinstallation
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indicating that the pilot’s “hand” is not on the stick. This means that the mouse is free to move 

anywhere without impacting the flight controls. 

To grab the stick (and thus take control of the aircraft), click the left mouse button in the vicinity of the 

little white cross and a white box will appear around the cross. The mouse button should not be held 

down, only clicked once to turn the box on (i.e., to grab the stick) and again to turn the box off (to 

release the stick). When the box is visible, the pilot’s hand is on the stick and any movements of the 

mouse within the box will position the flight controls accordingly. Thus, moving the mouse directly 

below the cross will command some up elevator (causing the plane to climb) and will not impose any roll 

commands (which should keep the aircraft from changing its bank). Likewise, keeping the mouse lined 

up exactly with the cross but deflecting it to the right a bit will cause the plane to bank to the right 

without altering its pitch. 

Flight School 
If you are not familiar with flying an airplane or using X-Plane, check out Flight School for tutorials on 

many basic aviation concepts. Tutorials range from how to take off and land in the default Cessna 172 

SP, to how to use a VOR to navigate. To access Flight School, go to the main menu (found under the File 

menu) and click the button for Flight School. 

 

Figure 5.4: The General Aviation section of Flight School 

Take off 
To take off, the airplane must first be located at the end of a runway. By default X-Plane relocates the 

craft here, unless you have specifically picked a different location in the Customize Location screen. To 

take off in the Cessna 172, release the brakes (for instance, by using the ‘b’ key) when the throttle 

reaches its halfway point, then slowly advance the throttle (the F2 button when not using a joystick). 

Continue to advance the throttle and be ready to feed in some right yaw (using the right rudder or the 

twist on the joystick, if applicable) as the airplane accelerates. The tendency to turn to the left is normal 

in single engine aircraft due to the turn of the propeller. 

Don’t worry if it takes a few tries to learn how to keep the aircraft on the runway—a Cessna can take off 

in the grass just fine. If the airplane turns off the runway as it’s accelerating, just keep on going. 

Normally, the pilot will rotate (that is, apply some up elevator by pulling back on the yoke or stick) at 

about 60 knots in the Cessna 172. Once the aircraft leaves the ground, push the stick forward a bit to 
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momentarily level off and allow the airplane to build speed. Once the craft reaches 80 knots or so, pull 

back gently on the stick again and resume climbing. Building airspeed before climbing this way will help 

keep the plane from stalling. 

Note that if a crash occurs that damages the airplane too badly, X-Plane will automatically open a new 

airplane and place it at the end of the nearest runway (which may not be where you started). If the 

impact is only hard enough to damage the airplane without necessarily destroying it, the aircraft will just 

sit there and smoke. If this happens, you will need to open the Flight Configuration screen and start a 

new flight. If only it were so easy in the real world! 

Landing 
To land the plane you must first locate an airport and runway. This can be done during a flight by “dead 

reckoning” (that is, looking at your surroundings to find an airport nearby) or by opening Local Map 

(either by clicking on the icon in the menu, or using the ‘m’ key by default). The simplest option is to 

have X-Plane set you up on a final approach by opening the Flight Configuration screen, clicking on 

the Customize button in the location section, and selecting your desired airport and runway. Make sure 

the Starts button is toggled to Runway, then pick you desired distance from the drop down menu. 

To begin the descent in the Cessna 172, gradually lower the throttle to about 20% power and pitch the 

nose down between –3 and –5 degrees. Start to gradually lower the flaps (by using the ‘2’ key if no 

replacement button was configured) to further slow the aircraft. The goal is to be around stalling speed 

(about 50 knots in the Cessna) right at touchdown for the smoothest landing. As you near the runway, 

cut the throttle completely and pitch the nose up about 7 degrees to gently land the plane. Apply the 

brakes to come to a complete stop. 

Using the Instruments and Avionics 
When using the forward cockpit view, the mouse can be used to control the instruments in the panel, 

just as the pilot’s hand would be used to manipulate the instruments, switches, and other controls. 

To operate a button, just click it and release. To operate a switch, do the same to change its position. 

For example, to bring the landing gear down (on planes that are able to), click with the landing gear 

switch. Of course, this control will look different in different aircraft. Keep in mind that the g key could 

also be used or a joystick button could be assigned to toggle the gear. 

To turn knobs, move the mouse to the “plus” or “minus” side, whichever is necessary, and click to move 

the knob. Click repeatedly for greater movements. 

To easily see the controls within the cockpit that the mouse can operate, open the Settings and go to 

the General tab. Under the Flight Model section, check the box labeled Show clickable regions in the 

cockpit. This will draw green boxes around the areas of the instrument panel that can be manipulated 

with the mouse. 

If you have trouble interacting with (or even seeing) a control, you can switch to the 3-D cockpit mode 

by pressing Shift + 9, then move your view backward by pressing the comma key (‘,’). This will allow you 

to see the whole of the cockpit. You can also use the period key (‘.’) or mouse wheel to zoom in and get 

a closer look. Alternatively, you can use the up, down, left, and right arrow keys to move your view 

around in the 2-D panel view. 



Page | 52  
 

To get a quick description of the instruments in the panel, open the Settings and go to the General tab. 

Under the Flight Model section, check the box labeled Show instrument instructions in the cockpit. 

After closing the window, you’ll see a description of an instrument whenever you hold the mouse over 

it. 

A Note on Radio Tuning 
Avionics in most airplanes utilize twin concentric knobs that allow the pilot to tune the radio. For 

example, there will typically be a large knob on the surface of the radio, with a smaller knob sticking out 

from the large one. The large knob controls the integer (“counting number”) portion of the frequency 

and the smaller knob controls the decimal portion. 

For example, imagine that the COM1 radio (the communications radio number 1) needed to be tuned to 

128.00 MHz. In a real aircraft, the pilot would turn the big, lower knob until 128 was visible in the 

window, then turn the small, upper knob until 00 was visible. 

X-Plane is set up the same way. When hovering the mouse in the vicinity of one of the radio tuning 

knobs, two counter-clockwise arrows will appear on the left of the knob and two clockwise arrows on 

the right. The arrows closest to the knob are physically smaller than those on the outside-these adjust 

the decimal portion of the frequency. The outside arrows are larger and adjust the integer portion of the 

frequency. 

Using the Views 
You can change your view of the aircraft using the View menu, or by using the keyboard shortcuts listed 

on the right side of each option in the View menu. For example, to select the forward view, one would 

press the ‘w’ key, and to turn the view 45° left, one would press the ‘q’ key. 

Using the menus or the appropriate keyboard shortcuts, you can select a view or modify your current 

view. The controls for view selection affect the type of view that you are using. For instance, you may 

choose to be in the cockpit, looking forward at the instrument panel, or you may select an external view, 

perhaps where you look at your aircraft from the point of view of the nearest air traffic control tower. 

View selection controls are described in Table 5.2. 

After selecting some view, you can modify the view using translation (moving left, right, fore, or aft), 

rotation (spinning about your point of focus), or zoom (changing the angle of view). The default 

keyboard shortcuts for these effects are listed in Table 5.1. 

In the 3-D cockpit mode, if you want to move your view closer to the instrument panel, you would press 

the ‘.’’ (period) key, not the ‘=’’ key. To move your view farther from the instrument panel, you would 

press ‘,’ (comma), not the ‘-’ key. Furthermore, you cannot zoom out past your camera’s actual location; 

you have to translate backward (using the ‘,’ key) to move farther away. 

Many aircraft use 3-D cockpit mode by default, but you can also switch to it by opening the View menu, 

clicking Change (Internal), then clicking “3-D Cockpit Command Look,” or by pressing Shift + 9 on the 

keyboard. In this mode, you can move your view around the cockpit in one of a few ways: 

by clicking the right mouse button and and dragging your mouse around the screen, 

by using the keyboard shortcuts listed in Table 5.2, 

https://www.x-plane.com/manuals/desktop/index.html#viewselection
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by selecting different views from the View menu, or 

by pressing a button on your flight controls which you previously configured to modify the view. 

This mode leaves the mouse free to click on things in the cockpit without affecting where you are 

looking. 

In 3-D cockpit mode, you can use the keyboard shortcuts or the View menu itself to change where you 

are looking. These are described in Table 5.1. 

Movement Name Keyboard Shortcut Effect 

Translate left, right, up, 

and down 
Corresponding arrow key 

Shifts the view a bit in the direction you 

choose 

Translate fore and aft ‘,’ (aft) and ‘.’ (fore) 
Shifts the view toward the front and rear of 

the aircraft, respectively 

Rotate left, right, up, 

and down 

‘q’ (left), ‘e’ (right), ‘r’ (up), 

and ‘f’ (down) 
Spins the view in the corresponding direction 

Zoom in and out 
‘=’ (zoom in) and ‘-’ (zoom 

out) 
Simple zooming 

Table 5.1: General view modification commands 

Name of View 
Keyboard 

Shortcut 
Effect 

View Selection Controls for cockpit views 

Forward with panel ‘w’ 
Shows the instrument panel as though you were in the cockpit, 

facing forward 

Forward with HUD 
Shift+’w’ 

(i.e., ‘W’) 

Shows a front-facing view with no instrument panel, only a 

head-up display (HUD) 

Forward with nothing Ctrl+’w’ 
Shows a front-facing view unencumbered by an instrument 

panel or any other display 

3-D cockpit, using 

keyboard shortcuts to 

look around 

Shift+9 (i.e., 

‘(’) 

Displays the in-cockpit view of the 3-D instrument panel, 

where available. Uses translation and rotation commands 

(listed in Table 5.1) to move and look around. 

View Selection Controls for external views 

https://www.x-plane.com/manuals/desktop/index.html#viewmod
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Name of View 
Keyboard 

Shortcut 
Effect 

Linear spot 
Shift+1 (i.e., 

‘!’) 
Moves the camera with your craft’s initial velocity. 

Still spot 
Shift+2 (i.e., 

‘@’) 

Fixes the camera’s location some distance in front of your 

craft’s position. 

On the runway 
Shift+3 (i.e., 

“#”) 

Fixes the camera’s location on the ground at the nearest 

runway. 

Circling the aircraft 
Shift+4 (i.e., 

‘$’) 

Moves the camera with the aircraft, allowing you to use the 

rotation and translation keys (see Table 5.1) to circle the craft. 

Tower view 
Shift+5 (i.e., 

‘%’) 
Fixes the camera at the nearest tower. 

Ride-along 
Shift+6 (i.e., 

‘^’) 

“Mounts” a camera to the aircraft, which can then be moved 

using the rotation and translation keys (see Table 5.1). 

Track fired weapon 
Shift+7 (i.e., 

‘&’) 
Causes the camera to follow any fired weapon. 

Chase 
Shift+8 (i.e., 

‘*’) 
Sets the camera directly behind the aircraft. 

Table 5.2: Controls for selecting a view 

Using the Quick Look Feature 
Quick Look allows you to set up a view just the way you like it, and then save it as a hot key or 

command. Then, in the future, whenever you press that key on the keyboard (or button on your joystick, 

as the case may be), you can go right back to that view again. 

Note that the Quick Looks are aircraft-specific preferences. This means that your Quick Look views in the 

Cessna 172 do not interfere with your views in the King Air, and so on. 

For example, suppose you’re flying the default King Air and you find yourself frequently positioning your 

view in the cockpit by tilting down and zooming in on the throttle quadrant to see how you have the 

aircraft configured. This can take some time to set up and if you do it often, it can get tedious. 

The solution, then, is to set up a Quick Look. Set the view to however you like it, and assign it to Quick 

Look 1 by pressing Ctrl+Num Pad 1 (i.e., the control key, with the 1 key on the number pad). Note that 

the Num Lock must be on in order to do this.  Now, no matter how your view changes, when you press 

the shortcut for Quick Look 1 (by default, Num Pad 1), your head position, orientation and zoom goes 

right back to your memorized view of the throttle quadrant. 

https://www.x-plane.com/manuals/desktop/index.html#viewmod
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By default, the numbers 0 through 9 on your keyboard’s numeric keypad (a.k.a. the num pad or tenkey) 

are used to bring you back to Quick Looks 0 through 9. When pressing the Ctrl key along with any of 

those numbers, you will store your current view to be recalled later by that number key. Thus, to set a 

view for Quick Look 3, you would get the view to the way you like it, then press Ctrl + Num Pad 3, and to 

go back to that view, you would press Num Pad 3. However, like most keys in X-Plane, you can modify 

these settings if you like, and you can even assign an established Quick Look to your joystick as 

described in the section “Assigning Functions to Buttons”. 

Quick Looks are not just for 3-D cockpit mode, either. They work in all aircraft-relative views, such as 3-D 

Cockpit, Ridealong, Chase, Circle, and Forward with HUD. 

As of X-Plane 11.10, 10 additional quick looks have been added. Key assignments must be assigned to 

record & use quick looks 11–20. For example, you could go to the keyboard settings screen and assign a 

key to the command “memorize 3-D cockpit location #11” then return to the cockpit, set up the desired 

view, and press that key. Then return to keyboard settings and assign a key to “Go to save 3-D cockpit 

location #11.” Now when you return to the cockpit and use the new key assignment, your view will 

change to the memorized location. 

Letting X-Plane Fly Your Aircraft 
X-Plane has the capability to fly an aircraft using artificial intelligence (AI). The AI system can handle all 

aspects of flying your aircraft, including taxiing around the airport, take off and landing. 

To enable the AI’s control of the craft, move the mouse up to the top of the screen to bring down the 

menu bar. Click Aircraft, then select A.I. Flies Your Aircraft. 

With the AI controlling the airplane, you are free to experiment with the different views and also to 

practice raising and lowering the aircraft’s landing gear, flaps, and so on. Furthermore, this is an 

excellent way to practice tuning radios. 

In addition, you can have the AI control your view by opening the Aircraft menu and selecting A.I. 

Controls Your Views. 

Getting Quick Help 
If you need help with a certain aspect of the simulator, open the menu and check for a question mark 

icon in the right corner. Click on the icon to open a webpage with additional information and 

instructions about the screen you are currently viewing. 

You can also quickly access a list of essential commands and their associated keyboard shortcuts by 

going to the Flight menu and picking the “Show Key Shortcuts” option. 

To see what buttons, knobs or switches in the cockpit are interactive, turn on green boxes the green 

boxes of mouse click regions by going to View > Show Instrument Click Regions. In addition, toggling 

“Show Instrument Descriptions” will display the name of the instrument when you hover the mouse 

pointer over it. 

Saving and Sharing Your Flight 
X-Plane offers a number of ways to save and share a particular flight. These are: 

https://www.x-plane.com/manuals/desktop/index.html#assigningfunctionstobuttons
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Situations, which note the current location, environmental conditions, and properties of the aircraft in 

use. 

Replays, which store a “recording” of your entire flight since the last load. These are only replayable in 

X-Plane, but they have the advantage of being made up of X-Plane data points storing your aircraft’s 

location, so you can change your views during the replay. 

Screenshots, which store an image of a single moment in your flight and are viewable on any computer. 

In each case, you can save the flight and replay it yourself, or you can upload it to the Internet for others 

to see. 

 

Figure 5.5: Load a situation, replay, FDR or Xavion file from the Load Flight screen 

Video 5.2: Saving and Loading Flights tutorial 

Creating a Reusable Situation 

A “situation” in X-Plane is a file readable only by X-Plane. It is essentially a “snapshot” that makes a note 

of the aircraft you are using, its position in the air or on the ground, its payload, the amount of fuel in its 

tanks, and so on. It also includes information on the environmental conditions of the flight, including 

cloud conditions, temperature, and time of day. Furthermore, any other aircraft you have loaded will 

also be noted. 

To create a situation (a ‘.sit’ file), move the mouse to the top of the screen, click File, then click Save 

Flight. 

You may need to toggle the “Save As” file type to the correct file type, then enter a name in the File 

Name field and click the Save button. 
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By default, X-Plane saves your situation files to the following directory: ‘X-Plane/Output/situations/’, 

although you can pick a different save location with the Change Destination button. 

This is especially useful for quickly loading and practicing a specific type of approach, or for recreating a 

specific combat situation. The situations can even be sent to other X-Plane users; all they need is the 

‘.sit’ file that you created. 

To load a situation in order to fly it again, open the File menu and click Load Flight. You can narrow 

down the list of all the saved files by clicking on the Situations button. If you do not see your file in any 

of the lists, you can also click the Open Saved Flight Not Listed button to open a file browser window to 

navigate to the file, wherever you saved it. Click on the .sit file you want to load, then press the Load 

Flight button at the bottom of the screen. 

Creating a Replay 

A “replay” in X-Plane is essentially a “movie” of your flight which notes the aircraft’s location and 

attitude at each time step, beginning at the last time you loaded an aircraft or traveled to an airport and 

ending at the moment you click the “Save Replay” button. This file is only viewable in X-Plane, but 

because it is so complete, you can change your view as much as you like while replaying. This is in 

contrast to an AVI movie, which records only what you see while you’re recording. 

These files, like situations, can be shared with and replayed by any X-Plane user. 

To create a replay (a ‘.rep’ file), move your mouse to the top of the screen, click File, and click Save 

Flight. You may need to toggle the “Save As” file type to the correct file type, then enter a name in the 

File Name field and click the Save button. 

By default, X-Plane will store your replay in the following directory: ‘X-Plane 11/Output/replays/’, 

although you can pick a different save location with the Change Destination button. 

To load a replay, open the File menu as before, but select Load Flight. You can narrow down the list of all 

the saved files by clicking on the Replay button. If you do not see your file in any of the lists, you can 

also click the Open Saved Flight Not Listed button to open a file browser window to navigate to the file, 

wherever you saved it. Click on the .rep file you want to load, then press the Load Flight button at the 

bottom of the screen. 

Creating a Movie 

In addition to file types readable only by X-Plane, you can also create more universally readable movies. 

The downside to these movie files is that they record exactly what you see when you record them, and 

they do not record sound. You will toggle the recording on, fly around a bit, then toggle the recording 

off; the resulting ‘.avi’ file will contain what you saw on your screen while flying around. After recording 

the movie, you can edit it in a program like iMovie (installed on new Macs by default) or Windows Live 

Movie Maker. 

Before recording your movie, you will want to set up the movie’s specifications. Do so by moving the 

mouse to the top of the screen, clicking on the File menu, then clicking “Configure video recording.” In 

the dialog box that appears, you can set: 

the frame rate of the movie (measured in frames per second) 
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the resolution of the movie (width only; height will be calculated automatically from the width), and 

the time multiplier, indicating how many frames to skip when doing a time lapse video. 

In choosing a frame rate, know that videos produced at 15 frames per second will look jittery. Film and 

television use 24 and 30 frames per second, respectively. In choosing a resolution, keep in mind that an 

x-resolution of 720 pixels is 720p, and that increasing beyond the resolution you’re using on your screen 

will give no benefit. 

To begin recording a movie, either press Ctrl + Spacebar or open the File menu and click “Toggle video 

recording.” After flying whatever you intended to record, turn the recording off by either pressing Ctrl + 

Spacebar or clicking Toggle Movie from the File menu. A file called “X-Plane [aircraft 

name]_[number].mov” will appear in the Output folder of the X-Plane directory. 

Your movie file can be played back on virtually any computer. If the appropriate software is not installed 

on the computer you want to play the file on, you can get a free cross-platform multimedia player from 

the VideoLAN Organization. 

Capturing a Screenshot 

The final method of saving or sharing your flight is to take a simple screenshot. This can be done either 

by pressing Shift + Spacebar, or by moving your mouse to the top of the screen, clicking the File menu, 

and clicking “Take Screenshot.” The captured image (a ‘.png’ picture file) will appear in the Output folder 

of your X-Plane directory. 

These ‘.png’ screenshots can be opened and viewed on any modern computer, regardless of whether 

X-Plane is installed. 

Visualizing and Replaying Your Flight 
In addition to being able to save replays for later playback (as described in the section Saving and 

Sharing Your Flight above), you can visualize your flight up to your present location in a few different 

ways. You can view your flight path on X-Plane’s 2-dimensional maps, or you can toggle the 3-D flight 

path and view that path in the main simulator. If you want to replay your flight, beginning at the last 

time you loaded an aircraft or location, you can use X-Plane’s built-in replay function, which has shuttle 

controls to play, rewind, and fast forward, just like you would expect. Finally, if you want to visualize the 

path taken by a real-world aircraft, you can format its flight data recorder information in a way that 

X-Plane can interpret. X-Plane will treat the data in the FDR file just like a regular replay, so you can play, 

fast forward, and rewind as usual. 

http://www.videolan.org/
https://www.x-plane.com/manuals/desktop/index.html#savingandsharingyourflight
https://www.x-plane.com/manuals/desktop/index.html#savingandsharingyourflight
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Viewing the Path Taken by Your Aircraft 

 

Figure 5.6: Visualizing a 3-D path 

The path taken by an aircraft up to its current location can always be seen as a trail behind the aircraft 

when you toggle the 3-D flight path on. To do so, either press Ctrl + ‘p’ on the keyboard, or move the 

mouse to the top of the screen, click on the View menu, and click Cycle 3-D Flight Path. Doing so once 

will cause X-Plane to display a violet-striped line behind the aircraft. Cycling it again will give a semi-

transparent black bar extending from the flight path to the ground (seen in Figure 5.6). Cycling the path 

once more will turn off the flight path lines. 

To reset the 3-D flight path, either press Shift + ‘p’ on the keyboard, or open the Aircraft menu and 

click Reset 3-D Flight Path. The flight path will also be reset whenever you load an aircraft or a location. 

For more information on using the navigation maps here, see the section “Using X-Plane’s Navigation 

Maps” of the chapter Navigation, Autopilots, and Flying on Instruments. 

Using the Built-In Replay 
You can replay your flight, from the last time you loaded an aircraft or a location up to your current 

location, by toggling the replay mode on. This can be done either by pressing Alt (Option on a Mac) + ‘r’ 

or by opening the File menu and clicking Toggle Replay Mode. In the top of the window, you will see 

shuttle controls to (listed left to right): 

stop playback, 

play backward faster than real-time, 

play backward at real-time speed, 

play backward slower than real-time, 

pause playback, 

play forward slower than real-time, 

https://www.x-plane.com/manuals/desktop/index.html#threedpath
https://www.x-plane.com/manuals/desktop/index.html#usingx-planesnavigationmaps
https://www.x-plane.com/manuals/desktop/index.html#usingx-planesnavigationmaps
https://www.x-plane.com/manuals/desktop/index.html#navigationautopilotsandflyingoninstruments
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play forward at real-time speed, 

play forward faster than real-time, and 

stop playback. 

Additionally, you can click the shuttle slider and drag it to quickly jump around in the playback. 

To return to the flight, either press Alt (Option) + ‘r’ again, or open the menu and click Toggle Replay 

Mode once again. 

Replaying a Flight from a Flight Data Recorder (FDR) 
The final method of visualizing a flight is to load information from a flight data recorder (FDR). This is 

useful primarily in accident investigation and re-creation. In that case, you would need to take the data 

from the “black box” of the aircraft you’re interested in and put it in a format that X-Plane can read. 

That format is the Flight Data Recorder (or ‘.fdr’) format. 

You can load .fdr files, including an example file from the Instructions folder, by going to the File menu 

and clicking on “Load Flight.” Click the Flight Data Recorder button, select the desired file from the list, 

and click Load Flight. Then you will be greeted with the standard replay shuttle buttons with which you 

can replay the flight. 

Note that even if your custom instantaneous “snapshots” of the aircraft does not use a given parameter 

(such as the engine pressure ratio, perhaps), your data file must use a dummy value as a placeholder so 

that the columns of data are interpreted correctly. The FDR file specification and information on each 

field can be found in the X-Plane Knowledge Base. 

Viewing the Behind-the-Scenes Flight Model 
X-Plane models flight by breaking an aircraft down into a number of little pieces and finding the forces 

acting on each piece. By clicking the “Show Flight Model” option from the View menu (or by pressing 

Ctrl + ‘m’ on the keyboard) and moving to an outside view (e.g., by pressing Shift + 8 on the keyboard for 

the chase view), you can actually see all the forces calculated on each piece of the craft, as illustrated in 

Figure 5.7. With some wind and turbulence turned on in the Weather screen, you can even see the 

pseudo-random velocity vector flow field around the airplane. The velocity vectors seen are the actual 

vectors interacting with the aircraft, and the force vectors (the green lines coming off the plane) are the 

actual forces acting on the plane—nothing is just for show here. This is the actual work that X-Plane is 

doing. 

http://www.x-plane.com/?article=creating-fdr-files
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Figure 5.7: Illustrating the forces acting on a Baron 58 

The green bars extending from the control surfaces of the aircraft indicate how much lift each section of 

the surface is generating; longer bars represent greater force. The red bars, likewise, represent drag, 

and the yellow bars represent lift from vertical control surfaces. 

To see the flow field around the plane, press Ctrl + ‘m’ (or select Show Flight Model from the menu) 

again. Note that X-Plane is not a computational fluid dynamics application, but it makes a decent stab at 

seeing how the craft affects the flow field, and how that in turn affects other parts of the craft. 

 

Figure 5.8: The flow field around a Baron 58 

The vector popping out of each point around the airplane shows if the air is being pushed up, down, 

fore, or aft (or, for that matter, side to side by the rudder or vertical stabilizer) compared to the speed 

and direction of the center of gravity of the airplane. The color of the vectors represent airspeed, where 

yellow is the middle of the spectrum, and a 10% speed change takes us to red (10% lower) or green 

(10% higher) vector color. 



Page | 62  
 

Pressing Ctrl + ‘m’ (or selecting Show Flight Model from the menu) one more time will show the 

streamlines, and toggling the flight model a fourth time will turn it off completely. 

Additionally, these on-screen visual representations provide no numerical data. In order to obtain that 

information, press Shift + ‘m’ and the data will be output to the file “Cycle Dump.txt” in the main 

X-Plane directory. The text file will include angles of attack, forces, velocities and additional data for that 

instant of your flight. 

Advanced Simulation in X-Plane 
X-Plane is the most comprehensive and powerful flight simulator available. As such, there are a great 

number of features available that go beyond simply taking off, flying around, and landing. These include 

tools like the logbook and checklists, and features like equipment failures and damage modeling. 

Keeping a Logbook 
Each time an aircraft is flown in X-Plane, the program logs the flight time in a digital logbook. By default, 

X-Plane creates a text file called “X-Plane Pilot.txt” in the ‘X-Plane 11/Output/logbooks directory’. Inside 

this text file are the following details of previous flights: 

Dates of flights 

Tail numbers of aircraft 

Aircraft types 

Airports of departure and arrival 
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Number of landings 

Duration of flights 

Time spent flying cross-country, in IFR conditions, and at night 

Total time of all flights 

To see your logbook, open the File menu and click “Open Logbook.” You can load a logbook by clicking 

the Open Logbook button and navigating to your logbook, or you can create a new logbook using 

the New Logbook button. 

Working with the Air Traffic Control 
X-Plane’s air traffic control (ATC) system is powerful and realistic when you want to practice real-world 

protocols, but completely unobtrusive when you want to just fly. Although AI aircraft will always follow 

the guidance of the air traffic control, they will also work around your aircraft if you are not interacting 

with the ATC. 

Note: You will only be able to hear the air traffic control chatter if ATC audio output is enabled; to 

confirm this is the case, open the Settings screen, then click Sound. 

All interactions with the air traffic control occur via the on-screen ATC window. To access this feature, 

simply press Enter (Return) on the keyboard. You can also program a button on a joystick to access this 

screen or click the headset icon in the menu. 

In order to make a request or hear from the air traffic controllers, you must have your COM 1 radio 

tuned to the proper frequency for the request. Filing a flight plan is independent of any controller, so 

that option is always available. However, once the flight plan is filed, you must tune to the Clearance 

Delivery, Ground, or Tower frequencies (if available, in that order as in the real world) to get clearance 

for takeoff. 

After you get clearance, you tune to the Ground (if available) or Tower frequencies for your taxi 

clearance. When you get to a hold short line, ground control will hand you off to tower and then you’ll 

receive handoffs throughout the rest of your flight when necessary; keep tuning to the proper frequency 

to continue to receive air traffic control guidance. 

To see these frequencies, as well as other important airport information, click on the airport in the Map 

window, then on Details in the box that opens. 

You can always tune your radios by hand, but you can also auto-tune your COM1 radio by clicking on any 

line in the ATC list. In addition, if you’re ever en route and not sure which controller you should be 

talking to, X-Plane will do its best to suggest the right one—you’ll see a little asterisk (*) next to the 

recommended controller. X-Plane can automatically switch between the correct controllers for you if 

you check the “Auto-tune recommended frequencies” box. 
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Figure 6.1: The Air Traffic Control window at KSEA 

As in the real world, any ATC interaction begins with filing a flight plan. Thus, the first time you press 

Enter during a flight, the option to “File Flight Plan” will always be available. Click that button to open 

the Flight Plan window (shown in Figure 6.2). 

Your aircraft’s tail number will be filled in, but you may change this to a different callsign if you wish. 

Select a manufacturer and aircraft model from the drop down lists as these are required with the new 

ATC voice system in X-Plane 11.30. You may specify an airline and a flight number if desired. The starting 

airport will already be filled in, but you must enter your destination airport code, as well as your planned 

cruising (enroute) altitude. You may also specify your route using NDBs, VORs, Fixes and airways. 

Pressing the File Flight Plan button will register your flight plan with the X-Plane air traffic control. 

 

Figure 6.2: The Flight Plan window 

With your flight plan filed, you can bring up the ATC menu again by pressing Enter, then click “Request 

Clearance.” Check the “Use departure wizard box” if you’d like assistance with the ATC departure 

process. It will help you through each step in the proper order and give you hints if you get off track. 

Seattle ATC Walkthrough 
The following is a brief walkthrough on how to depart the KSEA area: 

Load a small aircraft, such as the Cessna 172, and position yourself at a gate at KSEA. 
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Tune your COM1 radio to 128.00, the clearance delivery frequency at KSEA. Remember you can do this 

by hand, by clicking on the line in the list of controllers, or, if auto-tune is enabled, it will happen 

automatically. 

Press Enter on the keyboard to bring up the ATC menu, then select “File Flight Plan.” 

Pick your aircraft’s manufacturer and model, set your destination to KBFI, and then set your altitude to 

3,000 feet. We’re going to leave the route blank because we want to go direct, but you could also enter 

any NDB/VOR/FIX/Airway to get real routings. When you’re done click File Flight Plan. 

You now have a flight plan in the system. If you wish to change your mind, you can return to the flight 

plan dialog in the same way and update it. (You may need to uncheck “Use departure wizard” if you no 

longer see the option to file a flight plan.) 

You need an IFR clearance before you can proceed, and in the ATC window and you’ll see an option for 

“Request Clearance.” Click that and you’ll receive your clearance. 

Read back your clearance by clicking the option “Read back transmission.” Note that if you hear a beep 

when you click on any ATC menu items, that means that another aircraft or controller is busy talking on 

the radio. As in the real world, you must wait for them to finish talking before you can talk. You must 

also respond within a reasonable amount of time or they will repeat their instructions. 

Once you’ve received and read back your clearance, tune the COM1 radio to 121.70, the frequency for 

the ground controller at KSEA. Click Request Taxi to call ground to receive a taxi clearance. Acknowledge 

the clearance as described above and then look around you. You’ll see yellow arrows painted on the 

ground directing you to where you should go. Where the arrows stop, you must also stop and wait for 

further instructions. 

Taxi to where the arrows are taking you. When you reach the side of the runway, ground will instruct 

you to contact the tower. Read back the command and then tune to the tower frequency of 119.90. 

Check in with this new controller. This is how you tell the controller you’re now on their frequency 

waiting for their command. If there are aircraft using the runway, you will have to wait until they are 

done. This may take some time! At that time, 

Tower will call you and give you your takeoff clearance. Respond and then depart. Unless otherwise 

instructed, fly the runway heading up to your cleared altitude of 3,000 feet. 

At some point, you will be handed off to the center controller on 124.20. Check in as you did before. 

Continue on your heading and altitude and eventually Center will begin vectoring you to an approach at 

your destination of KBFI. 

Once the approach is set up, you will be handed off to KBFI’s tower for landing and the process 

continues until you’ve arrived back at the gate. 

Using a Checklist 
X-Plane has the ability to display a simple checklist in the simulator. This checklist must be stored 

somewhere in the X-Plane directory as a plain text (‘.txt’) file. 
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To load a check list, open the File menu and click Open Checklist. Click on Load New Checklist and 

navigate to your ‘.txt’ file. Open it and you will see the checklist displayed line-by-line in the checklist 

window. You can use the forward and back buttons to go to the next and previous lines, respectively. 

If you prefer to see the text file all at once (rather than line-by-line as in the checklist view), you can 

select Open Text File from the File menu and then load a file in the manner discussed above. 

Changing How Damage Affects the Aircraft 
By default, X-Plane does not remove parts of the aircraft when the craft’s limits are exceeded. However, 

by opening the Settings screen and clicking on General, you can enable the option to Remove flying 

surfaces when over speed or over G limits 

Additionally, with the reset to the nearest airport when you wreck box checked, X-Plane will 

automatically reload your aircraft at the nearest airport in the event of a fatal crash. 

By making these damage modeling features optional, X-Plane allows both easy, possibly unrealistic 

flights, as well as much more accurate, more challenging simulations. 

Setting the Weight, Balance, and Fuel 
To modify an aircraft’s weight, balance, and fuel, go to the Flight menu and pick “Edit Weight & 

Balance.” You can also access this screen during Flight Configuration. Click on the icon for the aircraft 

you’d like to modify, click the Customize button, then the Weight, Balance, & Fuel button. Either way 

will open a window where you can use the sliders to set the aircraft’s center of gravity, the weight of its 

payload, and the amount of fuel in its tanks. 

 

Figure 6.3: Weight, Balance, & Fuel screen for the default Cessna 172 

An airplane can typically stay in the air at very high weights, but it will have a hard time getting off the 

ground initially. Additionally, moving the center of gravity forward (left on the slider) makes the plane 

behave more like a dart, and moving the center of gravity aft (right on the slider) makes the plane more 

unstable, and potentially unflyable. Flying a plane with the center of gravity far aft is like shooting an 

arrow backwards—it wants to flip around with the heavy end in the front and the fins in the back. 
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Since X-Plane calculates in real time how the plane is burning fuel, and the engines need fuel to run, and 

the weight distribution of the fuel is considered in the simulation, the fuel put on board does indeed 

matter. 

Video 6.1: The weight, balance and fuel tutorial video 

Simulating Equipment Failures 
X-Plane can simulate countless aircraft systems failures. Using this feature lets you experience what 

happens when important pieces of equipment don’t do what they’re supposed to in flight. 

You can access this feature while in the Flight Configuration screen by clicking on an aircraft icon, then 

the Customize button, then the Failures button. Or, access it during flight by going to the Flight menu 

and picking “Edit Failures.” 

If the Set global mean time between failures box is checked, the simulator will use the value to the right 

to determine how often, on average, each piece of equipment will fail. For instance, if the mean time 

between failure is set to 1000 hours, X-Plane will decide that each piece of hardware in the plane has 

about a one in a thousand chance of breaking each hour. Since the airplane has a few hundred pieces of 

hardware, that means a failure might occur every 5 to 20 hours or so. Checking this box essentially 

allows the possibility of random and unexpected failures. 

The World section of the Failures window controls things outside of the airplane, such as bird strikes and 

airport equipment failures. The other categories and subcategories in this window let the user set the 

frequency of specific failures for hundreds of different aircraft systems. Many of the options allow you 

to specify a time, speed, or other condition at which they will fail. 

Video 6.2: Setting failures tutorial 

Enabling a Smoke Trail 
A smoke trail, as might be used by an aerobatic airplane in an airshow, can be enabled behind your 

aircraft. This control is assigned to the ‘x’ key by default. You can assign a different key by following the 

instructions in Configuring Keyboard Shortcuts. 

Speeding Up the Simulation 
By pressing Alt+’t’ on the keyboard, you can increase the simulation speed to 2× the standard speed. 

Pressing Alt+’t’ repeatedly will increase the speed to 4×, then 6×, and then it will finally return the 

simulator back to standard speed. 

Note that if your computer cannot run the simulation at the required frame rate, X-Plane will slow its 

measurement of time to compensate. This is seen most often for users running at standard speed, but 

failing to maintain 20 frames per second. When X-Plane runs slower than 20 fps, it slows down its 

simulation of real-time so that the simulator is “effectively” running at 20 fps. For instance, if the 

simulator is running at 10 fps due to extreme rendering settings, X-Plane will run the flight model at half 

speed. The result is that the physics are integrating in slow-motion in order to avoid destabilizing from 

the low framerate. Thus, if you need real-time simulation, you must run the simulator at 20 fps or faster. 

https://www.x-plane.com/manuals/desktop/index.html#configuringkeyboardshortcuts
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Taxiing More Accurately 
In commercial aircraft, a nosewheel tiller is used to more accurately align the nosewheel to the taxi 

lines, and to get the aircraft safely docked at jetways. You can assign an axis on your joystick to control 

this tiller by opening the Settings screen, going to Joystick and, in one of the drop-down menus in the 

Axis tab, selecting nosewheel tiller. Note that this is the same procedure used in setting up the joystick 

axes normally, as described in the section “Configuring Flight Controls” of the chapter Configuring and 

Tuning Your X-Plane Installation. 

Virtual Reality 
X-Plane 11.20 and newer supports native virtual reality, or VR. The additional system requirements for 

VR are: 

Windows 7 64 bits or newer operating system 

HTC Vive, Oculus Rift, or Windows Mixed Reality (WMR) 

Steam VR installed for Vive/WMR 

“Windows Mixed Reality for SteamVR” for WMR 

Your CPU & GPU will need to meet all additional requirements as specified by your headset 

manufacturer. X-Plane supports the HTC Vive, Oculus Rift, and Windows Mixed Reality (WMR). 

Note: Steam VR is a free download that enables X-Plane 11 to use VR. Steam VR is compatible with the 

X-Plane 11 DVD set, digital download edition, and X-Plane on Steam. 

Note that no Intel GPUs are supported. Room-sized VR is supported, as well as using joysticks and other 

USB devices. 

This video shows how to get started and some of the tricks you can use with X-Plane VR. 

Video 6.3: X-Plane VR instructions and tips 

To get started using VR, first set up your device according to manufacturer’s instructions. In addition, 

you may need to enable foreign apps in the VR system settings. For example, with the Oculus Rift, you 

would go to Settings > General and toggle the button to the right to enable apps from Unknown 

Sources, such as X-Plane. 

Next, if you don’t already have it, Vive & WMR users will need to download the Steam software and 

create a free account in order to install Steam VR. Once the Steam client is installed and you have signed 

in, go to Library > VR. Click on SteamVR under the Tools section in the left sidebar, then the install 

button. 

If you’re using a Windows Mixed Reality (WMR) device, in addition to SteamVR you’ll also need to install 

“Windows Mixed Reality for SteamVR,” which is available from the Steam Library as well. 

Finally, launch X-Plane and go to Settings > VR Hardware. As long as your headset is attached (and your 

GPU meets minimum requirements), there will be a checkbox to enable VR hardware. 

https://www.x-plane.com/manuals/desktop/index.html#configuringflightcontrols
https://www.x-plane.com/manuals/desktop/index.html#configuringandtuningyourx-planeinstallation
https://www.x-plane.com/manuals/desktop/index.html#configuringandtuningyourx-planeinstallation
https://www.vive.com/us/ready/
https://support.oculus.com/170128916778795/
https://support.microsoft.com/en-us/help/4039260/windows-10-mixed-reality-pc-hardware-guidelines
http://store.steampowered.com/about/
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Figure 6.4: The VR Hardware Settings tab 

You can turn VR off by unchecking the box in Settings, or by using the large blue Disable VR 

Headset button in the X-Plane window on the computer. Note that if you have the VR Mouse cursor 

enabled, you may need to completely remove the headset to restore use of the 2d mouse cursor on 

your computer monitor. 

Once VR is up and running on all devices, you should find yourself in a virtual hangar in X-Plane. From 

here you can access the main menu, all settings, and any pop up warning screens. 

Controls & Manipulators 
The default fleet (minus the R–71) is VR-ready but 3rd party aircraft may be less usable in VR unless you 

use the 3D mouse to interact with the cockpit. Feel free to try other aircraft but be aware they will have 

limited functionality & use until updated for VR by their developers. 

In general, the manipulators in and around the aircraft function the way they would it real life. Grab the 

throttle of the Cessna 172 by pressing and holding the trigger near it. It will light up green, then push or 

pull the knob to adjust the setting. Alternatively, you can use “laser manipulation” to interact with 

objects. Lightly and partially squeeze the VR controller trigger to see a green laser appear. Aim that laser 

at the thing you want to interact with and ‘grab it’ by squeezing the trigger the rest of the way in. This 

feature essentially takes traditional manipulation and lets you perform the motion at any distance or 

angle that is convenient for you. 

By default, the pilot yoke behaves in a realistic manner–tilt your wrist left or right for roll, and push in or 

pull out to control pitch. This behavior can be tiring if you fly for long hours at a time, so you can switch 

to “ergonomic” mode by using the checkboxes in Settings > VR Hardware. Ergonomic mode behaves 

slightly differently than real life–it works by tilting your wrist up or down to control pitch, and rolling 

your wrist left right for roll. (Moving forward and back does nothing.) This allows you to keep your hand 
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in a relaxed and comfortable position while you fly and also allows you to be more precise with the 

controls. 

In addition, the yoke is a “latching” manipulator by default: if you click it once, your controller will stay 

attached to it. You must press the trigger a second time to release it. You may also change this behavior 

by unchecking the “Latch to yoke manipulators” checkbox in VR Hardware settings. 

Some rudder input will be added automatically as roll is controlled in order to allow you to taxi on the 

ground if you don’t have rudder pedals attached. If you do have hardware rudder pedals, it is up to you 

to control them. 

Move around the aircraft or the world by using teleport: push down on the thumb stick (Oculus) or 

touchpad (Vive) to see a blue arc with a circle at the end, which is your landing spot. As you rotate the 

thumb stick you’ll move the red line on the circle, which indicates your view direction when the teleport 

is executed. Some parts of the aircraft, such as seats, have a hotspot which will light up and snap you to 

that location. 

“VR Quick-Zoom” is a command that you can bind to your controller or a key. When you press the 

button, it zooms your view in so you can see distant things a bit clearer. When you release the button, 

your view resets. 

Press the three line button (the menu button) of the virtual controller to access the menu options. Note 

that the “Get in Pilot’s Seat” controller menu option (the top most icon) is both a shortcut into the 

cockpit if you’ve moved to a different view, and a way to recenter yourself in the pilot seat. This option 

is the only supported way to recenter your view inside the cockpit. 
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Figure 6.5: The quick menu options accessible by pressing the controller’s menu button 

Within the quick menu is a three-line menu option that opens the main menu so you can access the 

usual options: load or save a flight, change your view, modify the flight, and so on. Use the thumb stick 

(Oculus) or touchpad (Vive) to move around menus and submenus, then use the trigger on the 

controller to select an option. 

 

Figure 6.6: The menu option provides access to many of the options from the traditional menu bar 

Pop out windows such as ground services, ATC, the map, and more are available from the controller 

menu by selecting the icon that looks like two window boxes on the left side. 

Using the Mouse in VR 
You can turn on a 3D mouse cursor while using VR by checking the “Enable 3D Mouse Cursor” box in 

Settings > VR Hardware. You can also bind a joystick button or key to this option. This cursor will 

function basically the same as a non-VR mouse. Clicking the right mouse button will open up the VR 

menu, which is the equivalent to the traditional horizontal menu bar in non-VR X-Plane flights. 

Troubleshooting 
VR is more demanding on your computer than simply using the desktop simulator. If you are not 

consistently running at least 45 fps in the base desktop sim, you will need to turn rendering settings 

down. Review the section “Setting the Rendering Options for Best Performance” if you need to adjust 

your settings for VR. 

If you encounter errors when trying to start X-Plane or enable VR, try quitting and restarting both Steam 

VR and X-Plane. If that does not help, a full restart of the computer often seems to fix many problems 

with launching VR. There are many layers with a multitude of processes and subprocesses involved in 

running X-Plane VR, and many times it is faster to reboot the machine than try to isolate which one is 

causing the problem. 

Currently the thumbsticks on the WMR controllers do not have a useful In-press/Click. That click is being 

stolen by SteamVR for internal functions. Clicking the thumbstick is currently causing the controllers to 

become unresponsive to X-Plane until the Mixed Reality Portal, SteamVR and X-Plane are restarted. This 

is a design decision by SteamVR, so it’s best to just use the X/Y axis of the thumbsticks and not the click 

function. 

https://www.x-plane.com/manuals/desktop/index.html#settingtherenderingoptionsforbestperformance
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Navigation, Autopilots, and Flying on Instruments 
People often call customer support asking about some of the more advanced things that pilots do in the 

real world—how to navigate, use an autopilot, or fly on instruments. This chapter will cover these areas 

in a fair amount of detail, but we recommend that, if you are really serious about mastering these facets 

of aviation, you head down to a local general aviation airport and hire a CFI (Certified Flight Instructor) 

for an hour or two. If you have a laptop, by all means bring it along and have the instructor detail these 

things in practice. There is much more to review here than this manual could ever cover, so a quick 

search for information on the Internet will also be of assistance. 

Navigating 
Navigating over the Earth’s surface is as easy as knowing where your aircraft is and how to get to where 

you want to go, although this isn’t quite as straightforward as it sounds. Imagine that you’re flying IMC 

(Instrument Meteorological Conditions—that is, in the clouds). You have no reference to the ground and 

are flying over St. Louis in the middle of an overcast layer. As you might guess, this looks pretty much 

identical to the view you would have flying over Moscow on instruments. The only way to know that 

you’re over St. Louis and not over Moscow is to be able to navigate. Navigation is the art of being able to 

tell where your aircraft is and how to make it go where you’d like. 

Using X-Plane’s Navigation Maps 
X-Plane’s navigation maps come in a few different varieties, each of which is useful for a different 

situation. These navigation maps are opened by hitting the ‘m’ key or clicking the map marker icon in 

the menu. You can pick from three different modes: VFR Sectional, IFR Low Enroute, and IFR High 

Enroute. 

 

Figure 7.1: The map window in IFR low enroute mode, with the KSEA airport inspector window open 



Page | 73  
 

The VFR Sectional map is designed for use under visual flight rules. The IFR Low Enroute map is used as a 

low altitude Instrument Flight Rules navigation chart by piston (propeller) aircraft pilots. The IFR High 

Enroute map is essentially the same as the IFR Low Enroute view, but it displays the medium and high 

level airways instead of low level ones. It only shows the information of interest to pilots flying above 

18,000 feet and making use of vector airways that are much longer, based on larger VORs with longer 

ranges. 

The maps provide a lot of information on the area where your aircraft is located, including topography 

and selectable NAVAIDs. Each map is made up of ticked, thin black lines that make “boxes” officially 

named “Quadrangles.” Each box is 1/4 of a degree of latitude and longitude. The thick blue and gray 

lines running across the maps are airways, which are basically like highways in the sky. These vector 

airways are given names (for example, V503) and are used by air traffic controls to assign clearances. 

The triangles along them are “fixes.” 

Small airports are indicated by notched circles, while larger airports with are shown as full runway 

layouts. Airports shown in blue on the VFR sectional map have control towers in the real world. Note 

that a discussion of the navigational aids (NAVAIDs) of these maps (the ILS, VOR, and NDB beacons) can 

be found below, in the section “Modern Means of Navigation.” 

To move your view around a map, you can click the map and drag. You can also zoom in and out by 

using your mouse scroll wheel. Additionally, you can use the viewing control buttons located in the top 

left corner of the map window to alter your view. Use the plus or minus icons to zoom in or out 

respectively. 

Tap the target icon to center the view on the aircraft. This will also lock the map view onto the aircraft 

so that as you fly, the map will scroll underneath it and the aircraft will stay in the center. Drag 

anywhere on the map to break the lock. Tap the arrow icon to change whether the top of the map is 

North or the aircraft’s heading. In this second case, if the plane is flying south, the top of the map will be 

south. If the plane banks to the east, the map will automatically rotate and east will now be on top. 

Click on anything in the map to get more information on it. For example, if you click on your aircraft, the 

Inspector box will pop up with its name, heading, altitude, speed, and climb angle, most of which you 

can also edit from within the window. Clicking on an airport will allow you to pick a new runway or final 

approach, or view details such as weather conditions and communications frequencies. Click on a 

NAVAID such as a VOR to tune radios with a click of a button. 

In the right side of the map window you can change what is displayed on the map. In the “Layers” 

section you can use the drop down menus to show wind or clouds and precipitation in real time on the 

map. You can check the boxes to toggle the flight path, a compass rose around your aircraft, or to 

disable downwind ILS beacons. 

Finally, toggling the “Glideslope” slider will display a vertical profile of the flight at the bottom of the 

map screen. You can change what approach is displayed there by using the “Approach” drop down 

menu. 

Modern Means of Navigation 
“Modern” navigation (after the 1930s) was based on ground-based transmitters. You’ll need a good set 

of charts if you’d like to actually fly in X-Plane using any of these methods, but the software does contain 

https://www.x-plane.com/manuals/desktop/index.html#modernmeansofnavigation
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a full set of (mostly) current charts as well. Remember you can open the map by pressing ‘m’ or from the 

menu icon. 

NDB Navigation 

Non-directional beacons were invented in the late 1940s and consisted of a ground-based transmitter 

that broadcast a homing signal. A receiver in the aircraft could be tuned to one of about 300 discrete 

frequencies in order to tune to a particular transmitter. With that done, an instrument in the panel, 

called the NDB (or, interchangeably, the ADF, or Automatic Direction Finder), would point to the station. 

Although nearly abandoned in the United States, NDBs are still used in many countries around the 

world. It is for this reason that they are modeled in X-Plane. 

An ADF is located in the instrument panel for the Cessna 172 that comes with X-Plane. It is located 

above the mixture knob and trim wheel, below the dual VOR CDIs, and is pictured in Figure 7.2 below. 

 

Figure 7.2: The ADF in the Cessna 172 

VOR Navigation 

Very High Frequency Omni-Range navigation (or VOR) was introduced in the mid–1950s and 

represented a large improvement in navigation accuracy. Instead of an NDB that a pilot could home in 

on, the VOR sends a series of 360 discrete little carrier tones on a main frequency. Each of these carriers 

is oriented along a different radial from the station, one of 360 just like a compass rose. You can imagine 

it like the wheel of a bike: the VOR transmitter is the hub of the wheel with 360 spokes representing 

each radial. Thus, when you are flying along and tune in the main VOR frequency, you then fine tune 

your navigation display to tell you which of the 360 radials you are flying and also whether the 

transmitter station is in front of or behind you. Impressive! 

This finally gave pilots a means of telling exactly where they were in relation to a fixed spot on earth, 

and this system “automatically” adjusted for any winds aloft as the system would quickly display any 

error in track that the plane was making. This error could only be due to two factors—either the pilot 

was not flying along the radial or the wind blew the airplane slightly off of course. 

VORs are modeled in X-Plane. Clicking on one in the map will display it’s information and allow you to 

tune your Navigational radios with a click of a button. 

A specific type of VOR, a VOR-DME, combines the lateral guidance (that is, guidance left and right) of a 

VOR with the distance guidance of a DME (distance measuring equipment). Another type of VOR 

beacon, a VORTAC, is also found throughout the X-Plane maps. This is a transmitter that combines both 

VOR and TACAN features. TACAN (or tactical air navigation) provides special information to military 

pilots similar to a civilian VOR. However, for our purposes, this is functionally identical to a VOR-DME. 
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Figure 7.3: A close-up of a VORTAC near KSEA as displayed on the VFR sectional map 

To learn about the basics of using a VOR to navigate, check out the “VOR Navigation” tutorial in the 

Navigation tab of Flight School, or follow the instructions below. 

To use a VOR, first look on your map to find a VOR station that is close to the location of the aircraft. 

Click on the map icon to open a window that will allow you to tune the frequency into your NAV 1 radio 

automatically. The little red ‘nav1’ or ‘nav2’ flags on your CDI (Course Deviation Indicator) should 

disappear. Make sure the GPS is set to VLOC, if applicable. (Keep in mind that you can also tune the 

navigation radio built into the GPS, but you may have to hit the flip-flop switch to bring the frequency 

you just tuned into the active window on top.) 

A CDI or OBI is the other key instrument to VOR navigation. X-Plane’s Cessna 172 is equipped with two 

CDIs, but we are only concerned with the top one. The vertical line in the center is the reference 

indicator, and moves to the left and right to indicate where the aircraft is in relation to a chosen radial. 

Select a radial by turning the OBS knob which rotates the compass rose around the instrument; the 

chosen radial is indicated above the top yellow arrow. There are also arrows above and below the white 

horizontal glide slope indicator (which does not move during VOR navigation) showing whether the 

aircraft is headed “TO” or “FROM” the station center, respectively. 
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Figure 7.4: A CDI in the Cessna 172SP 

Now you can determine where you are in relation to the VOR by finding what radial you are on, or you 

can enter a radial you want to be on in order to plot your desired course. Keep in mind that all radials 

are measured as the heading when moving away from a VOR beacon. 

Determining what radial you are on is simple. Turn the OBS knob on the CDI until the vertical white 

indicator is perfectly centered in the little white circle in the middle of the instrument, and the “FROM” 

flag is displayed. The number above the yellow arrow at the top of the CDI is your current radial 

position. 

To intercept a different radial, look at your map again to determine where you are in relation to the 

station. If you are inbound to the station, pick the reciprocal on the opposite side of the station from 

your aircraft. If you are outbound, use the radial your aircraft is currently on. Turn the OBS dial again to 

enter the desired radial at the top of the circle. Most likely the vertical line will be off to one side or the 

other. This indicates how far you are from your desired radial. 

To the left and right of the center target (the little white circle) the instrument displays five dots or short 

lines on each side. Each of these dots indicates that you are two degrees off of course. Thus, a full scale 

left deflection of the vertical reference indicates that the aircraft is 10 degrees right of the desired 

radial. Just remember that as long as you are flying towards the VOR, the line on the CDI indicates the 

location of the desired course. If the reference line is on your left that means that your target radial is on 

your left, and you should turn that direction. (Of course, if the station is behind you while displaying the 

“TO” arrow, then the instrument is reverse sensing. That means that a left deflection indicates that the 

plane is to the left of your desired radial-the aircraft’s movement in relation to the vertical reference 

indicator is displayed in reverse.) 

Your aim is to get the vertical line in the center and to stay there, indicating you are flying the desired 

radial. As you get closer to the VOR station, the indicator’s movement will become more sensitive to 

even slight changes of the aircraft’s course. Flying over the station will cause the vertical line to swing to 

one side, and eventually the instrument will change from displaying the “TO” arrow to the “FROM” 

arrow. 
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With only one VOR you really don’t know where you are along a given radial, only that you are in front 

of or behind a station and what radial you’re on. You have no way of telling if you are 15 miles from the 

station or 45 miles away. The solution is to use two VOR radios so that you can plot your location from 

two different VORs. If you can determine that you’re on the 67th radial from the OJC VOR and on the 

117th radial from the MKC VOR then you can pinpoint your location on a sectional chart. Don’t forget 

that you’ll have to work fast as your position will be continually changing. 

ILS Navigation 

An ILS (or instrument landing system) differs from a VOR in that it provides both lateral guidance (left 

and right, as given by a VOR) and vertical guidance (up and down). An ILS is therefore made up 

of twotransmitters, a localizer and a glide slope—one for each component of the navigation. Both these 

components of the ILS are tuned together; tuning an ILS is just like tuning in to a VOR. 

A localizer (LOC) transmitter provides lateral guidance to the centerline of a runway. It works by sending 

out two signals on the same channel, one of which modulates at 90 Hz and the other of which 

modulates at 150 Hz. One of these signals is sent out slightly to the left of the runway, while the other 

sent out slightly to the right of it. If an aircraft is picking up more of the tone modulated at 150 Hz, it is 

off to the left. If it is picking up more of the tone modulated at 90 Hz, it is off to the right. The course 

deviation indicator (or CDI) in the instrument panel then indicates this so that the pilot can correct it. 

When both tones are being received in equal amounts, the craft is lined up with the physical centerline 

of the runway. These LOC transmitters do not necessarily have to be paired with a glide slope (but doing 

so makes them an ILS). 

The glide slope beacon functions similarly to the localizer, sending out two tones that have the same 

frequency, but different modulations. The difference is that the glide slope tells the plane that it is either 

too high or too low for its distance from the runway. The pilot uses this information to push the craft’s 

nose up or down as needed. The ILS will allow a pilot to fly on instruments only to a point that is a half 

mile from the end of the runway at 200 feet (depending on the category of the ILS) above the ground. If 

the runway cannot be clearly seen at that point the pilot is prevented from executing a normal landing. 

If this happens, the pilot in real life is required to fly a “missed approach” and climb back to altitude in 

order to try again or go somewhere else. 

For detailed instructions on how to fly an ILS approach, see the tutorial “Flying an ILS Approach” in the 

Navigation section of Flight School. 

GPS Navigation 

The Global Positioning System was first created for the US military and introduced to the public in the 

early 1990s. This system consists of a series of satellites orbiting the Earth which continuously send out 

signals telling their orbital location and the time the signal was sent. A GPS receiver can tune in to the 

signals they send out and note the time it took for the signal to travel from the satellite to the receiver 

for several different satellites at once. Since the speed at which the signals travel is known, it is a simple 

matter of arithmetic to determine how far from each satellite the receiver is. Triangulation (or, rather, 

quadrangulation) is than used to determine exactly where the receiver is with respect to the surface of 

the Earth. In an aircraft, this information is compared with the onboard database to determine how far 

it is to the next airport, navigational aid (NAVAID), waypoint, or whatever. The concept is simple, but the 

math is not. GPS systems have turned the world of aviation on its head, allowing everyday pilots to 

navigate around with levels of accuracy that were unimaginable 20 years ago. 
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There are several types of GPS radios available, and about 11 of these have been modeled in X-Plane. 

While the intricate workings of the various GPS radios are complex, the basic principals are pretty 

consistent. If you want to navigate from one location to another just launch X-Plane, open the aircraft of 

your choice, then press the Direct To key on the GPS radio (sometimes shown as a capital D with an 

arrow going through it) and enter the airport ID you’d like to navigate to. On the Garmin 430, entry is 

performed using the control knob on the bottom right of the unit. Use the outer knob to select which 

character of the identifier to modify, the use the inner knob to scroll through the characters (see the 

section “A Note on Radio Tuning” of the chapter Flight in X-Plane for more information on using the 

knobs). 

The databases in these radios are not limited simply to the identifiers of the airports you may wish to fly 

to. You can enter the IDs for any VOR or NDB station you’d like, or the name of any waypoint or fix you’d 

like to go to. 

Flying on Instruments 
To begin a discussion on instrument flight, we must first discuss why it is so difficult. It isn’t that the 

principles behind flying on instruments are so difficult or that interpreting what the instruments are 

telling you is that difficult. Rather, the difficulty lies in believing what the instruments are saying. Your 

body has developed a system of balance and equilibrium that has evolved in humans over millions of 

years, and forcing your brain to ignore these signals and to believe what the instruments are telling you 

is very difficult. To put it bluntly, in a real aircraft, your life depends on ignoring your feelings and senses 

and flying based solely on the information in front of you. 

Gyroscopes and Their Application in Flight 
The gyroscope was invented many decades before aircraft, but its tremendous implications for flying 

were not realized until the mid- to late–1920s. The basic principal that they work on is that if you take a 

relatively heavy object and rotate it at a high rotational velocity it will hold its position in space. You can 

then mount this stable, rigid gyroscope in an instrument that is fixed to your aircraft and measure the 

relative motion of the instrument case (and thus the airplane) about the fixed gyro. The gyroscope is 

physically attached to an indicator of some sort, and these indicators then relay critical information to 

the pilot concerning the aircraft’s attitude (that is, its orientation relative to the horizon). There are 

three primary gyroscopic instruments in the panel. They are: 

the attitude indicator (or AI, normally driven by a vacuum pump on the engine), 

the turn coordinator (or TC, typically electrically driven), and 

the directional gyro (or DG, typically vacuum powered, though possibly electric). 

https://www.x-plane.com/manuals/desktop/index.html#anoteonradiotuning
https://www.x-plane.com/manuals/desktop/index.html#flightinx-plane
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Figure 7.5: The three primary gyroscopic instruments in the Cessna 172 

The AI indicates what attitude the aircraft is flying at—how far the nose is above or below the horizon, 

as well as how far the wings are banked and in which direction. The TC indicates the rate of turn—that 

is, how steep or shallow your bank is in relation to a standard 2 minute turn rate, and the DG is nothing 

more than a gyroscopically driven compass that is more stable and accurate than the old standby, the 

magnetic (or “whisky”) compass. 

The Primary Flight Instruments 
There are six primary instruments that have become standard in any instrument panel. Since the early 

1970s, these have been arranged in a standard layout referred to as “the six pack.” They are laid out in 

two rows of three instruments each. The top row, from left to right, contains the airspeed indicator 

(ASI), the attitude indicator (AI) and the altimeter (ALT). The bottom row contains the turn coordinator 

(TC), the directional gyro (DG) and the vertical speed indicator (VSI). 

The airspeed indicator shows the speed at which the aircraft is traveling through the air. In its simplest 

form, it is nothing more than a spring which opposes the force of the air blowing in the front of a tube 

attached under the wing or to the nose of the aircraft. The faster the airplane is moving the stronger the 

air pressure is that acts to oppose the spring and the larger the deflection of the needle from which the 

pilot reads the craft’s speed. Obviously, it’s quite a bit more complicated than this, as the pressure 

exerted by the stream of air varies with the local air density (which continually changes as the airplane 

climbs or descends), and the ASI must account for this. 

The attitude indicator informs the pilot of his or her position in space relative to the horizon. This is 

accomplished by fixing the case of the instrument to the aircraft and measuring the displacement of the 

case with reference to a fixed gyroscope inside. 
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The altimeter looks somewhat like the face of a clock and serves to display altitude. This is measured by 

the expansion or contraction of a fixed amount of air acting on a set of springs. As the airplane climbs or 

descends, the relative air pressure outside the aircraft changes and the altimeter reports the difference 

between the outside air pressure and a reference, contained in a set of airtight bellows. 

The turn coordinator measures the rate of turn for the aircraft. The instrument is only accurate when 

the turn is coordinated-that is, when the airplane is not skidding or slipping through the turn. A skid is 

the aeronautical equivalent to a car that is understeering, where the front wheels do not have enough 

traction to overcome the car’s momentum and the front of the car is thus plowing through the turn. In a 

car, this results in a turn radius that is larger than that commanded by the driver. A slip is a bit more 

difficult to imagine unless you’re a pilot already. It results from an aircraft that is banked too steeply for 

the rate of turn selected. To correct the slip, all the pilot has to do is increase back pressure on the yoke, 

pulling the airplane ‘up’ into a tighter turn, such that the turn rate is in equilibrium with the bank angle. 

The directional gyro is a simple instrument that points north and thus allows the pilot to tell which way 

she or he is flying. 

The vertical speed indicator reports the craft’s climb or descent rate in feet per minute. Typically, non-

pressurized airplanes will climb comfortably at about 700 fpm (if the plane is capable) and descend at 

about 500 fpm. Descent rates faster than this cause discomfort in passengers’ ears. Pressurized 

airplanes can climb and descend much more rapidly and still maintain the cabin rate of change at about 

these levels, since the cabin altitude is not related to the ambient altitude unless the pressurization 

system fails. 

Flying an Instrument Approach in X-Plane 
Nearly all of the airplanes included with X-Plane have basic navigation radios and instruments built into 

them, and all of these are used in more or less the same way. Visit Flight School for the example tutorial 

“Flying an ILS Approach” (that is, an approach using an instrument landing system) to the default airport 

(Seattle-Tacoma International, identifier KSEA), or follow the procedure described below. Similar steps 

can be used for any airport in any application. 

Finding the Frequencies 

Start by loading the default Cessna 172 at KSEA airport. To fly an instrument approach, we first need to 

know the local navigational aid (NAVAID) frequencies in order to tune our radios. To find this, open the 

map by pressing the ‘m’ key or the icon in the menu. If needed, switch to either the IFR Low or IFR High 

Enroute view. 

Now, Sea-Tac is a busy airport, so you may have to zoom in to find the ILS for the runway you are 

approaching. When you find it, though, you can click on it to highlight in yellow the ILS path and to open 

a small window with details. From this window you can tune your radios with a click of a button and 

place your aircraft up in the air at the perfect spot for the approach. 

Recall from the discussion of ILSs previously in this chapter that an ILS combines the functionality of a 

localizer (providing lateral guidance to the centerline of the runway) with a glide slope transmitter 

(providing vertical guidance down to the runway). 
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Setting Up the CDI or HSI 

Having found the relevant ILS frequency, enter it into the Nav 1 radio (remember you can tune your 

radios automatically using the buttons in the map window). Make sure the GPS (if applicable) is set to 

VLOC by clicking the CDI button near the bottom of the panel to cycle through GPS or VLOC navigation. 

Click the GPS screen in the cockpit to bring up the close-up of the instrument if needed. You can tune 

the frequency here as well; changing the GPS frequency will adjust the NAV 1 radio, and vice versa. 

Now let’s discuss the instruments we’ll use to follow this ILS. 

As in VOR navigation, the CDI is the primary instrument used for ILS navigation in the Cessna. However, 

in ILS navigation both the horizontal and vertical lines move to provide guidance. The localizer is 

represented by a vertical line. When it is in the center of the CDI, it means that the aircraft is lined up 

almost perfectly with the physical centerline of the runway. The glide slope indicator portion of the CDI 

is represented by a horizontal line. When this is in the center of the instrument, the aircraft is perfectly 

in line with the glide slope and is descending at an ideal rate. 

Below the attitude indicator is the directional gyro. The directional gyro works like a compass in that it 

indicates the aircraft’s heading. You can use this to line up your approach with a known heading (e.g., 

about 160 degrees for runway 16L). 

Flying the Approach 

Now that we’ve found the relevant ILS frequencies and set up the navigation instruments, let’s begin 

flying the actual approach. 

Once again, we’re flying into Seattle-Tacoma International Airport (KSEA), the default airport in X-Plane, 

and we set ourselves up for a 10 nm final using a button in the map. We have tuned our navigation 

radio, used the navigation source selector to choose the right radio, and we’ve reviewed the CDI. 

As you’re flying toward the airport, the CDI will begin to wander left or right to indicate which direction 

your airplane needs to move in order to point down the centerline of the runway. Aim toward the 

deflection to intercept the localizer course; when the CDI wanders right, point the aircraft’s nose right, 

and so on. 

Additionally, the glide slope indicator will begin to move. This line functions like the vertical one: If its 

needles are above the center of the instrument then the craft needs to fly up to get back on track, and if 

they are below the center of the instrument, it needs to fly down to intercept the glide slope. However, 

the glide slope is (in most cases) a downward slope at three degrees, so you should never need to climb 

to intercept it, just adjust the rate of descent. The horizontal line is above us when we start the 

approach, since we started 10 nm out from the runway. Continue flying the same altitude, and the line 

will slowly come down to the center, and from there you should control the descent to keep it there. 

The goal is to keep the vertical line centered to stay on the localizer, and the horizontal line centered to 

stay on the glide slope. 

Follow the guidance of the localizer and glide slope until the craft reaches an altitude of about 300 feet 

above the runway. At this point, if everything was done correctly, the runway will be right in front of the 

aircraft. If the landing itself was managed properly, the aircraft will be at its stalling speed plus 30% with 

the gear and flaps down as it comes in for a landing. In the Cessna, this is about 65 knots. 
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Using the X-Plane GPS 
The X-Plane GPS is modeled closely after the Garmin G430W or G530. This instrument allows pilots to fly 

a GPS approach as well as direct-to navigation. The GPS essentially combines three things: A NAVCOM 1 

radio, a GPS, and a very small moving map. 

 

Figure 7.6: The X-Plane 430 GPS navigator in the Cessna 172. 

To use the GPS, first click on its display in the cockpit to bring up a close-up window, otherwise you 

won’t be able to see more than one screen. This can be moved around the cockpit as needed. Clicking 

the GPS display in the cockpit a second time will close the window. The controls on left side adjust the 

VOR, localizer and communication frequencies, while the ones on the right control GPS functions. 

To adjust the radio frequencies, “press” the center of the large knob at the bottom to switch between 

controlling voice radio (COM or “C”) and navigation radio (“V”). The “active” channel is the top 

frequency in each dark blue box. When the bottom frequency is highlighted in a paler blue, you can use 

the inner and outer rotating knobs to change the frequency. Then use the vertical “swap” buttons (“C” 

up/down arrows or “V” up/down arrows) to make the standby frequency, which you just set, into the 

active frequency. 

Read messages, create or edit a flight plan, and activate procedures by pressing the buttons at the 

bottom. Press the button again to return to the main navigational screen where you can zoom in and 

out in map view by using the “RNG” button, or change the level of detail with the “CLR” button. The 

large dial on the button moves through the categories navigational, waypoint or nearest (shortened to 

“NAV,” “WPT” and “NRST”), while the smaller dial moves through the sub screens of that type. Click on 

the “PUSH CRSR” button to activate the cursor in applicable screens, then use the dials to change what 

text is selected. In general, the large dial moves between lines or options, while the smaller one is used 

to edit a line. Press “ENT” to keep changes or activate selections, and “CLR” or the CRSR button again to 

cancel. 

To enter a GPS destination, press the “Direct to” button (the D with an arrow through it). The LCD will 

change to a data entry screen. Use the large, outer knob in the bottom right to pick the character 

position you want to change, and use the inner ring of the knob to scroll through the alphabet/numbers 

(click and hold to move through the list quickly). For example, to pick the default airport KSEA as your 

destination, use the inner knob to scroll to “K”, use the outer knob to move the cursor to the next 

position, use the inner knob to scroll to “S”, and so on, then press ENT twice to activate it. (Note that the 

X-Plane GPS includes data for the whole world and can only use ICAO identifiers.) 
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Alternately, you can select a waypoint or destination by using the “nearest” function. From the main 

navigation screen, click the large knob twice to get to the group of menus for nearest airport, 

intersection, NDB, VOR, and airspace. Activate the cursor by pushing the knob, scroll to select the 

destination, then click the “Direct to” button and enter to activate it. 

After creating a flight plan, you can save it to load later by pressing the Menu button while in the active 

flight plan screen. You can also reverse the order of waypoints or delete the entire plan from this menu. 

To load a saved plan, use the small knob to go to the second screen of the Flight Plan category. Any .fms 

file that has been saved in the FMS plans folder (located within the Output folder in the main X-Plane 

directory) can be selected from this list. 

Using the Autopilot 
The autopilot works by implementing a number of different functions. These include, among other 

things, the ability to automatically hold a certain pitch, altitude, heading, or speed, or to fly to a 

commanded altitude. 

The following autopilot functions are available in X-Plane. Each of these is a mode that the aircraft can 

be put into simply by clicking that button on the panel with the mouse. Not all aircraft have autopilot, 

and some of the simpler craft, such as the Cessna 172, may have fewer modes than those listed below. 

The actual use of these autopilot functions will be discussed in the following sections. 

The WLV button is the wing leveler. This will simply hold the wings level while the pilot figures out what 

to do next. 

The HDG button controls the heading hold function. This will simply follow the heading bug on the HSI 

or direction gyro. 

The LOC button controls the localizer flight function. This will fly a VOR or ILS radial, or to a GPS 

destination. Note that the GPS may be programmed by the FMS. 

The HOLD button controls the altitude hold function. This will hold the current or pre-selected altitude 

by pitching the nose up or down. 

The V/S button controls the vertical speed function. This will hold a constant vertical speed by pitching 

the aircraft’s nose up or down. 

The SPD button controls the airspeed function. This will hold the pre-selected airspeed by pitching the 

nose up or down, leaving the throttle alone. 

The ATHR button also controls airspeed, but in the reverse of the SPD button. It will maintain the craft’s 

current airspeed by increasing or decreasing the throttle, while leaving the pitch alone. 

The FLCH button controls the flight-level change function. This will hold the pre-selected airspeed by 

pitching the nose up or down, adding or taking away power automatically. This is commonly used to 

change altitude in airliners, as it allows the pilot add or take away power while the airplane pitches the 

nose to hold the most efficient airspeed. If the pilot adds power, the plane climbs. If they take it away, 

the plane descends. 
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SPD and FLCH are almost identical functions in X-Plane—they both pitch the nose up or down to 

maintain a desired aircraft speed, so adding or taking away power results in climbs and descents, 

respectively. The difference is that if you have auto-throttle on the airplane, FLCH will automatically add 

or take away power for you to start the climb or descent, whereas SPD will not. 

The PTCH button controls the pitch sync function. Use this to hold the plane’s nose at a constant pitch 

attitude. This is commonly used to just hold the nose somewhere until the pilot decides what to do next. 

The G/S button controls the glide slope flight function. This will fly the glide slope portion of an ILS. 

The VNAV button controls the vertical navigation function. This will automatically load altitudes from 

the FMS (Flight Management System) into the autopilot for you in order to follow route altitudes. 

The BC button controls the back course function. Every ILS on the planet has a little-known second 

localizer that goes in the opposite direction as the inbound localizer. This is used for the missed 

approach, allowing you to continue flying along the extended centerline of the runway, even after 

passing over and beyond the runway. To save money, some airports will not bother to install a new ILS 

at the airport to land on the same runway going the other direction, but instead let you fly this second 

localizer backwards to come into the runway from the opposite direction of the regular ILS! This is called 

a back course ILS. 

Using the same ILS in both directions has its advantages (e.g., it’s cheaper), but there’s a drawback: the 

needle deflection on your instruments is backwards when going the wrong way on the ILS. Hit 

the BC autopilot button if you are doing this. It causes the autopilot to realize that the needle deflection 

is backwards and still fly the approach. 

Note that HSIs do not reverse the visible needle deflection in the back-course; you must turn the 

housing that the deflection needle is mounted on around 180° to fly the opposite direction. 

Note also that the glide slope is not available on the back course, so you have to use the localizer part of 

the procedure only. 

Turning It On and Off 
Before using the autopilot, it needs to be turned on. The autopilot power switch is labeled “Flight 

Director Mode,” or simply “FLIGHT DIR.” It has OFF, ON, and AUTO modes. 

If the flight director is OFF, nothing will happen when you try to use the autopilot. If it is ON, then the 

autopilot will not physically move the airplane controls, but will rather move little target wings on your 

artificial horizon that you can try to mimic as you fly. If you do this, you will be following the guidance 

that the autopilot is giving you, even though you are the one actually flying. The flight director, then, is 

following whatever autopilot mode you selected, and you, in turn, are following the flight director to 

actually fly the plane. If the flight director is set to AUTO, then the autopilot servos will actually fly the 

airplane according to the autopilot mode you have selected. 

In other words, turning the flight director ON turns on the brains of the autopilot, displaying the 

commands from the modes above on the horizon as little magenta wings you can follow. Turning the 

Flight Director switch to AUTO turns on the servos of the autopilot, so the plane follows the little 

magenta wings for you without you touching the stick. 
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Therefore, if you have a flight director switch, make sure it is in the right mode for the type of autopilot 

guidance you want—-none, flight director only, or servo-driven controls. 

With the flight director set to the right mode, you can engage the autopilot functions by simply pressing 

the desired button in the instrument panel. To turn off an autopilot function, simply hit its button once 

again. When all other autopilot functions are turned off, the autopilot will revert to the default 

functions. 

To turn the autopilot off altogether, simply turn the FLIGHT DIR switch to OFF. Alternatively, assign a key 

or joystick button to turn it off in the Joystick & Equipment dialog box of X-Plane. 

Using the Controls 
With the autopilot turned on (either to the flight director-only mode or the servo-driven control mode), 

you are ready to use the autopilot functions. We will discuss when it would be appropriate to use some 

of the most common functions. 

Wing Leveler and Pitch Sync 

Hit either the wing leveler (WLV) or the pitch sync (PTCH) to hold the current roll and pitch attitude, 

respectively. This is useful when switching between autopilot functions. 

Heading, Altitude, Vertical Speed, Speed Hold, Flight Level Change, and Auto-Throttle 

Hit the heading hold (HDG), altitude hold (ALT), vertical speed (V/S), speed hold (SPD), flight level 

change (FLCH), or auto-throttle (ATHR) buttons and the autopilot will maintain whatever values are 

entered into their respective selectors. For the sake of smooth transitions, many of these values will be 

set by default to your current speed or altitude at the moment the autopilot function buttons are hit. 

If you want the autopilot to guide the aircraft to a new altitude, you have to ask yourself: Do you want 

the airplane to hold a constant vertical speed to reach that new altitude, or a constant airspeed to reach 

it? Since airplanes are most efficient at some constant indicated airspeed, climbing by holding a constant 

airspeed is usually most efficient. 

Imagine you are flying along at 5,000 feet and you hit ALT, causing the autopilot to store your current 

altitude of 5,000 feet. Now, though, you want to climb to 9,000 feet. You would first dial 9,000 into the 

altitude window. The plane will not go there yet; before it will, you must choose how you want to get to 

this new altitude. 

To get to your new altitude via a given airspeed (as airliners do), after dialing in 9,000 feet in the altitude 

window, you would hit the FLCH or SPD buttons. This will cause the plane to pitch the nose up or down 

to maintain your current indicated airspeed. Now, simply add a dose of power (if needed) to cause the 

nose of the plane to rise (which the autopilot will command in order to keep the speed from increasing). 

When you reach 9,000 feet, the autopilot will leave speed-hold mode and go into altitude-hold mode, 

holding 9,000 feet until further notice. 

Both the airspeed and vertical speed modes will be maintained until you reach the new specified 

altitude, at which point the autopilot will abandon that mode and go into altitude-hold mode. The same 

thing will happen with the glide slope control. If the glide slope is armed (that is, lit up after you pushed 

the button), then the autopilot will abandon your vertical mode when the glide slope engages. This will 
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also happen with the localizer control. If the localizer is armed, the autopilot will abandon your heading 

mode when the localizer engages. This is referred to as “capturing” the localizer or glide slope. 

The key thing to realize is that the vertical speed, flight level change, and heading modes are all modes 

that command the plane the moment they are engaged. Altitude, glide slope, and localizer, on the other 

hand, are all armed (in standby) until one of the modes above intercepts the altitude, glide slope, 

localizer, or GPS course. 

An exception to the above rule is altitude. If you hit the altitude button, the autopilot will be set to the 

current altitude. This is not the way a smart pilot flies, though. A smart pilot with a good airplane, a good 

autopilot, and good planning will dial in the assigned altitude long before he or she gets there (including 

the initial altitude before take off) and then use vertical speed, flight level change, or even pitch sync to 

reach that altitude. 

Here is how the system in a real plane would be used (and thus how the system in X-Plane is best used): 

While on the ground, short of the runway, you are told to maintain, say, 3,000 feet. You are given a 

runway heading and cleared for takeoff. 

You enter 3,000 feet into the ALTITUDE window and a runway heading (for instance, 290) into the 

HEADING window. 

You take off. 

In the initial climb, around maybe 500 feet, you set the flight director to AUTO. The autopilot notes the 

plane’s current pitch and roll and holds the plane steady. 

You hit the HDG button, and the plane follows or turns to the heading. Once there, click the HDG button 

again and the plane will maintain its course. 

You hit either the V/S, FLCH, or SPD button. The autopilot automatically notes the current vertical 

velocity or airspeed, and the plane flies at that airspeed or vertical velocity until it gets to 3,000 feet, 

where it levels off. 

You are given a new heading and altitude by ATC, and dial these into their respective windows. 

You click the HDG button and the aircraft turns to the new heading, then hit V/S, FLCH, or SPD to let the 

plane zoom to the new altitude. 

Localizer and glide slope 

These are the options that are most difficult to figure out, partially because the right frequencies and 

HSI mode must be selected to use them, and partially because they will do nothing until they capture 

the approach path they are looking for. For that to happen, some other mode (any of the ones discussed 

above) must be engaged to do that. 

These modes capture an ILS, VOR, or GPS course, so they must obviously be able to fly either NAV 1, 

NAV 2, or GPS. The autopilot only knows which of these three to use when you tell it which one. This is 

done with the button labeled “NAV–1 NAV–2 FMC/CDU (or GPS),” which is the HSI source selector. 

Note: In some aircraft, this is instead a three-position switch labeled SOURCE. 



Page | 87  
 

If you set this button to NAV 1, the HSI will show deflections from the NAV 1 radio, and the autopilot will 

fly VOR or ILS signals from the NAV 1 radio when you hit the LOC or G/S buttons. 

Similarly, if you set this to NAV 2, then the HSI will show deflections from the NAV 2 radio, and the 

autopilot will fly VOR or ILS signals from the NAV 2 radio when you hit the LOC or G/S buttons. 

If you set this switch to FMC/CDU (or GPS), then the HSI will show deflections from the GPS, which can 

be set manually or by the FMS, and the autopilot will fly to the GPS destination when you hit 

the LOCbutton. Remember that if you enter destinations into the FMS, they will automatically feed into 

the GPS, so the autopilot will follow them if you select LOC. 

To repeat: be sure to send the right signal (NAV 1, NAV 2, or GPS) to the autopilot when using 

the LOC and G/S (lateral and vertical navigation) buttons. 

The LOC button will immediately begin lateral navigation to a GPS destination once engaged. It will, 

however, only track a VOR radial or ILS localizer after the needle has come off of full-scale deflection. 

This means that if you have a full-scale ILS needle deflection (simply because you have not yet gotten to 

the localizer) the localizer mode will simply go into armed (yellow) mode, and will not do anything yet to 

the plane. Your current heading or wing level mode (if engaged) will remain in force (or you can fly by 

hand) until the localizer needle starts to move in towards the center. Once that happens, the LOC will 

suddenly go from armed mode (yellow) to active mode. This causes the autopilot to start flying the 

plane for you, disengaging any previous modes. 

The reason that the localizer function disengages previous modes is that as soon as the localizer needle 

comes in, you want the autopilot to forget about heading and start flying the localizer down to the 

runway. Alternatively, you may simply fly the plane by hand to the localizer (with no autopilot mode on 

at all) and have the autopilot take over once the ILS needle starts to come in, indicating you are entering 

the localizer. Interestingly, this is much the same as the altitude modes. Just as the localizer is armed by 

hitting the LOC button, and you can do anything until the localizer arms take over lateral control, the 

altitude is also armed (always and automatically) and you can fly any vertical speed, airspeed, or pitch 

(manually or on autopilot) until the altitude is reached, at which point the autopilot will go into altitude 

hold mode. 

Just like the lateral navigation (that is, the localizer function), the vertical navigation (glide slope, 

or G/S mode) will not do anything until the glide slope needle starts to move. Unlike with the localizer, 

though, the glide slope function won’t do anything until the glide slope needle goes all the way through 

the center position. It does this because you typically have the airplane on altitude hold until you 

intercept the glide slope, at which point the plane should stop holding altitude and start descending 

down to the runway. In other words, the glide slope function will automatically go from armed to active 

once the plane hits the center of the glide slope. 

Let’s now put the LOC and G/S functions into use to fly an ILS. 

Flying an ILS Using LOC and G/S 
To fly an ILS, do the following while still far away from the ILS and below glide slope: 

Hit the ALT button to hold the current altitude. 

Enter a heading in the heading window to be followed until you intercept the ILS. 
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Hit the HDG button to hold that heading. 

Hit the LOC button. It will go to “armed” (yellow). 

Hit the G/S button. It will also go to “armed” (yellow). 

As soon as you intercept the localizer, the LOC button will go from yellow to green, abandoning the 

heading mode to instead fly the localizer. 

As soon as you intercept the center of the glide slope, the G/S button will go from yellow to green, 

abandoning the altitude hold mode to instead fly the glide slope. 

The autopilot will track you right down to the runway, and even flare at the end, cutting power if auto-

throttle mode is engaged. 

Just as in a real airplane, these things only work well if you: 

intercept the localizer far away (outside of the outer marker) and below the glide slope, 

intercept the localizer at less than a 30° angle, and 

hold altitude when you intercept the glide slope. 

If you come in above the glide slope, cross the localizer at a wide angle, or intercept the localizer too 

close to the airport, the autopilot will not be able to maneuver the airplane for landing (again, just as in 

a real plane). 

Now that we’ve detailed flying with the autopilot, let’s talk about flying an FMS (flight management 

system) plan. 

Flying an FMS Plan 
To use the autopilot to fly a flight management system plan, a few things must happen: 

You must enter your entire flight plan into the FMS. 

You have to have the HSI set to GPS, not NAV 1 or NAV 2 (because the autopilot will fly whatever it sees 

on the HSI). 

You must have the LOC button selected ON since that button causes the autopilot to follow the localizer 

(or whatever is on the HSI). 

You must have the FLIGHT DIR switch set to AUTO, so that the servos are running. 

You must hit the VNAV button if you want the FMS to also load altitudes into the altitude window. 

Do all these things and the plane will follow any FMS plan, assuming, of course, that the plane you are 

flying has all this equipment (which of course some do not). 

To demonstrate the use of an FMS, we’ll go through the procedure in a typical aircraft. The steps will be 

similar in any aircraft. 

Start the flight by opening the Quick Start dialog box and selecting an aircraft with the default FMS, such 

as the P180 Avanti. It is found in the General Aviation aircraft folder. Select San Diego International 
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Airport (KSAN) as the starting airport from the Airport box. Time of day and weather can be anything 

you like, but to keep it simple, let’s use the “day” and “clear” settings. 

In 3-D cockpit view, the FMS is found to the right of the pilot’s seat (it should be displaying the text 

“PLAN SEGMENT 01”). Hit the top left INIT button on the FMS. This gets the FMS ready to receive a flight 

plan and puts the cursor on the second line labeled “APT.” 

Now enter the ID of the starting airport by hitting the FMS keypad with the mouse. We are starting at 

San Diego International Airport (KSAN) and flying to San Bernardino International (KSBD). 

If you like, hit the line-select button on the left side of the FMS next to the text “FLY AT  FT” and enter 

the altitude you want to fly at using the keypad. 

Now, hit the NEXT button on the FMS and repeat the steps above for the next waypoint. For our 

purposes, press the AIRP button and enter KSBD for our final destination airport here, then click the 

dash button to the left of the “Fly At” line on the screen to enter the altitude at which you’ll be flying. 

Any VOR, NDB, FIX or LAT/LON can be entered here instead (or as additional plan segment pages) to 

program your route. Make sure your press the appropriate button on the FMS before entering the code 

for the NAVAID of your choice. 

Use the DEL button to erase mistakes, or CLR to cancel the entire plan. The PREV PAGE and NEXT 

PAGE buttons will cycle through the various waypoints in your plan. To save an FMS plan, click 

the SAbutton, or click the LD button to load a saved plan. X-Plane stores these plans in the Output folder 

of the home directory. 

Once you have entered the plan into the FMS, set the white NAV Source switch to GPS so that the HSI is 

getting data from the flight management computer we just programmed. Move the FLIGHT DIR switch 

to on, then take off. 

The second waypoint should activate automatically. Engage HDG mode on your autopilot and set it to 

intercept the FMS course. Press the LOC autopilot button to arm FMS course capture so as you approach 

the course the autopilot will lock on and turn toward the waypoint. You must first intercept the FMS 

course to make the autopilot lock on. Press the autopilot VNAV button to select the “Fly At” altitude. 

If your flight plan has more than one waypoint, as you approach the FMC’s active waypoint it will 

automatically switch to the next Plan Segment. If for some reason the FMS fails to do this, you can force 

it to step forward or skip waypoints by using the NEXT button to display the desired waypoint and the 

select button (a D with an arrow through it) to activate it. 

Sit back and let the autopilot take you to your destination. Once you arrive, note that you can’t use the 

FMS to land the plane so you must deactivate GPS mode and fly your approach as you usually would. 

Special Situations in X-Plane 

Using an Instructor Operator Station (IOS) for Flight Training 
An Instructor Operator Station is a sort of console used by a flight instructor or someone standing in for 

an instructor. This console can be used to fail multitudes of aircraft systems, alter the weather and time 

of day, or relocate the aircraft. The IOS can be run on a second monitor on the same computer as the 

simulator. 
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Setting up the IOS 
If you are using one computer with two (or more) monitors, you can enable the IOS on the second 

monitor by going to the Graphics tab in the Settings screen. Under Monitor Configuration, ensure your 

primary monitor is set to “Full Screen Simulator” in the drop down box, then pick “Instructor Operating 

Station” in the drop down menu for the other monitor. (Note that the IOS can only be used full screen, 

not windowed, when set up in this manner.) When you close the Settings window you will have the IOS 

screen options on your second monitor and the flight on the primary monitor. 

If you would like to use X-Plane windowed, you can also open the IOS as a window, pop it out and drag it 

around to whatever location you want on your monitors. Open the IOS window by going to the Flight 

menu > Toggle Instructor Operating Station. Click the two squares in the top right corner to pop it out as 

a separate window that you can then drag to a different monitor. 

IOS Features 
Once you have the IOS configured how you would like it, you will be able to fly on one monitor while 

controlling many of the aspects of your flight on the other. 

In the IOS window you you will have the standard Map display as well as buttons along the left of this 

window which allow the instructor to perform all sorts of tasks from one location, while maintaining a 

watch on the X-Plane pilot using the map view. 

The “instructor” can load different aircraft, relocate the aircraft, alter weather conditions, fail systems, 

and change the time, weight, balance, or fuel for the “student” pilot. In addition, there are buttons to 

load or save a flight, reset the flight path and quit X-Plane. 

Flying Helicopters 
The following is a description of how helicopters are flown in the real world, along with the application 

of this in X-Plane. You can also use the Flight School tutorial “Helicopter Basics” to get hands on 

experience flying helicopters in the sim. Note that helicopters are loaded in X-Plane just like any other 

aircraft, using the Flight Configuration screen. Note also that you can move to the helipad nearest you at 

any time by opening the Customize Location screen, clicking the Special Starts button and clicking on 

the Helipad Start line. 

All manner of different helicopter layouts can be found in reality, but we will discuss the standard 

configuration here—-a single overhead rotor with a tail rotor in the back. Here’s how this works: First, 

the main rotor provides the force needed to lift the craft by continuously maintaining the same rotor 

RPM for the entire flight. The amount of lift generated by the main rotor is only varied by adjusting the 

blade pitch of the main rotor blades. 

So, imagine the one-and-only operational RPM of a helicopter is 400 RPM. When the craft is sitting on 

the ground, the rotor is turning 400 RPM, and the pitch of the rotor’s blades is about zero. This means 

that the rotor is giving about zero lift! Because the blades have zero pitch, they have very little drag, so it 

is very easy to move them through the air. In other words, the power required to turn the rotor at its 

operational RPM is pretty minimal. Now, when the pilot is ready to go flying, he or she begins by pulling 

up on a handle in the cockpit called the “collective.” When this happens, the blades on the rotor go up 

to a positive pitch. All the blades on the main rotor do this together at one time—“collectively.” Of 

course, they are then putting out a lot of lift, since they have a positive pitch. Equally apparent is the fact 
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that they are harder to drag through the air now, since they are doing a lot more work. Of course, since 

it is a lot harder to turn the blades, they start to slow down—if this were allowed to happen, it would be 

catastrophic, since the craft can’t fly when its rotor isn’t turning! To compensate, at that point any 

modern helicopter will automatically increase the throttle as much it needs to in order to maintain the 

desired 400 RPM in the rotor. 

To summarize, this is the sequence for getting a helicopter in the air in X-Plane: 

While on the ground, the collective handle is flat on the floor. This means the rotor pitch is flat, with 

minimum drag and zero lift. In X-Plane, a flat collective corresponds to the throttle being full forward, or 

farthest from the user. The automatic throttle in the helicopter is obsessively watching the rotor’s RPM, 

adjusting the throttle as needed to hold exactly 400 RPM in the example above. On the ground, with the 

collective pitch flat, there is little drag on the blades, so the power required to hold this speed is pretty 

low. 

When you decide to take off, you do so by raising the collective up—that is, by pulling it up from the 

floor of the helicopter. In X-Plane, this is done by easing the throttle on a joystick back down toward 

you. This increases the blade pitch on the main rotor and therefore increases its lift, but it also increases 

the drag on the rotor a lot. The rotor RPM begins to fall below 400 RPM, but the auto-throttle senses 

this and loads in however much engine power it has to in order to keep the rotor moving at exactly 400 

RPM. 

More collective is pulled in until the blades are creating enough lift to raise the craft from the ground. 

The auto-throttle continues adding power to keep the rotor turning at 400 RPM no matter how much 

the collective is raised or lowered. 

Once the craft is in the air, the first-time helicopter pilot’s first crash is no doubt beginning. This 

inevitability can be delayed for a few moments using the anti-torque pedals. 

The main rotor is putting a lot of torque on the craft, causing it to spin in the opposite direction (because 

of course for every action there is an equal and opposite reaction—the rotor is twisted one way, the 

helicopter twists the other way). This is where the anti-torque pedals come in. The rotational torque on 

the helicopter is countered with thrust from the tail rotor. Just push the left or right rudder pedal (such 

as the CH Products Pro Pedals) to get more or less thrust from the tail rotor. If rudder pedals aren’t 

available, the twist on a joystick can be used for anti-torque control. If the joystick used does not twist 

for yaw control, then X-Plane will do its best to adjust the tail rotor’s lift to counter the main rotor’s 

torque in flight. 

Incidentally, the tail rotor is geared to the main rotor so that they always turn in unison. If the main 

rotor loses 10% RPM, the tail rotor loses 10% RPM. The tail rotor, like the main rotor, cannot change its 

speed to adjust its thrust. Like the main rotor, it must adjust its pitch, and it is the tail rotor’s pitch that is 

being controlled with rudder pedals or a twisting joystick. 

Once the craft is in the air and the collective pitch of the main rotor is being adjusted (in X-Plane, using 

the joystick throttle), try holding the craft 10 feet in the air and adjusting the tail-rotor pitch with the 

anti-torque pedals (i.e., rudder pedals or a twisting stick) to keep the nose pointed right down the 

runway. From here, the joystick should be wiggled left, right, fore, and aft to steer the helicopter 

around. 

http://www.chproducts.com/retail/pedals.html
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Here is how this works: If the stick is moved to the right, then the rotor blade will increase its pitch when 

it is in the front of the craft, and decrease its pitch when it is behind the craft. In other words, the rotor 

blade will change its pitch through a full cycle every time it runs around the helicopter once. This means 

that it changes its pitch from one extreme to the other 400 times per minute (7 times per second) if the 

rotor is turning at 400 RPM. Pretty impressive, especially considering that the craft manages to stay 

together under those conditions! Now, while it seems that the right name for this might be the 

“helicopter destroyer,” the fact that moving the stick sends the blade pitch through one cycle every 

rotation of the rotor blades means we call the control stick the cyclic stick. So, we have the collective, 

cyclic, and anti-torque controls. 

Let’s talk more about the cyclic. When the stick is moved to the right, the rotor increases pitch when it is 

in the part of its travel that is in front of the helicopter. This will increase the lift on the front of the rotor 

disc, causing it to tilt to the right, since the gyroscopic forces are applied 90° along the direction of 

rotation of the gyroscope. Now that the rotor is tilted to the right, it will of course drag the craft off to 

the right as long as it is producing lift. 

The fascinating thing is that the rotor on many helicopters is totally free-teetering; it has a completely 

“loose and floppy” connection to the craft. It can conduct no torque (left, right, fore, and aft) to the body 

of the helicopter. Maneuvering is only achieved by the rotor tilting left, right, fore, and aft, dragging the 

top of the craft underneath it in that direction. The helicopter body is dragged along under the rotor like 

livestock by a nose-ring, blindly following wherever the rotor leads. 

Once you master hovering in place, push the nose down to tilt the rotor forwards. The lift from the rotor 

acting above the center of gravity of the aircraft will lower the nose of the helicopter, and the forward 

component of lift from the rotor will drag the craft forward as it flies along. 

Flying Special Situations 
To view all the possibilities for special starts in X-Plane, go to Flight Configuration and click 

the Customize button in the Location box. In the following window, click the Special Starts button at the 

bottom left of the screen. In this list you will find a number of special ways to take off and fly. Selecting 

the Grass Strip, Dirt Strip, Gravel Strip, or Seaplane Start lines will take you, in your current aircraft, to 

the nearest airstrip of that type. 
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Figure 8.1: Special starts in the Location Customize screen 

Selecting the Frigate Approach, Small Oil Rig Approach, or Large Oil Platform Approach lines will give 

you excellent targets for a helicopter landing. Additional types of special starts are discussed in more 

detail in the following sections. 

Flying Gliders 
Get started with flying gliders by going to the Flight Configuration window and picking a glider, such as 

the default ASK 21. Now you have to get in the air, either by being towed by another aircraft or by a 

winch. Click the Customize button and pick which start you’d like from the two options at the bottom of 

the window. 

The Glider Tow button will load another aircraft (the Stinson L–5) to which your glider will be attached. 

This aircraft will pull yours along behind it, and you will be able to release the line connecting you to the 

towplane at your desired altitude. On the other hand, the Glider Winch button will set up a stationary 

winch on the ground which will quickly pull in a wire attached to your glider, which you will release once 

you are 1500 feet or so above the ground. In either case, you can release the tow line by pressing the 

space bar. 

When using the towplane, you will start behind the plane with its engine running and ready to go. 

Releasing the glider’s brakes (using the b key by default) commands the towplane to take off, dragging 

your glider with it. 

The towplane, once in flight, will take the glider as high as you like. Pressing the space bar will release 

the line between the aircraft, allowing you to soar freely. While being carried up to altitude, though, you 

must keep your glider in formation behind the towplane. 

Notice that until you have unhooked yourself, the tow rope connecting your glider to the towplane is 

attached to your nose and the towplane’s tail. X-Plane models the real physics of this situation, so if 

your glider pulls left, right, up, or down, it will drag the towplane’s tail in that direction. This could result 

in simply pulling the plane off course, or ultimately in dragging the plane into a stall or spin. If that 

happens, things will get very complicated very quickly—-the towplane (which will likely be crashing) will 

be dragging the glider with it! The dynamics of the resulting crash are interesting if nothing else. 

According to the FAA Glider Handbook, a glider pilot should keep the glider in one of two positions when 

being towed to altitude. It should either be in a “low tow” position, wherein the glider is just below the 

wake from the towplane, or it should be in a “high tow” position, just above the wake from the 

towplane. Hold this position carefully to keep from dragging the towplane around! 

A glider pilot must watch the wind and the slope of the terrain carefully to hold inside the upward-

moving currents of air, using the lift of the air flowing up the mountain slope to hold the craft aloft. With 

a good 25-knot wind set in the simulator, you can get a nice, free elevator ride to 10,000 feet when 

flying along the windward side of a nice, steep mountain. This is called ridge lift. 

X-Plane will also model the columns of rising hot air, called thermals, that are useful for prolonging a 

glider flight. To turn on the thermals, open the Customize Weather screen from Flight Configuration. 

Expand the Thermals section in the right side list, then drag the Coverage slider up—15% coverage or 

more makes for a nice flight. A 500 ft/min Climb Rate is fine, but you can raise that value, too, if you 

http://www.faa.gov/library/manuals/aircraft/glider_handbook/
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like. Additionally, as you’re starting out in gliders, you may want to keep the Speed, Turbulence, Gust 

Speed Increase and Shear Amount settings of your wind layers set to minimum. 

Now, to take full advantage of both ridge lift and thermals, gliders have a unique instrument known as 

the total energy variometer. This indicates your glider’s rate of climb or descent. You can see the visual 

representation of this instrument in the panel (it is labeled “Total Energy” and is found towards the 

bottom of the panel in the ASK 21); if the needle is above the center of the dial, you are climbing 

(perhaps due to ridge lift or a thermal), and if it is below the center, you are falling. Even better, you can 

flip on the switch next to it labeled “Audio” in the instrument panel to get auditory feedback from the 

variometer. If it is beeping, then the aircraft is in a nice updraft from the air following the terrain. 

Circling in that area will let the glider ride the climbing air to altitude. When the variometer is emitting a 

steady tone, the craft is in descending air—-the glider has been blown to the wrong side of the 

mountain, and a crash will follow soon if you do not find a way out of that area! 

To land the glider, simply circle down to runway level. The trick is to approach the runway with just 

enough speed to set the craft down safely. Remember, pulling the speedbrakes in can help slow the 

craft down, but if it doesn’t have enough speed to reach the landing strip, the glider has no way of 

generating thrust. Ideally, you will reach the runway at just above stalling speed, but it’s always better to 

have too much speed (which you can burn off using the speedbrakes) than too little. 

Flying the Space Shuttle 
Read this chapter before attempting Space Shuttle landings in X-Plane if you want your virtual pilot to 

live! 

The first rule of flying a glider—quite unlike flying a powered plane—is this: Never come up short. When 

bringing a powered plane in for landing, if the pilot thinks the craft will not quite make it to the runway, 

it is no big deal. She or he just adds a bit more power to cover the extra distance. If a little more speed is 

needed, it is again no problem—just add power. 

Gliders play by a different set of rules, though. There is no engine to provide power, so when setting up 

a landing, a pilot must be sure to have enough altitude and speed to be able to coast to the airport, 

because if s/he guesses low by even one foot, the craft will hit the ground short of the runway, crashing. 

Gliders must never be low on speed or altitude, because if they ever are, there is no way of getting it 

back—a crash is assured. (Thermals, or rising currents of air, provide the exception to this rule. These 

can give efficient gliders enough boost to get the job done, but thermals will typically provide less than 

500 feet per minute of vertical speed—not enough to keep even a lightweight Cessna in the air!) 

Now, with the Space Shuttle, it is certainly true that the aircraft has engines—three liquid-fuel rockets 

putting out 375,000 pounds of thrust each, to be exact. (To put this in perspective, a fully-loaded Boeing 

737 tips that scales around 130,000 pounds, so each engine of the orbiter could punch the Boeing 

straight up at 3 Gs indefinitely. That is not even considering the solid rocket boosters attached to the 

Shuttle’s fuel tank that provide millions of pounds of thrust!) 

So, the Space Shuttle has engines; the problem is fuel. The orbiter exhausts everything it’s carrying 

getting up into orbit, so there is nothing left for the trip down. Thus, the ship is a glider all the way from 

orbit to its touch-down on Earth. With the final bit of fuel that is left after the mission, the orbiter fires 
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its smaller de-orbit engines to slow it down to a bit over 15,000 miles per hour and begins its descent 

into the atmosphere. 

So, if you want to fly the Space Shuttle, and the Space Shuttle is a glider from the time it leaves orbit to 

the time it touches down on Earth, you must bear in mind the cardinal rule of gliding: Always aim 

long(past the landing point), not short, because if ever you aim short, you are dead, because you cannot 

make up lost speed or altitude without engines. Aim long since the extra speed and altitude can always 

be dissipated with turns or speedbrakes if the craft winds up being too high, but nothing can be done if 

it comes up short. 

In observance of this rule, the Orbiter intentionally flies its glide from orbit extra high to be on the safe 

side. But there is one problem. It would appear that if the Orbiter flies its entire approach too high, it 

will glide right past Edwards. In reality, this doesn’t happen for one reason. For most of the re-entry, the 

Shuttle flies with the nose way up for extra drag, and it makes steep turns to intentionally dissipate the 

extra energy. The nose-up attitude and steep turns are very inefficient, causing the Shuttle to slow down 

and come down to Earth at a steeper glide angle. If it ever looks like the Orbiter might not quite be able 

to make it to the landing zone, the crew simply lowers the nose to be more efficient and level it out in 

roll to quit flying the steep turns. This makes the Orbiter then glide more efficiently, so the crew can 

stretch the glide to Edwards for sure. The extra speed and altitude is the ace up their sleeve, but the 

drawback is they have to constantly bleed the energy off through steep turns (with up to 70° bank 

angle!) and drag the nose up (as high as 40°!) to keep from overshooting the field. 

We will now walk through the re-entry process from the beginning as it is done both in the real Shuttle 

and in X-Plane. 

After de-orbit burn, the shuttle heads for the atmosphere at 400,000 feet high with a speed of 17,000 

miles per hour and a distance of 5,300 miles from Edwards (equivalent to landing in the Mojave Desert 

after starting a landing approach west of Hawaii—not a bad pattern entry!). In reality, the autopilot flies 

the entire 30-minute re-entry, and the astronauts do not take over the controls of the shuttle until the 

final 2 minutes of the glide. The astronauts could fly the entire re-entry by hand, but it is officially 

discouraged by NASA, for obvious reasons. These speeds and altitudes are way outside of normal human 

conception, so our ability to “hand-fly” these approaches is next to nil. 

During the first one hundred NASA Shuttle missions, the craft was hand-flown for the entire re-entry 

only once, by a former Marine pilot who was ready for the ultimate risk and challenge. In contrast, users 

flying the Space Shuttle in X-Plane will have to complete the entire mission by flying by hand. 

Walkthrough 

To open the Space Shuttle for a re-entry flight into the atmosphere, go to the Aircraft section of Flight 

Configuration. Make sure Show extra aircraft from old versions is checked and select the Space Shuttle. 

Click on Customize in the location box. Click on Special Starts to find four options for flying the space 

shuttle: Full Re-entry, Final Re-entry, Full Approach, and Final Approach. 

The Space Shuttle: Final Approach is the shortest and easiest, as well as the most realistic since this is 

the only part of the whole procedure pilots actually hand-fly! Click this button to fly the final eight miles 

before setting down on the runway at Edwards Airforce Base. Click Space Shuttle: Full Approach to start 

40 miles away from Edwards. You’ll fly over and past the base, then make a left turn to heading marker 
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230 to line up with the runway for touchdown. The Sapce Shuttle: Final Re-Entry button will start you 

almost 600 feet downrange for the final 12 minutes of descent to Edwards. 

To fly the whole 30 minute re-entry procedure, click the Space Shuttle: Full Re-entry button (choose 

one of the other options for a much shorter flight). X-Plane will load the craft at around 450,000 feet, in 

space, coming down at a speed of Mach 20. Control will be limited in space (the craft is operating off of 

small reaction jets on the Orbiter, set up as “puffers” in Plane-Maker), but once the shuttle hits 

atmosphere, there will be some air for the flight controls to get a grip on and the craft will actually be 

able to be controlled. The ship will first hit air at about 400,000 feet, but it will be so thin that it will have 

almost no effect. 

The airspeed indicator at this point will read around zero—interesting, since the craft is actually moving 

at over 17,000 mph. The reason for this is that the airspeed indicator works based on how much air is 

hitting it, just like the wings of the Orbiter do. In space, of course, that’s very little. The indicated 

airspeed will build gradually as the craft descends. Under these conditions, even though the Shuttle is 

actually slowing down, the airspeed indicator will rise as it descends into thicker air that puts more 

pressure on the airspeed indicator. This oddity of the airspeed indicator, though, is useful, since the air is 

also putting more pressure on the wings. This means you should get some help with your research paper 

and the airspeed indicator is really measuring how much force the wings can put out, which is really 

what a pilot is interested in here. 

Restated, the airspeed indicator indicates the craft’s true airspeed times the square root of the air 

density. It indicates lower speeds in thin air, but the wings put out less lift in thin air as well, so the 

airspeed indicator works very well to tell the pilot how much lift can be put out by the wings. 

If the airspeed indicator reads more than about 250 knots, the wings have enough air to generate the lift 

to carry the aircraft. If the airspeed indicator is showing less than about 250 knots, then the wings do 

not have enough air hitting them to lift the Shuttle, so it is still more or less coasting in the thin upper 

atmosphere, where the air is too thin to do much for controlling flight. 

As the airspeed indicator on the HUD gradually starts to indicate a value (as the aircraft descends into 

thicker air), it means the craft is starting to ease down into the atmosphere at 15,000 mph like a 

sunburned baby trying to ease into a boiling-hot Jacuzzi—very carefully and very slowly. Remember, if 

the craft was going 15,000 mph in the thick air of sea level, it would break up into a million pieces in a 

microsecond. The only reason it survives at 15,000 mph up here is the air is so thin that it has almost no 

impact on the ship. Again, the airspeed indicator tells how much the air is really impacting the craft; 250 

knots is a “comfortable” amount. The trick is to get the craft moving much slower than 15,000 mph by 

the time it gets down to the thick air of sea level—and to have it doing so at Edwards Air Force Base. 

This is what the re-entry is for, to dissipate speed while descending so that the Orbiter is never going too 

fast for the thickness of the air that it is in. It should only descend into the thicker air once it has lost 

some speed in the thinner air up higher. The whole thing should be a smooth process wherein the ship 

doesn’t get rammed into thick, heavy air at too high a speed. 

Now, as the Orbiter begins to touch the outer molecules of the Earth’s atmosphere, you will notice a 

slight ability to fly the ship as some air begins to pass over the wings. At the same time, the HUD should 

begin showing speed. Notice the picture of the Orbiter on the far right-hand EFIS display in Figure 8.2 

below. (The best way to see the entire panel is in 3D cockpit view, selected from the View menu at the 
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top of the screen, or by pressing “Shift + 9,” then use the arrow keys to position the view as desired.) 

Both the Orbiter and the path down to Edwards should be visible. The goal is to stay centered on the 

path. If the craft gets above it, it is either too fast or too high and might overshoot the landing. If it gets 

below it, it is either too slow or too low and might not make it. 

Remember that the line is drawn with a large margin for error, so if a pilot stays on the line, he or she 

will have plenty of extra energy. Getting below the line a little will only tap into the speed/altitude 

reserve. Getting below the line a lot will keep the craft from reaching Edwards. 

 

Figure 8.2: The 3D Orbiter cockpit 

The Orbiter must stay near the center green line. This green line represents the desired speed for the 

early part of the re-entry, the desired total energy for the middle part of the re-entry, and the 

desired altitude for the final phase of the re-entry. If the craft is too fast or too high (meaning it is above 

the center line) then it is time to dissipate some energy. Put the Shuttle in a steep bank, pull the nose 

up, and hang on! 

The real Orbiter will have it nose up about 40° and be in a 70° bank to try to lose energy while moving at 

14,000 mph, glowing red hot, hurtling through the upper atmosphere on autopilot, and leaving a ten 

mile-long trail of ionized gas behind it while the astronauts just watch. 

Go into some steep turns to dissipate energy as needed to keep the ship from going above the center 

green line. Pilots should follow the computer’s recommendation or their own intuition for how much 

bank to fly, but they must certainly keep the nose up (in order to stay in the upper atmosphere) and fly 

steep banks to dissipate the extra speed and altitude. It might be tempting to just push the nose down if 

the craft is high, but don’t. The aircraft would drop down into the thick air and come to an abrupt stop 
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from the tremendous drag, keeping it from ever making it to Edwards. It would wind up swimming in the 

Pacific somewhere around Hawaii. 

Now, as the pilot makes those steep turns, the aircraft will gradually be pulled off course. For this 

reason, the turn direction should be switched from time to time to stay on course. Turn left awhile, then 

right, then back to the left again. This is what the real Orbiter does—it slalom-skis through the upper 

atmosphere at Mach 20. Watch Edwards on the center Horizontal Situation EFIS display. 

As the ship approaches Edwards (right on the green line of the right-hand Vertical Situation display) 

there should be some numbers in a sort of curve out past Edwards. This is the Heading Alignment 

Cylinder, or H.A.C. The aircraft will fly past Edwards at about 80,000 feet, then fly around the H.A.C. like 

it’s connecting the dots. After coming around, it will be pointed right at Edwards. If the craft is still on 

the green line, its altitude will be just right for landing as well. In the real Shuttle, this is usually where 

the pilot will turn off the autopilot and hand-fly in. 

 

Figure 8.3: The space shuttle’s horizontal and vertical course displays 

The craft should now be doing about 250 or 300 knots, coming down at about 15,000 feet per minute or 

so (about 125 miles per hour of descent rate). Needless to say, pilots do not want to hit the ground with 

that 125 miles per hour descent rate. Do not aim for the runway without expecting to become a smear 

on it. Instead, aim for the flashing glide slope lights 2 miles short of the runway that NASA has 

thoughtfully provided. If they are all red, the craft is too low. If they are all white, it is too high, so the 

speed brakes need to be brought in. If the lights are half red and half white, the Orbiter is right on its 

glide slope (about 20°). Airliners fly their approach at 125 knots with a 3 angle of descent, while the 

Space Shuttle uses 250 knots and a 20° descent angle—not too unusual considering pattern-entry 

started west of Hawaii, actually. 

To recap: the craft should be at 250 knots, on the green line, lined up with the runway. It should be 

facing half red, half white glide slope lights with the flashing strobes by them. This approach 

configuration should be held until the craft is pretty close to the ground (3° glide slope to the runway), 

then the descent should be leveled and the gear put down (using the ‘g’ key or the mouse). Pull the nose 
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up for a flare as the runway approaches, causing the Orbiter to touch down smoothly. Lower the nose 

then and hit the parachute and even the brakes if the craft will be allowed to roll out. 

Now, if you can just repeat that process another hundred times in a row without a single hitch, you will 

be as good as NASA. 

Special thanks to Sandy Padilla for most of the Shuttle re-entry information! 

Flying the X–15 
The North American X–15 is a rocket-powered speed demon. With a top speed of Mach 6.72 (4520 miles 

per hour), it is the fastest manned aircraft in the world. To begin flight, this craft is dropped, uniquely, 

from the B–52 “mothership.” Its top speed is over double that of the SR–71 (the world’s fastest jet 

airplane), and its maximum altitude of over 50 miles qualifies its pilots for astronaut status. 

The craft’s absurdly high top speed requires a blast shield to be installed over one side of the 

windshield—without it, the windows would burn up. The X–15 pilots would fly the high speed portion of 

the mission with the shield on the right side, looking out the left side only. After the craft slowed down 

(and the left window was sufficiently charred), the pilot would jettison the blast shield and move to the 

right window in order to land. 

To fly the X–15, go to the Aircraft section of Flight Configuration. Make sure Show extra aircraft from 

old versions is checked and select the X–15. To be dropped from the B–52, click on Customize on the X–

15, and from the drop down select “Be carried by another aircraft.” If necessary, change to the B–52 by 

using the Edit button that is now available. 

X-Plane will load up both the X–15 and the B–52 drop ship. When you are ready, press the space bar to 

release the rocket from the drop ship. Give it full throttle, with no flaps, and watch your airspeed 

“rocket”—that is, until it gains enough altitude, at which point its indicated airspeed will drop to maybe 

15 knots, while it is actually moving at Mach 6. 

Performing Carrier Operations 
To begin carrier operations, select the aircraft you will use (military aircraft such as the default F–4 

Phantom are good choices). Open the Flight Configuration Screen and click the Customize button in the 

Location box. Pick either the Carrier Catshot, Frigate Approach, or Carrier Approach line to set up a 

catapult launch from a carrier or a final approach to one, respectively. 

To take off from a carrier, a few things must be done in quick succession. First, give the aircraft full 

throttle, and pull in about half flaps. Release the brakes (using the ‘b’ key by default) to activate the 

catapult propelling your aircraft off the deck. From there, simply guide the craft down the flight deck 

and, once clear, pull the nose up. When you’re safely in the air, bring the gear up (using the ‘g’ key by 

default) and you’re off. 

Landing on the carrier is a bit more difficult. First, be sure you have an aircraft with an arresting hook. 

To set up an approach to a modern carrier, such as the USS Nimitz included with X-Plane, bear in mind 

that the landing runway is angled 30 to the port (left) side—it is not straight down the flight deck like in 

older carriers. This change was made in order to prevent the all-too-common overruns that occurred in 

WWII when a landing plane crashed into the stacked line of planes at the far end of the carrier. A pilot 
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landing on such a carrier must correct for this angling. With your ADF tuned to the carrier, then, you 

must wait until the ADF is pointing either 15° or 60° to the right before turning in for a landing. 

When approaching the flight deck to land, a glidepath of about 3.5° is standard. At this time, the tail 

hook should be lowered (Option + ‘Q’ by default). This will allow the tail of the aircraft to catch the 

arresting wires on the deck. These wires will decelerate the craft from well over 100 knots down to zero 

in little more than a second. 

Unlike in a conventional landing, there should be no “flare” before touching down on the carrier. 

Whereas, say, an airliner would raise its nose up just before touching the runway (thereby ensuring a 

smooth landing), a carrier approach should maintain a constant glide slope until the craft hits the deck. 

Also, rather counter-intuitively, a real fighter pilot must slam the throttle to full the instant that the 

aircraft touches the deck. This is because, even when the pilot has done everything right, the craft’s tail 

hook can bounce over the arresting wires in what is called a “bolter.” When this happens, the pilot must 

be ready to get off the deck safely and come around for another try. Don’t worry—even when the 

throttle revs up like this, the arresting wires will still pull the craft down to zero velocity. 

Flying a Boeing 747 with the Piggybacking Space Shuttle 
The piggybacking Space Shuttle situation in X-Plane was inspired by the following email, which was 

circulated by United Technologies corporate. It is a “trip report” from the pilot of the 747 that flew the 

Shuttle back to Florida after the Hubble repair flight. 

Well, it’s been 48 hours since I landed the 747 with the shuttle Atlantis on top and I am still buzzing from 

the experience. I have to say that my whole mind, body and soul went into the professional mode just 

before engine start in Mississippi, and stayed there, where it all needed to be, until well after the flight… 

in fact, I am not sure if it is all back to normal as I type this email. The experience was surreal. Seeing 

that “thing” on top of an already overly huge aircraft boggles my mind. The whole mission from takeoff 

to engine shutdown was unlike anything I had ever done. It was like a dream… someone else’s dream. 

We took off from Columbus AFB on their 12,000 foot runway, of which I used 11,999 ½ feet to get the 

wheels off the ground. We were at 3,500 feet left to go of the runway, throttles full power, nose wheels 

still hugging the ground, copilot calling out decision speeds, the weight of Atlantis now screaming 

through my fingers clinched tightly on the controls, tires heating up to their near maximum temperature 

from the speed and the weight, and not yet at rotation speed, the speed at which I would be pulling on 

the controls to get the nose to rise. I just could not wait, and I mean I could not wait, and started pulling 

early. If I had waited until rotation speed, we would not have rotated enough to get airborne by the end 

of the runway. So I pulled on the controls early and started our rotation to the takeoff attitude. The 

wheels finally lifted off as we passed over the stripe marking the end of the runway and my next hurdle 

(physically) was a line of trees 1,000 feet off the departure end of Runway 16. All I knew was we were 

flying and so I directed the gear to be retracted and the flaps to be moved from Flaps 20 to Flaps 10 as I 

pulled even harder on the controls. I must say, those trees were beginning to look a lot like those 

brushes in the drive-through car washes, so I pulled even harder yet! I think I saw a bird just fold its 

wings and fall out of a tree as if to say “Oh, just take me.” Okay, we cleared the trees, duh, but it was 

way too close for my laundry. As we started to actually climb, at only 100 feet per minute, I smelled 

something that reminded me of touring the Heineken Brewery in Europe… I said “Is that a skunk I 

smell?” and the veterans of shuttle carrying looked at me and smiled and said “Tires!” I said “Tires?! 
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Ours?!” They smiled and shook their heads as if to call their captain an amateur… Okay, at that point I 

was. The tires were so hot you could smell them in the cockpit. My mind could not get over, from this 

point on, that this was something I had never experienced. Where’s your mom when you really need 

her? 

The flight down to Florida was an eternity. We cruised at 250 knots indicated, giving us about 315 knots 

of ground speed at 15,000 feet. The miles didn’t click by like I am use to them clicking by in a fighter jet 

at Mach 0.94. We were burning fuel at a rate of 40,000 pounds per hour or 130 pounds per mile, or one 

gallon every length of the fuselage. The vibration in the cockpit was mild, compared to down below and 

to the rear of the fuselage where it reminded me of that football game I had as a child where you turned 

it on and the players vibrated around the board. I felt like if I had plastic clips on my boots I could have 

vibrated to any spot in the fuselage I wanted to go without moving my legs… and the noise was 

deafening. The 747 flies with its nose 5° up in the air to stay level, and when you bank, it feels like the 

shuttle is trying to say “Hey, let’s roll completely over on our back.” Not a good thing, I kept telling 

myself. So I limited my bank angle to 15° and even though a 180° course change took a full zip code to 

complete, it was the safe way to turn this monster. 

Airliners and even a flight of two F–16s deviated from their flight plans to catch a glimpse of us along the 

way. We dodged what was in reality very few clouds and storms, despite what everyone thought, and 

arrived in Florida with 51,000 pounds of fuel too much to land with. We can’t land heavier than 600,000 

pounds total weight and so we had to do something with that fuel. I had an idea… Let’s fly low and slow 

and show this beast off to all the taxpayers in Florida lucky enough to be outside on that Tuesday 

afternoon. So at Ormond Beach we let down to 1,000 feet above the ground/water and flew just east of 

the beach out over the water. Then, once we reached the NASA airspace of the Kennedy Space Center, 

we cut over to the Banana/Indian Rivers and flew down the middle of them to show the people of 

Titusville, Port St. Johns and Melbourne just what a 747 with a shuttle on it looked like. We stayed at 

1,000 feet and since we were dragging our flaps at Flaps 5, our speed was down to around 190 to 210 

knots. We could see traffic stopping in the middle of roads to take a look. We heard later that a Little 

League Baseball game stopped to look and everyone cheered as we became their 7th inning stretch. Oh 

say can you see… 

After reaching Vero Beach, we turned north to follow the coast line back up to the Shuttle Landing 

Facility (SLF). There was not one person laying on the beach… They were all standing and waving! “What 

a sight,” I thought, and figured they were thinking the same thing. All this time I was bugging the 

engineers, all three of them, to re-compute our fuel and tell me when it was time to land. They kept 

saying “Not yet Triple, keep showing this thing off,” which was not a bad thing to be doing. However, all 

this time the thought that the landing, the muscling of this 600,000 pound beast, was getting closer and 

closer to my reality. I was pumped up! We got back to the SLF and were still 10,000 pounds too heavy to 

land so I said I was going to do a low approach over the SLF going the opposite direction of landing 

traffic that day. So at 300 feet, we flew down the runway, rocking our wings like a whale rolling on its 

side to say hello to the people looking on! One turn out of traffic and back to the runway to land… still 

3,000 pounds over gross weight limit. But the engineers agreed that if the landing were smooth, there 

would be no problem. “Oh thanks guys, a little extra pressure is just what I needed!” So we landed at 

603,000 pounds, and very smoothly if I have to say so myself. The landing was so totally controlled and 

on speed, that it was fun. There were a few surprises that I dealt with, like the 747 falls like a rock with 

the orbiter on it if you pull the throttles off at the “normal” point in a landing and secondly, if you 
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thought you could hold the nose off the ground after the mains touch down, think again… It is coming 

down!!! So I “flew it down” to the ground and saved what I have seen in videos of a nose slap after 

landing. Bob’s video supports this! 

Then I turned on my phone after coming to a full stop only to find 50 bazillion emails and phone 

messages from all of you who were so super to be watching and cheering us on! What a treat, I can’t 

thank y’all enough. For those who watched, you wondered why we sat there so long. Well, the shuttle 

had very hazardous chemicals on board and we had to be “sniffed” to determine if any had leaked or 

were leaking. They checked for Monomethylhydrazine (N2H4 for Charlie Hudson) and nitrogen tetroxide 

(N2O4). Even though we were “clean,” it took way too long for them to tow us in to the mate-demate 

area. Sorry for those who stuck it out and even waited until we exited the jet. 

I am sure I will wake up in the middle of the night here soon, screaming and standing straight up 

dripping wet with sweat from the realization of what had happened. It was a thrill of a lifetime. Again I 

want to thank everyone for your interest and support. It felt good to bring Atlantis home in one piece 

after she had worked so hard getting to the Hubble Space Telescope and back. 

—Triple Nickel, NASA Pilot 

To experience this in X-Plane, go to the Flight Configuration screen and select the Boeing 747–100. 

Click Customize and make sure Fly with piggybacking Space Shuttle is checked. 

Flying in Formations 
To try your hand at flying in formation with another aircraft, click the Customize button in the Location 

box of Flight Configuration. Click on Special Starts and pick Formation Flying from the list. X-Plane will 

load an AI-controlled version of the same aircraft you are using. Both aircraft will start the situation 

about 10,000 feet in the air, and from there you can follow the other aircraft as it maneuvers around. 

Mid-Air Refueling 
To try your hand at military mid-air refueling, select a fighter aircraft then click the Customize button in 

the Location box of Flight Configuration. Click on Special Starts and pick either the Refuel - 

Boom and Refuel - Basket to set your aircraft up in mid-air behind a tanker trailing a refueling boom or 

basket. Try to approach the tanker from slightly below or from the side in order to avoid the worst of its 

turbulence. From there you can line the fuel port on your aircraft up with the refueling system, then 

maintain the “air refueling envelope” formation to receive the fuel. Moving outside of this envelope can 

lead to mid-air collision. Unlike in the real world, in X-Plane there is no need to extend or retract the 

receiving aircraft’s fuel probe, so once you’ve finished refueling, simply fly away! 

Expert Essays: Unleashing the Full Potential of the Simulator 

Tuning the Handling of Aircraft in X-Plane 
If X-Plane is set up and flying, but aircraft seem to be too sensitive in pitch, or if they pull to one side, the 

simulator’s handling may need to be tuned. It is also vital to make sure the hardware itself isn’t 

malfunctioning first. 

Make sure the joystick and/or other control devices are set up and calibrated. See the section 

“Configuring Flight Controls” of the chapter Configuring and Tuning Your X-Plane Installation for 

instructions on doing this. 

https://www.x-plane.com/manuals/desktop/index.html#configuringflightcontrols
https://www.x-plane.com/manuals/desktop/index.html#configuringandtuningyourx-planeinstallation
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To easily see whether the controls are properly calibrated, we’ll first need to display their output. Go to 

the Settings screen and click Data Output. Find line 8 labeled joystick ail/elv/rud and check the first box 

to show the values in the cockpit. When you close the Settings window, you will see in the upper left 

corner of the screen the aileron, elevator, and rudder inputs from the flight controls (such as a joystick, 

yoke, rudders, etc.). 

With properly configured controls, the aileron, elevator, and rudder joystick inputs should all read 

around 0.0 when your flight controls are centered. When the controls are pushed full left and forward, 

they should read around –1.0. When the controls are pulled full aft and right, they should read around 

1.0. If this is what you see, then your controls are properly calibrated. If not, it’s no wonder the plane is 

not flying correctly! You need to configure the controls as described in the section “Configuring Flight 

Controls” of the chapter Configuring and Tuning Your X-Plane Installation. 

If the controls are indeed properly calibrated as per the above test, but the plane still is not flying 

correctly, it’s time to look at the first level of control response tuning. Go to the Settings screen and click 

Joystick. Click on the Calibrate button and follow the instructions to complete calibration. 

Once you have ensured the hardware is calibrated and functioning properly, try flying the plane once 

again. If it still does not handle correctly, read on to tune the next level of control response. 

Open the Joystick window again and click on the Control Sensitivity button. Look at the three sliders 

under the Control Response column (one each for pitch, roll, and yaw). 

If these three sliders are fully left, then the control response is linear; that is, a 50% stick deflection in 

the hardware will give 50% control deflection in the aircraft. Likewise, 100% stick deflection in the 

hardware will give 100% control deflection in the aircraft. 

If the problem being experienced is that the plane feels too responsive in the simulator, try dragging the 

sliders all the way to the right. This will give a non-linear response. Set this way, 0% hardware deflection 

will still give 0% control deflection in the simulator, and 100% hardware deflection will still give 100% 

control deflection. The difference lies in between—50% stick deflection in the hardware might only give 

15% control deflection in the simulator. In other words, while the hard-over roll rate in the simulator will 

remain unchanged no matter how these sliders are set, fine control will be increased for smaller, partial 

deflections, since the flight controls will move less for a small-to-moderate stick deflection in the 

hardware joystick or yoke. This will give a nice, fine pitch control and slow, detailed roll control. 

If, after changing the control response, the aircraft still does not fly as it should, the next level of control 

tuning is stability augmentation. If the plane still feels squirrelly or overly sensitive, go back to Joystick 

settings, open the Control Sensitivity window, and try dragging the three sliders in the right column 

labeled “Stability augmentation” all the way to the right. 

This will cause X-Plane to automatically counteract any stick input to some degree, resisting rapid or 

large deflections in pitch, heading, and roll. Basically, it is like always having an autopilot on that 

smooths things out. This is obviously very fake, but in the absence of a perfect flight control system, g-

load, and peripheral vision feedback, this can help smooth out the airplane’s flight characteristics. Try 

flying with those sliders at various places, bearing in mind that full left should be most realistic (with no 

artificial stability added). 

https://www.x-plane.com/manuals/desktop/index.html#configuringflightcontrols
https://www.x-plane.com/manuals/desktop/index.html#configuringflightcontrols
https://www.x-plane.com/manuals/desktop/index.html#configuringandtuningyourx-planeinstallation
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If, after doing all of the above, the aircraft still does not fly as it should, nothing more can be done within 

the simulator. It is now time to tweak the airplane model itself. In the real world, if a plane is pulling to 

one side or the other, a pilot will bend the little trim tab on the aileron one way or another. This bending 

of the aileron trim tab counteracts any imperfections in the shape of the airplane, the dynamics of the 

propwash, or the mass distribution inside the plane. The same thing can be done in X-Plane—you can 

bend a trim tab a bit one way or the other to make the plane fly true. 

To do this, exit X-Plane and open Plane Maker (included in the X-Plane installation). Go to the File menu 

and select Open. There, select the plane that is pulling left or right and load it using the Open button. 

Then, go to the Standard menu and click Control Geometry. In this window, select the Trim & Speed tab. 

Look at the far right-hand column of controls in the top half of the screen, labeled for aileron, elevator, 

and rudder trim tab adjust. This is a measure of how much the trim tabs are bent on each axis. A value 

of 0.000 in these boxes means that the trim tab is not bent at all. A value of 1.000 means the tab is bent 

so far that the control is fully deflected by the trim tab—this is way too far. Try bending the trim tab just 

a little bit—maybe set the value at 0.05 or at most 0.10. This would correspond to being enough force to 

deflect the controls 5% or 10%, respectively, due to the trim tab. A positive value corresponds to 

bending the trim tab up or right, depending on whether it is pitch, yaw, or roll. Thus, if the plane needs 

to roll right a bit more (or needs to stop rolling left), then enter a positive number for the aileron 

control. The same goes for the rudder: if the plane needs to pull right a bit more, enter a positive rudder 

trim tab adjust. If the plane needs to pull up a bit more, give it a positive elevator trim tab adjust. Tweak 

the trim tabs as needed, save the aircraft file (using Plane Maker’s File menu), and exit Plane Maker. 

Then, open up X-Plane and try flying the plane again. It should noticeably pull one way or another based 

on how the trim tabs were bent. The trim tab controls may need to be tuned again to get the plane to fly 

as straight as is desired. 

Setting Up a Copilot Station 
A copilot’s station is a second computer networked to the main simulator, set to view a portion of the 

cockpit intended for the copilot. To use a copilot’s station, you will first need two computers on the 

same network, each running their own copy of the most recent X-Plane update. 

You will need two copies of the aircraft file you intend to fly, both either created or modified using Plane 

Maker. The first copy of your aircraft should have the pilot-side instrument panel. If you are content 

with the default panel layout, any of the stock planes could be used. 

With the first version (the pilot-side version) of the plane ready, simply make a copy of the entire 

airplane folder and add some suffix, such as “copilot“ to the end of the folder’s name—for instance, if 

the aircraft you wanted to fly was in the folder ”Boeing 747“, you might name the copilot-side version 

”Boeing 747copilot”. 

Next, open the copilot-side copy of the aircraft in Plane Maker and tweak the instrument panel (as 

described in the chapter “Creating an Instrument Panel” of the Plane Maker manual) as desired for the 

co-pilot’s side of the craft. Save it when finished and close Plane Maker. 

There should now be two copies of the same aircraft folder, where each aircraft file within has its own 

instrument panel. These folders should have names like “[Plane name]” and “[Plane name]_copilot”. 

Both folders should be in the same place within your X-Plane directory. 

http://developer.x-plane.com/manuals/planemaker/#creatinganinstrumentpanel
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Simply copy that entire aircraft folder from one of the computers over to the other, putting the aircraft 

folder in the same directory (relative to the X-Plane installation directory) on the second computer. For 

example, the folder location might be ‘X-Plane 11/Aircraft/Extra Aircraft/Boeing 747/’ on the pilot’s 

computer and ‘X-Plane 11/Aircraft/Extra Aircraft/Boeing 747_copilot/’ on the copilot’s computer. With 

that done, open X-Plane on each computer and start a flight with the unmodified copy of the plane on 

both computers. From our example above, each computer will start a flight with the Boeing 747. Then 

open the Settings, and select Network. Expand the External Visuals section. From here, the procedure 

for the pilot’s and copilot’s machines differ slightly. 

On the pilot’s machine, leave the role set to Master. Click the Add External Visuals Machine 

(Independent View) button and select the other computer from the drop down list, if necessary. It 

should not be necessary to change the Port number. 

Set the copilot machine’s role to External Visuals. Pick the Pilot’s computer from the drop down under 

the “Master Machine” section, if necessary. Check the box Use aircraft from suffixed folder and enter 

the folder suffix you used before (copilot, in our example). After that, no matter what aircraft is opened 

on the pilot’s machine, this computer will add "copilot" to the name of the aircraft folder that it needs to 

open. 

If everything is set up correctly, the pilot’s machine will send all the appropriate data to the copilot’s 

machine, the copilot’s machine will get the message. The copilot’s machine will then apply the suffix 

“_copilot” to the name of the aircraft folder, and it will open the copilot’s version of the aircraft cockpit 

on the copilot’s machine. 

Configuring a Multi-Monitor Simulator 
There are two general ways of configuring multiple monitors. You can either have your monitors all 

connected to one computer, running one copy of X-Plane, or you can have multiple different computers 

all networked together, each one with its own monitor and its own copy of X-Plane. 

In general, using multiple displays on one computer will be more restrictive regarding the ways in which 

you can configure the simulator. Networking many computers together will be more flexible, but it will 

also be much more expensive. 

Driving Multiple Displays from One Computer 
If you are using only one copy of X-Plane on one computer with several monitors, you will be able to 

configure the view as 

one large display of one view or 

one view and one Instructor Operating Station. 

X-Plane only supports one type of view (3-D cockpit, forward with no scenery, etc) at a time per copy of 

X-Plane. 

Video 9.1: Configuring the monitor tutorial 

If your multiple monitors are configured as a single large display in your operating system, all you need 

to do to have X-Plane fill the screen with a single large window is go to Settings > Graphics > Monitor 

Configuration and change the drop down to “Full Screen Simulator.” If X-Plane is still only filling one 
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screen, you may need to pick “Custom” from the Resolution drop down, and change it to the combined 

size of all your monitors (for example, two 1920x1080 monitors should be entered as a custom 

resolution of 3840x1080). You will most likely want to adjust the “Lateral field of view” as well. 

If, on the other hand, your monitors are configured in the operating system as separate displays, the 

simplest option is to have a regular, windowed version of X-Plane which you manually resize to fill as 

much of your display as possible. 

If your monitors are separate displays and you also don’t want to have X-Plane windowed, in the 

Monitor Configuration box you will need to set each monitor to “Full Screen Simulator.” Then you will 

need to adjust the offsets in the Visual Offsets section. 

For a wrap-around, 3-monitor configuration: 

Left monitor: set the Lateral rotational offset to the negative of your main monitor’s Lateral field of view 

(FOV) 

Center monitor: no offset 

Right monitor: set the Lateral rotational offset equal to your main monitor’s (positive) Lateral FOV 

For a flat, 3-monitor configuration: 

Check the box to Enable flat (fractional) offsets 

Enter –2 for the left monitor’s offset 

The center monitor offset should be left at 0 

Enter +2 for the right monitor offset 

If you want to use your secondary monitor as an instructor operator station, refer to the section “Using 

an Instructor Operator Station (IOS) for Flight Training” of the chapter Special Situations in X-Plane. Note 

that the flight and IOS is the only configuration available for separate monitor views if you are using 

X-Plane on only one computer. If you would like your monitors to display completely different views 

than the IOS and the flight, or different offsets of the same view, you will need to have more than one 

computer and to follow the instructions in the next section. 

Also recall that in X-Plane 11 many of the windows, such as the GPS, map, and ATC windows, can be 

popped out as separate displays and moved to a secondary monitor. Simply click on the icon in the top 

right corner of the window then move it around independently. 

Networking Multiple Computers for Multiple Displays 
To set up a multi-computer simulator, each of the computers you want to use must first be linked 

together over a network. For the most reliable connection, join the computers together with Ethernet 

cables, or you can connect over a Wi-Fi network. The computers should form a simple LAN, configured 

as normal within Mac OS X or Windows, whatever the case may be. The most recent version of X-Plane 

should then be launched on each computer. 

Video 9.2: Configuring networking options, including external visuals 

https://www.x-plane.com/manuals/desktop/index.html#usinganinstructoroperatorstationiosforflighttraining
https://www.x-plane.com/manuals/desktop/index.html#usinganinstructoroperatorstationiosforflighttraining
https://www.x-plane.com/manuals/desktop/index.html#specialsituationsinx-plane
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On each computer, open the Settings and go to Network. In this screen, expand the “External Visuals” 

section. Here, the steps differ slightly between the “master” machine (the computer which is hooked up 

to all your flight controls) and the other computers. 

On the master machine, press the button for either Add External Visuals Machine, depending on 

whether you want the view locked to this machine or not. If needed, pick the machine you want to 

connect to from the drop down list. On the other machine(s), set the machine’s role to “External 

Visuals.” Expand the Master Machine section and pick the master computer from the drop down, if 

necessary. 

If the button for Independent Views was used, you can now set up each of the additional computers 

with a different view from the Master machine. It may be helpful to set up Quick Views according to the 

instructions in Using the Quick Look Feature to quickly return to your setup the next time you launch X-

Plane. 

For a complex set up with four computers and four monitors, or one cockpit and three external 

visuals, and with the view locked to the master computer, you’ll need to adjust the view offsets to 

accommodate a wrap-around view. On each of the three computers used for external visuals, we need 

to open the Rendering Options dialog box from the Settings menu. There, we will enter a lateral field of 

view of 45° for each of them. Enter a lateral offset for networked scenery of –45° for the left screen, 0° 

for the center screen, and 45° for the right screen, with no vertical offset on all screens. This will simply 

yield a 135° (45° × 3) field of view. If this is drawn out on paper, it becomes apparent that the 45° offsets 

on the left and right screens will cause them to perfectly sync up with the center screen. 

From there, the monitors need to physically be moved around the “cockpit” (that is, where a user will sit 

when flying the simulator) in a semi-circle describing a 135° field of view. If this is not done, then the 

horizon will not appear straight as the craft pitches and rolls, caused by the “fisheye lens” effect. If a 

135° field of view is described in a flat plane or in an arc of monitors that describe less than 135° of arc, 

fisheye distortion will result, apparent as a horizon that seems to bend and distort between monitors. 

Lining Up the Horizon (Without Vertical Offsets) 
Now, sometimes people sit on the ground and see the horizon does not line up, so they enter vertical 

offsets on some of the display machines only in order to get the horizons to line up. They quickly 

become confused when everything breaks down as they pitch and especially roll. If vertical offsets are 

used, they must be used on all networked machines in your simulator, unless you have one monitor 

physically above another. If some but not all of your computers have vertical offsets, things start getting 

messed up. What often happens is that a user will fly with a cockpit in the center screen, which shifts 

the center of that screen as far as scenery is concerned to be around 75% of the way up the monitor; 

this is done in order to leave room for the instruments. The external visuals, on the other hand, have 

screen centers in the center of the monitor, since they do not have to reserve space for the instrument 

panel. In this case, you need to do the following: 

Open Plane Maker from the X-Plane installation directory. 

Click on the File menu, then click Open Aircraft. 

Navigate to the aircraft you wish to fly and open it. 

https://www.x-plane.com/manuals/desktop/index.html#usingthequicklookfeature
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Click on the Standard menu, then click Viewpoint. 

In the Viewpoint dialog box, go to the View tab. 

In the Screen-Centers box, set the view center Y, panel view (i.e., the y coordinate of the center of the 

screen when in the panel view) to be one-half the height of your monitor in pixels (assuming you run 

X-Plane in full screen mode). For instance, if your monitor has a resolution of 1920×1080 pixels, you 

would enter 540 here (being 1080/2). 

Close the Viewpoint dialog box, either by pressing Enter or by clicking an X in the corner of the window. 

Open the File menu and click Save As (not Save, since you do not want to overwrite the original file). 

Type in a name for this copy of the aircraft file (for instance, “Triple Monitor [aircraft name]”) and 

press Save. 

Close Plane Maker. 

Now, when you load the new copy of the aircraft up in X-Plane, the screen center will be just where you 

like it. 

Correcting for Monitor Bezels 
When using more than one monitor to fly in X-Plane, you must account for the monitor bezels (the 

frame around each monitor), or the displays will not line up seamlessly. If you’re flying an airplane with 

a 3D cockpit and using two monitors, an acceptable solution may be to move your point of view a little 

to the left to get the bezel out of the way of the runway. An alternative, or for planes with only a 2D 

panel, experiment with putting a small lateral offset in the rendering options. The example below 

describes how to do this with three monitors. 

Let’s imagine that you have three networked computers for additional visuals to form a wrap-around 

cockpit. Each computer might have a 45° lateral field of view (as set in the Graphics settings). You would 

enter a lateral offset for networked scenery of –45° for the left visual, 0° for the front visual, and 45° for 

the right visual, as discussed above. If each display has a field of view of 45°, these images would blend 

together seamlessly if you didn’t consider the width of the displays’ bezels. If you cannot set up the 

monitors to run their effective image all the way to the edge (as you can with some, even though you 

wouldn’t be able to see the part under the border), you might instead try a field of view of maybe 43° 

based on whatever fraction of the monitor is visible. Vertical and roll offsets, of course, are the up/down 

and tilt equivalents of the lateral offset. 

Note: While the view offsets do indicate how much to the left or right or up or down each view is 

looking, people make the same mistake over and over: they run a center view with a cockpit in the 

center screen, and external visuals on the left and right—which is fine—but they notice that the horizon 

in the center (cockpit) screen does not line up with the horizons on either side. The reason for this is 

that the center-point of the screen where the horizon rests in a level flight attitude is up near the top of 

the screen in the cockpit view (to make room for the instrument panel) and the center of the screen for 

the external visuals (which do not need room at the bottom for the instrument panel). Often, people will 

incorrectly lower the vertical offset of the center panel (with the cockpit). 
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This results in countless problems with the views not lining up. The way to correct this is to do as in the 

“Lining Up the Horizon (Without Vertical Offsets)” section above and change the screen center for your 

aircraft; only then will the horizon always line up across all the visuals. In other words, the only time a 

vertical offset should be used is if there is one monitor on top of another. 

Using Other Special Viewing Controls 
The lateral field of view setting, located in the Monitor Configuration window of Graphics settings, will 

change the way X-Plane displays the view of the outside world. Higher settings will allow more of the 

terrain to be viewed at any one time, but will reduce performance. Higher settings will also increase the 

“fish eye” effect of the simulator. The default value is 60° per display, which generally gives good 

performance and a natural view. Note, of course, that changing the field of view of a monitor in a multi-

display setup will require you to re-evaluate your lateral offset values as well. 

Now, suppose you are using multiple monitors, some for external visuals and others for cockpit displays. 

You may notice that when views are changed within X-Plane, the change propagates to all the visuals. To 

stop this from occurring, use the Add External Visuals Machine (Independent View) when setting up 

additional computers. You can also check the Lock view to default box under the “visuals settings” 

section of Monitor Configuration to prevent the view from being changed by any means. 

Networked Multiplayer 
Multiplayer allows you to fly with up to 19 other people. You can race, fly in formation, dogfight and 

more in this mode. To use X-Plane 11’s built-in networked multiplayer, you will first need all the 

computers on the same network, each running their own copy of the most recent X-Plane update. 

Video 9.3: Configuring networking options, including multiplayer 

Set up multiplayer by going to the Settings window, then the Network tab. Leave the machine’s role set 

to “Master” and expand the “Multiplayer” section in the list on the right. Click the blue Add Multiplayer 

Machine button, then either find the other machine’s name in the drop down box, or manually enter its 

IP address. Changing the port number should not be necessary. Increasing the rate of the Transmissions 

per second slider can be useful if you notice lagging or stuttering in the other players’ planes. 

When you return to your flight you will see the other aircraft and will be able to chat with the other 

players by using the enter key. 

Using X-Plane with Mobile Apps 
There are numerous apps available that can enhance flying in X-Plane, including those such as 

ForeFlight, FlyQ, Aerovie, Garmin Pilot, or even Laminar Research’s own Control Pad and Xavion. As long 

as the device is running on the same local network as the computer running X-Plane, you can set up 

their connection in the Network tab of the Settings screen. 

Video 9.4: Configuring networking options, including external apps 

Expand the iPhone & iPad section of the list on the right side of the screen. Apps that use AHRS and ADS-

B data can be added by clicking on the Add Connection to Xavion or FlyQ button and either manually 

entering the IP address or finding the device name in the drop down (if necessary). These devices use 

fixed port numbers so it will not be necessary to change the port number field. 

https://www.x-plane.com/manuals/desktop/index.html#liningupthehorizonwithoutverticaloffsets
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If you are using other apps that use just AHRS data, under the “Third-party apps” section, check one of 

the boxes to broadcast to either a single device (if you are only using one tablet, phone or app) or all 

devices if you are using more than one. 

If you are using Control Pad, a Laminar Research app that functions as a mobile instructor operating 

station (IOS), check the last box and either manually enter the IP address or find the device name in the 

drop down (if necessary). Again, it will not be necessary to change the port number. 

If you are using an app that sends and receives UDP data, expand the “UDP Ports” section to see the 

default port numbers, or to edit them. 

Serial Port Flight Instruments Set Up 
If you have flight instruments or other hardware you plug into a serial port, you can send datarefs from 

X-Plane to the serial port to drive them. To do this, first go to the Data Output section of Settings and 

click on Dataref Read/Write. Check the box next to A COM port, then select the com-port number and 

enter the baud rate in the lower-right. 

Now you can choose any number of datarefs from the list on the left to write or read from the serial 

port. They will show up on the right. If you selected a dataref that contains an array of data (like 

sim/cockpit/engine/fuel_pump_on, for example), then you simply select the array index you want from 

the field there. 

Projector Setup for X-Plane Professional 
The X-Plane Professional-Use USB Key or Professional-Use Digital Download product key enables 

sending imagery to a projector to make wrap-around visuals for professional displays. To set up 

projection, go to the Developer menu and toggle “Show Projection Parameters.” In this window are 

three tabs that allow customization of the projection, Ren Opts (Rendering Options), Grid Adjust, and 

Edge Blend. The Cylinder Projection box in the first tab should be checked to optimize projections onto 

curved surfaces instead of flat. Grid Adjust has options for test images that can help customize the warp 

of the projection. Edge-blending lets you adjust the edge darkness, or fade-out, near the left and right 

sides of the screen to help you overlap projectors. 

Kiosk Mode 
Starting in X-Plane 11.10 and newer, you can enable “kiosk mode” from within the General section of 

the Settings screen. This option is useful when you don’t want others modifying sim settings, especially 

when the sim is used at trade shows or by schools. 

 

Figure 9.1: Kiosk Mode available in X-Plane 11.10 outlined in orange 
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When kiosk mode is active, no preference changes are allowed at all. This includes everything in 

Settings, but it also means that X-Plane won’t save things like your aircraft, last-known location, etc. 

across restarts of this sim. 

To enable kiosk mode, check the “Enable kiosk mode and prevent settings changes” box, then enter a 

password. To turn off kiosk mode, enter the settings screen and type this same password into the box 

next to the Exit Kiosk Mode button. 

Data Input and Output from X-Plane 
X-Plane is a powerful source of data and much of it is handled using the Data Output screen (found in 

the Settings window). The General Data Output button controls where the data will be output. 

 

Figure 10.1: The Data Output section of Settings 

Each field has four checkboxes corresponding to the four places the data can be sent, as shown in Figure 

10.1. They are: Show in cockpit, Disk (data.txt file), Data Graph Window, and Network via UDP. Checking 

the Disk option will send output to the data.txt file located in the main X-Plane folder. Data Graph 

Window options will display in the Data Output Graph, which is accessed under the Developer menu (or 

Ctrl + g by default). 
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Data selected to display in the Data Graph Window is displayed in a graph with different colors for each 

variable and can be zoomed in or out using the sliders in the bottom right corner of the screen. 

For detailed examples on how to set up a plugin using data input & output, see the document “Sending 

Data to X-Plane.rtd” found in the Instructions folder. 

Data Output Table 
Please see this webpage for a table of all the fields present in the X-Plane Data Output screen. 

Troubleshooting X-Plane 
This chapter is designed as a reference for when you encounter common problems in X-Plane. Each of 

the following sections describes a common problem and its solution. As a general rule of thumb, 

however, the first thing you should do after encountering any problems is update to the latest version 

per the section “Updating X-Plane.” If you are running the latest version and still have problems, you can 

check for problem files by manually downloading and running the latest installer found on the X-Plane 

website. Select “Update X-Plane,” pick which copy you’d like to update, and click the “continue” button. 

The installer will scan your installation to see if any of the default files are missing or altered, and allow 

you to restore them. 

Water World, or “Help, there’s water everywhere!” 
When scenery is not installed for a given location, all that will be visible are airports and water. This is 

referred to as “water world,” and is a common problem, especially when using older installers. 

To avoid water world, either install the scenery for the location in which you’re flying, or choose to fly 

somewhere else. To install scenery, run the installer and pick Add or Remove Scenery. You will need to 

have DVD disc 1 inserted, or possibly enter your digital download product key for authorization. 

If scenery for the location is in fact installed, be sure that the copy of X-Plane for which it is installed is 

the one being used—for instance, if you have two copies of X-Plane installed (say, one running a demo 

version and one running 11.00), the two versions may have different amounts of scenery installed. 

http://www.x-plane.com/?article=data-set-output-table
https://www.x-plane.com/manuals/desktop/index.html#updatingx-plane
http://www.x-plane.com/downloads/x-plane_10_installer-updater/
http://www.x-plane.com/downloads/x-plane_10_installer-updater/
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The X-Plane Installer Fails to Extract a File 
If the X-Plane installer gives an error about a failed file extraction, or input/output error, it is almost 

always because your DVD drive cannot read the disc. Take note of the file reported in the error message 

and try to copy it from the DVD (using the Finder in Mac OS or Windows Explorer on Windows). If 

possible, try copying the file into a different folder. If multiple DVDs cannot be read, it is likely that your 

DVD drive is to blame. If, however, only a single DVD is causing problems, it is more likely the DVD is 

defective. Defective discs can be replaced for a small charge. Email our tech support at info@x-

plane.com for more information. 

X-Plane Gives Errors about Missing DLLs, or There Are Strange Graphical Anomalies 
Most graphics- and DLL-related issues in X-Plane are due to a lack of video drivers. Make sure your 

graphics drivers are up to date by following the instructions in the X-Plane Knowledge Base article 

entitled Updating the Computer’s Graphics Drivers in Windows. 

X-Plane Crashed 
A hard crash in X-Plane can be caused by a multitude of factors, so isolating a fix for every specific crash 

is outside the scope of this manual. If the automatic crash reporter comes up, be sure to send the report 

so Laminar Research has the data on your crash. 

In general, a good place to start for almost any problem with X-Plane is running the installer to update 

the program. Even if you are running the latest version of the simulator, the Installer/Updater can find 

missing or accidentally modified files and replace them with the correct default files. See the section 

“Updating X-Plane” for step by step instructions on how to check for and update to the latest version of 

X-Plane. 

If you are running the latest version of the simulator and still have problems, another good place to look 

is at the preferences. Move the preferences folder (found in the Output folder) to the desktop, then 

restart X-Plane and default preferences will be restored. If the default preferences do not fix your 

problem, you can simply replace them with the folder you moved to the desktop and restore your 

personalized settings. 

The final common culprit is third party add ons, such as scenery and plugins. Try moving the Custom 

Scenery folder and plugins folder (found in the Resources folder) to the desktop, then restart X-Plane. 

Starting in Safe Mode 
If X-Plane detects that it crashed the last time it was run, then on the next start, you have an option to 

reset the rendering settings. If you reset the settings, you might avoid a crash on startup if the rendering 

settings were the cause of the initial crash. You may bring up the option to enter safe mode only if you 

start the sim with the shift key pressed down. 

My Joystick or Yoke Isn’t Working 
If the joystick and other flight controls appear to be configured correctly according to the steps outlined 

in the the section Configuring Flight Controls of the chapter Configuring and Tuning Your X-Plane 

Installation but are not giving the desired response in the simulator, it’s time to troubleshoot. 

Thankfully, X-Plane makes it easy to find out how the software is perceiving the flight controls’ input. 

mailto:info@x-plane.com
mailto:info@x-plane.com
http://www.x-plane.com/?article=updating-graphics-drivers
https://www.x-plane.com/manuals/desktop/index.html#updatingx-plane
https://www.x-plane.com/manuals/desktop/index.html#configuringflightcontrols
https://www.x-plane.com/manuals/desktop/index.html#configuringandtuningyourx-planeinstallation
https://www.x-plane.com/manuals/desktop/index.html#configuringandtuningyourx-planeinstallation
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In the following example we’ll assume that the plane’s pitch, yaw, and roll are not matching the way the 

joystick is being moved. A similar procedure may be used for other malfunctioning controls. 

Move your mouse to the top of the screen and open the Settings. 

Click Data Output. 

Select the first box on line 8 joystick aileron/elvator/rudder. This box will cause X-Plane to display the 

input it is receiving while running the simulation. 

Close the window. 

A box in the upper left should be displaying the elev, ailrn, and ruddr commands (elevator, aileron, 

rudder, respectively) being received from the joystick. 

Now, center the stick and pedals. Each axis should indicate 0.0, or close to it. 

Move the stick full left. The ailrn should indicate –1.0 or near –1.0. 

Move the stick full right. The ailrn should indicate 1.0 or near 1.0. 

Move the stick full aft. The elev should indicate 1.0 or near 1.0. 

Move the stick full forward. The elev should indicate –1.0 or near –1.0. 

Move the rudder full left. The ruddr should indicate –1.0 or near –1.0. 

Move the rudder full right. The ruddr should indicate 1.0 or near 1.0. 

By moving the stick and pedals and seeing what values they are sending X-Plane, you can see if X-Plane 

is getting proper stick input. 

If the correct values (according to the tests above) are not being received in X-Plane, and you have 

calibrated the controls in X-Plane per the section “Calibrating the Hardware” of the chapter Configuring 

and Tuning Your X-Plane Installation, then the next step is to look at the first level of control response 

tuning. 

Go to the Settings and click Joystick. In that dialog box, select the Axis tab. Click the button 

labeled Calibrate. Follow the directions to calibrate the controls. Go back to the cockpit and check to see 

if the data output (which should still be on the screen from the pre-test in the above instructions) is 

around 0.000 when the controls are centered. If it is, then the hardware works fine and the center point 

was set successfully. 

The last step to solving the issue is checking the hardware’s calibration in your operating system, not 

X-Plane. Finally, if you have done all of the above steps and still have problems, then the hardware itself 

is malfunctioning. 

Note: If your frame rate is below 20 frames per second (which you can confirm by checking the box 

labeled frame rate in the Data Input & Output window, just like you did with the joystick 

ail/elv/rud box), X-Plane may behave erratically regardless of your joystick settings. See the section 

“Increasing the Frame Rate” of the chapter Configuring and Tuning Your X-Plane Installation for help 

improving your frame rate. 

https://www.x-plane.com/manuals/desktop/index.html#calibratingthehardware
https://www.x-plane.com/manuals/desktop/index.html#configuringandtuningyourx-planeinstallation
https://www.x-plane.com/manuals/desktop/index.html#configuringandtuningyourx-planeinstallation
https://www.x-plane.com/manuals/desktop/index.html#increasingtheframerate
https://www.x-plane.com/manuals/desktop/index.html#configuringandtuningyourx-planeinstallation
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My Frame Rate is Low 
If your frame rate is low, or the simulator seems to “stutter” or move in slow motion, most likely your 

rendering settings are set too high for your system. Make sure your computer meets the minimum 

system requirements to run X-Plane 11, then review the section “Configuring the Rendering Options” for 

a step by step guide to adjusting the rendering options. 

Many of the most common problems people encounter with X-Plane is due to low frame rate and 

rendering settings which are set to high for the system. 

Airplanes Flutter and Crash in the Simulator 
The tendency for some aircraft to flutter and crash is a known limitation. Just as a car can only go a 

certain speed with a given horsepower, the X-Plane simulator can only accurately model flight at a 

certain speed with a given frame rate. 

If the frame rate gets too low for the flight model to handle, then the plane is likely to start oscillating 

quickly back and forth (referred to as “simulator flutter,” often occurring with autopilot on) as the flight 

model tries unsuccessfully to predict what the plane will do next. At this point, the computer is running 

too slowly to take small enough steps in the flight model to see what the plane will really do at each 

moment. Smaller and more maneuverable planes will accelerate more quickly, and greater accelerations 

require a higher frame rate to simulate. 

This occurs due to the way that X-Plane moves aircraft within the simulation. X-Plane calculates the 

acceleration of the craft for each frame, then adds up the acceleration between frames to move the 

plane. This works fine if the frame rate is reasonably high and the accelerations are reasonable low. In 

fact, for any reasonably normal aircraft that has reasonably normal accelerations, a frame rate of 20 fps 

or more is fine. 

Problems occur, though, when you have very light aircraft with very large wings going very fast, or 

sitting on the ground with landing gear spread very far out from the center of gravity. All of these things 

add up to the same result—high acceleration. 

X-Plane, of course, can handle these high accelerations, but it needs a high frame rate to do it. For the 

flight model to work, there can only be a certain amount of velocity change per frame of the simulation. 

If the accelerations are high, then the frame rate better be high so that there is a reasonable velocity 

change (i.e., acceleration) per frame. 

To determine how high a frame rate is enough to handle a given acceleration, just find the frame rate at 

which there is no flutter. 

For example, imagine a Boeing 747 at approach speed. It slowly lumbers along, hardly accelerating at all. 

One frame per second could track that flight accurately. Now imagine holding a paper airplane out the 

window of a car at 80 miles per hour and letting go. The plane doesn’t smoothly, gradually, accelerate 

up to speed, it disintegrates in a thousandth of a second! To simulate that may require a simulator to 

run at one thousand frames per second! 

So, while a simple 20 frames per second works fine for most any aircraft, when small, light, big-winged 

craft with widely spaced landing gear designs start flying fast, the accelerations come up enough that in 

extreme cases, 100 fps might be needed to model accurately. 

https://www.x-plane.com/manuals/desktop/index.html#configuringtherenderingoptions
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This is more of a problem with planes that: 

are small because they maneuver much more quickly than big planes, 

are light because they have less inertia and react faster, 

have long wings because they have more leverage on the center of gravity, thus reacting faster, 

have big wings because they get more lift, thus reacting faster, or 

have widely spaced landing gear because the gear has more leverage on the craft, causing it to torque 

the plane faster. 

When using an airplane that reacts extremely quickly to the environment, the computer needs to react 

just as quickly to simulate it. This can be achieved by reducing the rendering options and visibility in 

X-Plane enough to raise the frame rate to a non-fluttering level. More info on this can be found in the 

section “Configuring the Rendering Options.” 

The Simulator’s Measurement of Time is Slow 
If the simulator’s measurement of time is incorrect (e.g., the “elapsed time” field has a value less than it 

should), check your frame rate. If your computer cannot maintain 20 frames per second, simulator time 

will not match real time; when X-Plane runs slower than 20 fps, it slows down its simulation of real-time 

so that the simulator is “effectively” running at 20 fps. For instance, if the simulator is running at 10 fps 

due to extreme rendering settings, X-Plane will run the flight model at half speed. The result is that the 

physics are integrating in slow-motion in order to avoid destabilizing from the low framerate. Thus, if 

you need real-time simulation, you must run the simulator at 20 fps or faster. 

My PC Freezes after Running X-Plane a While 
When a computer freezes after running X-Plane for a while, the problem is almost always heat related. 

When the system is running X-Plane, the video card and processor get very hot because they are running 

at 100% utilization. This causes the temperature to rise inside the case. To eliminate heat as an issue, 

remove the computer’s cover and aim a fan into the case. Run X-Plane for a while and see if the problem 

goes away. If it does, then you need to add some additional cooling. 

Note that this assumes that the system has enough RAM. Running out of RAM will cause crashes as well. 

(See the current X-Plane 11 system requirements here.) This also assumes that the computer is not 

overclocked. 

Problems with Digital Download 
The X-Plane Digital Download product key is a long, unique series of numbers and letters that identifies 

your copy of X-Plane 11, allows you to download X-Plane directly to your computer over the internet, 

and allows you to run X-Plane without a DVD. 

When you buy a digital copy of X-Plane from Laminar Research or another company, you receive a 24-

digit code (your digital download product key). The code consists of numbers and capital letters; the 

letters i and o and the numbers 0 and 1 are never used, to avoid confusion. 

https://www.x-plane.com/manuals/desktop/index.html#configuringtherenderingoptions
https://www.x-plane.com/kb/x-plane-11-system-requirements/
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A Digital Download Product Key Is Like a Credit Card Number 
Your purchase of the digital download version of X-Plane provides you with one product key that is like a 

credit card number. Product keys do not have passwords associated with them; like a credit card 

number, if someone else has your digital download product key, that user has access to your copy of 

X-Plane. Just like credit cards, you should not share your digital download product key with anyone else. 

If you have to contact Laminar Research customer support, we will only require the last eight digits of 

your digital download product key; you do not need to send your full digital download product key 

to anyone, including Laminar Research. 

If someone manages to steal your digital download product key, piracy is prevented by fraud detection; 

our servers will see your digital download product key being used in a pattern that looks like multiple 

people (e.g. your product key used from two continents at the same time) and it will be locked. You can 

contact X-Plane customer support to receive a new, unlocked digital download product key, and your 

old one will be discarded. 

The Digital Download Version of X-Plane Requires an Internet Connection to Run 
In order for X-Plane to work outside of demo mode with a digital download product key, the computer 

running X-Plane must have an internet connection to contact our servers. X-Plane does not require an 

internet connection to re-validate on every single application launch, but it does require authentication 

frequently. If your internet service is unreliable or extremely slow, you may prefer to purchase and use 

the X-Plane DVDs. 

Note that when you authorize X-Plane using a product key, Laminar Research collects your computer’s 

IP address. We use this information only to verify your product key has not been stolen. We do not sell 

or share this information with anyone else. 

A Digital Copy of X-Plane Is Not A Backup 
The digital version of X-Plane is available online at any time for download, but it is not a replacement for 

a good backup of your computers! Only a true backup can save your preferences, third party aircraft 

you’ve downloaded, your log book, etc. 

The only version of X-Plane that is available digitally is the latest non-beta version of X-Plane. If you do 

not want to update to the latest version, you need to make your own backup of X-Plane; re-installing the 

product will get the latest version. 

For additional information, see the Knowledge Base article “X-Plane Digital Download.” 

Getting Help with Other Problems 
If your issues do not match those above, first search for a solution on the X-Plane Q & A site. You can 

also ask your question there if it has not been covered already. Questions are answered by Laminar 

Research team members and knowledgeable community members. The site also features commenting, 

voting, notifications, points and rankings. 

There is one more option you should try before contacting tech support: resetting the preferences. 

Open the X-Plane folder, double click on the “Output” folder and locate the preferences folder within. 

Move the entire preferences folder to the desktop. When you restart X-Plane it will restore the default 

http://www.x-plane.com/?post_type=article&p=9956
http://questions.x-plane.com/
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preferences and settings. If this does not fix your problem, you can simply replace this new folder with 

the one you moved to the desktop and restore your personalized settings. 

Tech Support 
Before calling or emailing, save both yourself and customer service time by checking this manual, the X-

Plane Knowledge Base, or the X-Plane Q & A site for answers. Be sure you have the latest version of the 

software you’re using before calling. (You can check this by following the instructions found in the 

section “Updating X-Plane” of the chapter Configuring and Tuning Your X-Plane Installation.) 

To contact customer service, email info@x-plane.com. 

If your problem involves a system crash, please include the following in your email: 

The “log.txt” file after encountering your error (also found in your X-Plane directory). 

The Apple crash log (if you are using a Mac). 

For questions regarding your order status from X-Plane.com, email our shipping department 

at xplaneorders@gmail.com. 

How to File a Bug Report 
When sending a bug report, please include as much information as possible—anything that the X-Plane 

development crew might need to know in order to reproduce the malfunction. This includes (but is not 

limited to) the following information: 

The software in question (X-Plane, Plane Maker, etc.) 

The operating system being used 

The version of X-Plane in question 

The hardware in use (if the issue only occurs when using certain hardware) 

A copy of the scenery or aircraft with the issue 

A copy of the log.txt 

A copy of the Apple Crash Report (Mac users can find this in (your Home 

directory)/Library/Logs/DiagnosticReports/) 

The exact steps (as specific and step-by-step as possible) required to reproduce the problem 

Additionally, before filing a bug report, please: 

Be sure you are using the latest version of X-Plane (this includes making sure you aren’t using an 

outdated shortcut). 

Delete (or move) your preferences file in order to rule that out. 

Disable any plug-ins or third-party add-ons. (Please report bugs in third-party add ons to the add on 

developer, not the X-Plane team.) 

Be sure you understand the feature you are reporting a bug on. 

http://www.x-plane.com/support/kb/
http://www.x-plane.com/support/kb/
http://questions.x-plane.com/
https://www.x-plane.com/manuals/desktop/index.html#updatingx-plane
https://www.x-plane.com/manuals/desktop/index.html#configuringandtuningyourx-planeinstallation
mailto:info@x-plane.com
mailto:xplaneorders@gmail.com
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Ask on the X-Plane Q & A site if you are not sure whether you have a bug or a tech support problem. 

To file a bug report, please use the X-Plane Bug Reporter. Make sure to attach a ‘log.txt’ file from 

X-Plane (or the installer or other X-Application) when filing the report, as well as PNG screenshots for 

any visual problems. The ‘log.txt’ file will tell us a lot of information about your system that will speed up 

bug analysis. 

Please note that, if the report was filed correctly, most likely you will not receive any feedback on it. The 

report will be saved and looked into, and, depending on its priority, fixed in a future update. 

Very often, people will report a bug like, “My speed indicator does not work.” Well, I might crash my 

Corvette into a tree, pick up my cell phone as the airbag deflates in my lap, call General Motors, and say, 

“My speed thing indicates zero!” 

In a case like that, how good a job can GM do in deciphering that report? 

Filing a report with X-Plane saying “My speed indicator does not work” can be that incomplete for two 

reasons. The first is that with about 20 or 30 instruments available in the X-Plane world (accessible via 

Plane Maker) that indicate speed, saying “speed Indicator” does not really isolate what instrument is 

being discussed. The second reason is that you have not really given a checklist of steps that you took to 

find yourself with the apparent bug. For example, it may take certain conditions for the airspeed 

indicator to not work, conditions you may cause without thinking about based on your airplane 

selection, weather, etc. 

In the Corvette analogy above, the proper report to GM would be: 

I got in my car. 

I hit the starter button, the engine started, and I put the transmission in first gear. 

I hit the gas and turned the wheel and drove until I hit a tree, which stopped me. 

The speedometer in the instrument panel indicated zero. 

I included a picture I took on my digital camera here, showing both the speedometer indicating zero and 

the car actually stopped. 

In the X-Plane world, a proper checklist for the report would look like this: 

I renamed my preferences file so I did not have any odd settings that may cause this that we might not 

know about. 

I fired up X-Plane on my computer running [some operating system]. 

I went to the File menu and opened the “Austin’s Personal Transport” aircraft. 

I noticed the EFIS airspeed indicator stayed at zero, no matter how fast I flew. 

I included a screenshot of X-Plane showing the panel here, with the actual speed of the plane shown 

using the Data Output screen to show my real speed. 

http://questions.x-plane.com/
http://dev.x-plane.com/support/bugreport.html
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The difference between the five-lined report above and the one-liner at the top is that you have actually 

told us what you are doing. You are starting by resetting the preferences so that we can do the same as 

you (a first step toward solving the problem!). You are telling us what aircraft you are opening (so we 

can do the same). You are choosing one of the planes that come with X-Plane (so we can do the same as 

you), and you are listing which of X-Plane’s dozens of speed indicators you are referring to, so we can 

see what the problem really is. 

To summarize, be sure to give a complete checklist to duplicate the issue, starting with deleting the 

preferences and choosing an airplane that comes with X-Plane so that we can go through the same steps 

as you. Err on the side of sending too much information, rather than too little! We must be able to 

mirror your actions, step by step, to duplicate the bug on our computers, as this is the first step to 

solving the problem. 

Another common mistake, though, is to say something like, “I flip a switch and hit a button and an 

indicator goes to 56%.” The problem with this is that it doesn’t tell us what the issue actually is. What do 

you think the indicator should go to? And, above all, prove it. 

In almost all filed bug reports, the report lacks any sort of proof that the value being cited as wrong is 

actually wrong. Since we sometimes get reports from people that think a Cessna cannot roll, an airliner 

cannot take off without flaps, or a helicopter cannot turn without pulling collective (all incorrect 

assumptions on the part of the “bug” reporter). We need proof that a characteristic that is claimed to be 

wrong actually is. Segments of pilot’s operating handbooks are typically just fine. 

So, be sure to include proof that a characteristic of the simulator is wrong if you believe it to be so. 

Another very common error is for people to install plug-ins that modify data in the simulator, third-party 

scenery packages that don’t quite follow the standards, or third-party airplanes that may have 

problems, and then report it as a “bug” when something does not work correctly. 

We won’t be able to duplicate the problem if it is due to third-party modifications. So, be sure that 

starting from a freshly installed copy of X-Plane with the preferences (and any plug-ins) removed is the 

first item in your step-by-step walkthrough for recreating the problem. Build up from there as needed, 

including each step in the checklist so that we can go through it and see the same thing you see. Use 

only scenery and planes that come with X-Plane if possible, so that we can duplicate the bug. 

Once again, be sure to: 

Use a checklist to explain what you are doing, starting with renaming the preferences and removing add 

ons. 

Include every step in the checklist that you send in your bug report. 

Use proper terminology. If you do not know the name of an instrument, then go into Plane Maker and 

click on it with the mouse. The X-Plane instrument name will be displayed at right. Alternatively, you can 

get the real name of the instrument by turning on the instrument instructions option (by going to the 

Settings screen, clicking General, and checking the Show instrument instructions in the cockpit box). 

Explain why you think the result you are seeing is wrong. Provide proof if you think the simulator is not 

doing what the real plane would do. 
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Remember, a bad report would say, “The pressure gauge does not work.” (Which pressure gauge? Why 

do you think it does not work? What do you expect it to show? What plane are you even flying?) 

A good report would say, “On a Mac running OS X Lion, I renamed the preferences and opened [an 

aircraft included with X-Plane] via the File menu, then I set the controls as follows, then I observed the 

manifold pressure gauge to indicate manifold pressure of zero as I advanced the power, though in the 

real plane I would get 25” of manifold pressure in this plane, as I know from the following excerpt from 

the plane’s pilot’s operating handbook." 

That report indicates what type of computer you are using, what you do to get the problem (in a way 

that lets us perfectly mirror it), what you think the problem is, and it gives proof that what you believe 

about the plane is in fact true. That is enough info for us to work with! 

Also, be sure to send the ‘log.txt’ file! This lists what type of computer you have. Hardly anyone even 

thinks to mention whether they are on Mac, Windows, or Linux! 

Glossary of Terms 
Working with the Program Itself 

Download: To download something means to get files from some remote server on the Internet and 

receive those files on your computer. Users can download lots of airplanes and scenery packages for 

X-Plane from the Internet. Downloading is receiving files from the Internet; it is not the same as 

installing those files. 

Install: To install something is to move a copy of the software onto your computer so that it can be run. 

When you get a DVD with X-Plane on it, you run the installer to install the program from the DVD—this 

is not downloading the program. It is installing it. You would only be downloading the program if the 

files were coming from the Internet (though once such files were downloaded, you would install them to 

have them ready for use). 

Update: To update a piece of software is to convert it to a newer version. This should be done every 

couple months or so in order to take advantage of new features in the simulator. To update in X-Plane, a 

user first downloads and then installs a newer version. The updater program (available for free at X-

Plane.com) does both of these things for you very easily. 

Controls in an Aircraft 

Anti-torque pedals: In a helicopter, the anti-torque pedals are the foot pedals which modify the 

collective pitch of the tail rotor. Because the helicopter’s throttle governor keeps the rotors turning at a 

constant RPM, changing the pitch also changes the thrust generated by the rotor, so the tail rotor can 

swing the helicopter’s tail to the left or right. This is referred to as yaw motion. 

Collective: In a helicopter, the collective is the lever that modifies the collective pitch of the main rotor’s 

blades. It is called “collective” because the pitch of all the blades is modified at the same time. Because 

the engine keeps the rotor moving at a constant RPM, increasing the rotor blades’ pitch with this control 

will also increase their lift. 

http://www.x-plane.com/desktop/home/
http://www.x-plane.com/desktop/home/
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Cyclic: The control (a joystick in real life) which changes the pitch of the main rotor’s blades as they go 

through each cycle, used to steer the craft left, right, forward, or aft. 

Joystick: A control device used in aircraft. It consists of a base with a handle attached to it. The handle 

can be tiled around within the base to control the pitch and roll movement of the aircraft. Computer 

joysticks often have the ability to twist the handle to control yaw movement also. Real airplanes have 

either a joystick or a yoke to control them, while helicopters are controlled with joysticks only. 

Rotor: The rotating part of a helicopter that generates the craft’s lift; similar in appearance to an 

oversized airplane propeller, though different in its operation. 

Rudder pedals: Foot pedals in an airplane used to steer the plane down the runway and to control its 

yaw motion in flight (that is, the wagging of its tail left or right). This becomes very useful when starting 

turns and counter-acting crosswinds. Note that these are not spelled “petals,” as they are not named 

after the fragile leaves of a flower. 

Yoke: The yoke, named after a wooden device draped across oxen to tow things, is the “steering 

wheel” of the airplane. It is used to steer the plane in flight by dipping the wings up or down and by 

pulling the nose up and pushing it down. Note that this is not spelled “yolk,” as it is not named after 

the center of an egg. 

Movement of an Aircraft 

 

Figure G.1: This image illustrates the pitch, roll, and yaw axes of an airplane (which also apply to 

helicopters). Thanks to Wikipedia contributor ZeroOne for releasing this image under the Creative 

Commons Attribution 3.0 Unported license. 

Pitch: Movement of the aircraft’s nose up or down (illustrated in Figure G.1). 

Roll: Movement of the aircraft’s body along the line formed by its body; in an airplane, this is easily seen 

as the dip or rise of the wings (illustrated in Figure G.1). 

http://en.wikipedia.org/wiki/User:ZeroOne
https://www.x-plane.com/manuals/desktop/index.html#dynamics
https://www.x-plane.com/manuals/desktop/index.html#dynamics
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Yaw: Movement of the aircraft’s body left or right, most easily pictured as a wagging of the aircraft’s tail 

(illustrated in Figure G.1). 

Other Aviation Terms 

Above Ground Level (AGL): When holding an altitude requested by air traffic control, a pilot will hold an 

altitude AMSL (above mean sea level). This lets the pilot stay at a constant level while flying. In order to 

avoid a horrific and instant death, however, pilots should be aware of their altitude AGL (above ground 

level) as well! The altimeter in the aircraft works on air pressure, so it measures the altitude above sea 

level, so awareness of minimum allowable altitudes in one’s region is always needed in order to stay at 

least that high. The radio altimeter measures the height above the ground (AGL). Most planes, however, 

do not have these installed. This is increasingly okay, though, because in theory a pilot can follow the en 

route and approach charts, which list safe MSL altitudes, and more and more planes have moving maps 

that clearly show the terrain elevation, so pilots can be sure that their elevation is safe. 

Airspeed indicator (ASI): The ASI is driven by the pressure of the air impacting a little tube on the nose 

or wing of the plane. More pressure means the craft is moving faster. See the discussion in the 

“Indicated airspeed (IAS)” entry below. 

Air Traffic Control (ATC): The body governing aircraft operations in a given airspace. Altitude: An 

aircraft’s altitude is its height above sea level. This is typically displayed on the aircraft’s altimeter, which 

is driven by air pressure. 

Automatic Direction-Finder (ADF): An old-style navigation device that points a needle at a transmitter 

on the ground. These are not used much any more because with GPS navigation, the idea of going to 

pre-defined points (like picking up bread-crumbs to find one’s way home) is disappearing. The GPS will 

take pilots all the way to where they want to go in a straight line, not a zig-zag like would be achieved in 

flying from one navigation transmitter to another with an ADF. 

Back Course (BC): This is the part of the ILS that goes beyond the touch-down zone. Read all about it in 

Chapter 7, Navigation, Autopilots, and Flying on Instruments. 

Course Deviation Indicator (CDI): This instrument (part of the OBI or HSI) displays which direction the 

aircraft needs to turn in order to intercept the VOR course. This is discussed in Chapter 7, Navigation, 

Autopilots, and Flying on Instruments. 

Density altitude: As the temperature of the air increases, its density decreases. The barometric pressure 

can vary based on a number of other factors, too, so at sea level on a hot, low-pressure day, the density 

of the air may be the same as standard air density at 10,000 feet up in the air! This is a 10,000 foot 

density altitude. This means there is less air for the engines, less air for the propeller, and less air for the 

wings. All of this adds up to say that it will take the aircraft longer to get off the ground. 

Distance Measuring Equipment (DME): An instrument used in navigation which measures distance 

using the delay between the sending and receiving of a radio signal. Aircraft use this to determine their 

distance from a fixed NAVAID. 

Drag: The aerodynamic force (created by a fluid such as air flowing around an object) that slows the 

object’s motion. 

https://www.x-plane.com/manuals/desktop/index.html#dynamics
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Electronic Flight Instrument System (EFIS): A flight instrument system (found in an air- craft’s panel) 

with electronic displays rather than the mechanical gauges of a standard panel. 

Go Around (GA): An autopilot mode that raises the nose in a wings-level attitude and calls for lots of 

power in order to get back to altitude after a botched landing approach). 

Glide slope (G/S): The angle at which an aircraft approaches (or needs to approach) a runway; often 

used when discussing navigation by instruments. See Chapter 7 for more information. 

Global Positioning System (GPS): A form of navigation using data from satellites. 

Heading (HDG): An aircraft’s heading is the direction that its nose is pointing. This is also a mode in the 

autopilot that lets the pilot hold a pre-defined heading, typically magnetic. A magnetic heading is 

heading to the magnetic north pole, something a hair different than true north, which is a geographic 

heading that will take one to the true geographic North Pole. Remember, since the magnetic north pole 

is separated from the geographic north pole by a bit, true and magnetic heading are not typically the 

same! They may be off by 5 or 10 degrees in the medium latitudes. The difference between the true and 

magnetic north poles is called the magnetic variation. 

Hold (HLD): Pressing this button will engage the autopilot in altitude hold mode. See the Autopilots 

section of Chapter 7 for more information. 

Horizontal Situation Indicator (HSI): This instrument is found in the panel of many aircraft in X-Plane. It 

serves the same function as an OBI—that is, it indicates course deviation. See Chapter 7 for more 

information. 

Instrument Flight Rules (IFR): The procedure for flying an aircraft based solely on the craft’s instrument 

panel. Environmental conditions requiring such flight (such as the poor visibility on a rainy day) are 

referred to as IFR conditions. This is contrasted with VFR conditions (those operating under visual flight 

rules). In bad weather or above 18,000 feet, pilots need to fly by Instrument Flight Rules, following their 

instruments and air traffic control instructions carefully to avoid hitting the ground or other planes, or 

going off course. 

Instrument Landing System (ILS): A ground-based system for guiding approaching aircraft into the 

runway via radio signals. See the Chapter 7 for more information. 

Instrument Meteorological Conditions (IMC): When pilots are in clouds or rain and cannot see out the 

window, they are required to fly by IMC rules. In such conditions, they need to be on an instrument 

flight plan. 

Indicated airspeed (IAS): The presumed airspeed of a craft as determined by measuring the pressure 

acting on a little tube attached to the craft which points into the wind. This differs from true airspeed in 

situations where the air has very little density (for example, at 80,000 feet in an SR–71 Blackbird or in 

orbit in the Space Shuttle). This error, though, can be useful, because if there is less pressure pushing on 

the airspeed indicator, then there is also less pressure pushing on the wings of the aircraft. Therefore, 

the airspeed indicator tells how much air pressure is available for the props and wings (which is what a 

pilot really cares about, as more pressure gives more lift and drag). So, if a pilot is going 120 mph in thin 

air, but the pressure is only strong enough to measure 100 mph on the airspeed indicator, then that 



Page | 125  
 

means the aerodynamic pressure on the wings is only 100 mph-worth of pressure! It is this pressure that 

determines how much lift and drag the wings can put out. 

Lift: The aerodynamic force (created by a fluid such as air flowing around an object) that pushes an 

object upward. 

Localizer (LOC): A localizer is part of an instrument landing system (ILS). It serves as a lateral (left and 

right) guide to the centerline of the runway. 

Mach speed: The speed of sound through the air. Mach’s number actually describes the speed of sound 

through any fluid (that is, liquid or gas). In application to aeronautics, though, it is implied that the fluid 

is air. Note that this number is dependent on a number of factors, such as temperature, humidity, and 

pressure. Generally, “Mach 1” is cited as 768 miles per hour (the speed of sound at sea level in dry air at 

68◦ Fahrenheit). 

NAV: Short for “navigate.” This is an autopilot mode that follows an ILS, localizer, VOR, or GPS path. See 

Chapter 7 for more information. 

NAVAID: A navigation aid transmitter (typically a VOR, NDB, or ILS) which is used as a reference when 

flying. These are often found on or near an airport, but they can also be scattered between airports to 

use as node points in an airway. Pilots often fly from NAVAID to NAVAID on long flights, as a VOR is only 

usable from about 50 miles away. See Chapter 7 for more information. 

Non Directional Beacon (NDB): See the ADF note above. 

Omni-Bearing Indicator (OBI): This instrument, used for navigation, is found in most general aviation 

aircraft. It consists of a moving arrow (called the course deviation indicator, or CDI) which points the way 

to whatever VOR frequency is tuned in the navigation radio. The instrument is set using the Omni-

Bearing Selector (or OBS), the knob in its lower left corner. A more expensive version of this is an HSI. 

See Chapter 7 for more information. 

Rotations per minute (RPM): a way of measuring the speed of a rotor or propeller. In a helicopter, the 

RPM of both the main rotor and the tail rotor are held constant. 

Speed: The change in the position of an object over time; unlike velocity, speed does not take into 

account the direction of the object’s movement. 

Thrust vector: The direction in which the engine or rotor’s thrust is going; for a helicopter sitting on a 

helipad with its controls at neutral, this is straight down. 

Thrust vectoring: The ability of helicopters and some other aircraft (such as the Harrier or the F–22) to 

change the direction of the thrust from its engines/rotors. 

V-airways (victor airways): Victor airways are the pre-charted airways that are defined by a series of 

VORs. Pilots fly from VOR to VOR until they reach their destination, thereby staying on a V-airway. Each 

segment of the V-airway thoughtfully lists the minimum altitude that pilots can fly that airway segment 

with to avoid crashing. 

Velocity: The combination of an object’s speed and the direction of its movement; for example, an 

aircraft might have a vertical velocity of 500 feet per minute (meaning it moves upward at a rate of 500 
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feet per minute) or a vertical velocity of –500 feet per minute (meaning it moves downward at 500 feet 

per minute). 

Velocity of Flap Extension (Vfe): This is the maximum speed at which the aircraft can deploy its flaps 

without damaging or breaking them. 

Visual Flight Rules (VFR): This is flying done using a combination of the pilot’s view of the outside world 

and the aircraft’s instruments. Environmental conditions permitting such flight (such as a sunny day with 

10 mile visibility) are referred to as VFR conditions. It is assumed in such conditions that pilots are 

always able to see out the window well enough to avoid collisions with terrain and other aircraft. To use 

visual flight rules, one typically needs about 3 miles visibility and to stay about 1000 feet from the 

clouds. 

Visual Meteorological Conditions (VMC): These are environmental conditions suitable for flying by sight 

(VFR). 

Very high frequency Omnidirectional Range (VOR): This is a type of NAVAID that sends out signals that 

pilots can follow to get to or from the transmitter. While an NDB simply lets the aircraft’s ADF needle 

point right to it, the VOR actually lets pilots fly to the station along a programmed radial. So, for 

example, rather than just “flying to the VOR,” a pilot can be sure to fly to the VOR along the 090 radial 

(from the east), guaranteeing his or her location to be along an airway for the entire trip to the VOR. 

Once the airway is charted, the aircraft will be over mapped terrain height for the entire trip, and course 

corrections can be made quickly to stay on the desired radial. Light airplanes often track these VOR 

signals using an Omni-Bearing Indicator, or OBI, while more expensive craft often use a Horizontal 

Situation Indicator, or HSI. See Chapter 7 for more information. 

Velocity Never Exceed (Vne): This is the maximum speed that a given airplane can go. Going faster than 

Vne can result in “structural damage,” or in extreme cases, death. 

Velocity Normal Operating (Vno): This velocity should not be exceeded unless the air is very smooth. 

Even then, it should be exceeded “with extreme caution,” as the operating handbooks say. 

Vertical Speed/Velocity Indicator (VSI or VVI): By looking at how fast the air pressure is changing, the 

VSI deduces how quickly the aircraft must be climbing or descending. 

 


